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Abstrak 
 

Salah satu kawasan kota Surabaya yang sering terjadi 
banjir adalah pada DAS Gunungsari yang berada pada wilayah 
Surabaya Barat yang terbagi menjadi tiga sub DAS, yaitu sub 
DAS Kali Balong, sub DAS Kali Kandangan, dan sub DAS Kali 
Sememi. Kondisi topografi wilayahnya merupakan dataran 
rendah dan kondisi geografis yang berbatasan dengan laut 
menjadikan saluran ini dipengaruhi oleh pasang surut air laut. 

Oleh sebab itu perlu direncanakan dimensi saluran yang 
mampu menampung debit yang mengalir agar tidak terjadi 
limpasan (banjir). Dalam studi ini untuk analisa hidrologi 
menggunakan program bantu HEC-HMS.. Sedangkan untuk 
analisa hidrolika menggunakan program bantu HEC-RAS.  

Berdasarkan hasil analisa didapatkan bahwa lebar saluran 
primer Margomulyo bagian hulu sebesar 10 m dan bagian hilir 
sebesar 15 m. Untuk lebar bagian  hulu Kali Balong sebesar 20 m, 
dan 48 m pada bagian hilir. Untuk lebar Kali Kandangan bagian 
hulu sebesar 20 m, dan 30 m pada bagian hilir. Sedangkan untuk 
Kali Sememi lebar pada bagain hulu sebesar 20 m dan bagian 
hilir sebesar 38 m. 
 



 
 

Kata kunci : Kali Kandangan, Kali Sememi, Kali Balong, HEC-HMS, 
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Abstract 
 

One of the areas in Surabaya which frequent flooding in 
the watershed Gunungsari is located in West Surabaya which is 
devided into three sub-basins which Balong river sub-basins, 
Kandangan river sub-basins, and Sememi river sub-basins. The 
topography of Surabaya is lowland and geographical conditions 
bordering the sea to make this channel is affected by the tide. 

Therefore it is necessary to plan the dimensions of the 
channel that can accommodate the discharge that flows to 
prevent runoff (flood). In this study for the hydrological analysis 
using HEC-HMS program. As for the hydraulics analysis using 
HEC-RAS program. 

Based on the analysis results showed that the 
Margomulyo primary channel the width of upstream section of 10 
m and downstream sections of 15 m. On Balong River the width 
of upstream section of 20 m, and 48 m for downstream section. 
For the time width Kandangan upstream part of 20 m, and 30 m 
downstream. As for Kali Sememi width at any part of 20 m 
upstream and downstream sections of 38 m. 
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BAB 1 

PENDAHULUAN 

1.1 Latar Belakang 

Surabaya sebagai ibukota Provinsi Jawa Timur 
berkembang menjadi kota perdagangan dan industri yang 
mempunyai peranan yang penting dalam kehidupan sosial 
ekonomi Indonesia. Perkembangan ini menarik minat orang untuk 
bermigrasi ke Kota Surabaya, sehingga menyebabkan laju 
pertumbuhan penduduk kota Surabaya meningkat sangat pesat. 
Karena pertumbuhan penduduk berkembang semakin pesat maka 
kebutuhan lahan pemukiman juga meningkat. Hal ini 
mengakibatkan perubahan tata guna lahan yang tidak terencana 
dan mengurangi daerah konservasi sebagai tempat peresapan air 
hujan, sehingga menyebabkan banjir di beberapa daerah di 
Surabaya. 

Salah satu kawasan kota Surabaya yang sering terjadi 
banjir adalah DAS Gunungsari yang berada pada wilayah 
Surabaya barat. Maka pada tugas akhir ini akan dilakukan 
perencanaan dimensi saluran primer pada DAS Gunungsari 
bagian hilir. Perencanaan dilakukan dengan menggunakan 
program bantu HEC-HMS dan HEC-RAS. HEC-HMS digunakan 
untuk analisa hidrologi sedangkan HEC-RAS disgunakan untuk 
analisa hidrolika.  

Lokasi yang ditinjau adalah di DAS Gunungsari bagian 
hilir, yaitu di saluran primer Margomulyo, Kali Balong, Kali 
Kandangan, dan Kali Sememi. 
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Gambar 1.1 Lokasi Study yang Ditinjau 
 

Sumber : Surabaya Drainage Master Plan 
 

1.2 Rumusan Masalah 
Adapun rumusan masalah yang akan dibahas dalam tugas 
akhir ini adalah : 

1. Berapa debit banjir rencana saluran primer Margomulyo, 
Kali Balong, Kali Kandangan, dan Kali Sememi? 

2. Berapakah dimensi penampang saluran yang mampu 
mengalirkan debit yang mengalir? 

3. Apakah ada pengaruh dari backwater di Kali Balong, Kali 
Kandangan, dan Kali Sememi? 

4. Bagaimana perbedaan profil muka air antara kondisi 
eksisting dan setelah normalisasi? 
 

LOKASI YANG DITINJAU 
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1.3 Tujuan 
Adapun tujuan dari penulisan tugas akhir ini adalah : 

1. Mengetahui debit banjir rencana saluran primer 
Margomulyo, Kali Balong, Kali Kandangan, dan Kali 
Sememi. 

2. Memperoleh dimensi penampang saluran yang mampu 
menampung debit yang mengalir. 

3. Menganalisa pengaruh backwater dan cara mengatasinya. 
4. Mendapatkan perbandingan profil muka air antara kondisi 

eksisting dan setelah normalisasi. 
 

1.4 Batasan Masalah 
Adapun batasan masalah pada penulisan tugas akhir ini 
adalah: 

1. Debit air yang diperhitungkan hanya debit limpasan air 
hujan dan tidak memperhitungkan debit saluran dari 
limbah rumah tangga maupun perkotaan. 

2. Tidak  memperhitungkan sedimentasi pada saluran 
drainase. 

3. Tidak memperhitungkan rencana anggaran biaya dari 
perencanaan drainase. 

 
1.5 Manfaat 
 Adapun manfaat dari penulisan ini yaitu : 

1. Diharapkan dari penyelesaian tugas akhir ini dapat 
memberikan masukan dan pertimbangan kepada 
Pemerintah Kota Surabaya dalam perencanaan perbaikan 
sistem drainase pada kawasan saluran primer 
Margomulyo, sub DAS Kali Sememi, sub DAS Kali 
Kandangan, dan sub DAS Kali Balong. 

2. Sebagai bahan acuan bagi pihak tertentu yang ingin 
melakukan perbaikan pada jaringan drainase di lokasi 
yang ditinjau. 
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3. Sebagai bahan referensi atau literatur bagi mahasiswa 
yang ingin mempelajari evaluasi drainase menggunakan 
program bantu HEC-HMS dan HEC-RAS. 
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BAB II 
TINJAUAN PUSTAKA 

 
2.1 Umum 

Data yang digunakan sebagai acuan perencanaan 
drainase dalam proses pengolahan data adalah sebagai 
berikut: 

a. Data topografi 
b. Data hidrologi 
c. Data tata guna lahan 
d. Data geometri saluran 

Data-data tersebut diambil dari SDMP (Surabaya 
Drainage Master Plan). Sedangkan untuk data hidrologi 
diperoleh berdasarkan pencatatan yang dilakukan oleh Dinas 
Pekerjaan Umum yang diambil dari 4 stasiun hujan yang 
berpengaruh terhadap kawasan DAS Gunungsari, yakni 
stasiun hujan Kandangan, stasiun hujan Gunungsari, stasiun 
hujan Gubeng dan stasiun hujan Banyu urip 

2.2 Analisa Hidrologi 
Analisa hidrologi diperlukan untuk mengetahui 

karakteristik hidrologi di wilayah DAS Gunungsari 
Surabaya. Hasil yang diperoleh dari analisa hidrologi ini 
adalah besarnya debit rencana untuk perencanaan dimensi 
saluran. Periode ulang yang akan digunakan untuk 
perencanaan adalah periode ulang 10 tahun. Data yang 
diperlukan untuk menetukan besarnya debit rencana 
diperoleh dari data hujan di beberapa stasiun hujan yang 
berpengaruh pada DAS Gunungsari. 

Analisa hidrologi ini meliputi perhitungan distribusi 
hujan wilayah, perhitungan parameter statistik hidrologi, dan 
analisis debit dengan HEC-HMS 

2.2.1 Distribusi Hujan Wilayah 
Data hujan yang diperoleh dari stasiun hujan 

merupakan hujan yang terjadi pada 1 titik saja/point rainfall 
(Soemarto,1999). Untuk perhitungan hidrologi dibutuhkan 
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data hujan pada kawasan yang ditinjau sehingga dibutuhkan 
beberapa stasiun hujan yang akan diubah menjadi curah 
hujan wilayah. Ada 3 cara yang sering digunakan untuk 
menentukan curah hujan wilayah, yaitu rata-rata aljabar 
(aritmatik), Poligon Thiessen, dan Isohyet. 

Dari ketiga metode diatas perlu dipilih metode yang 
sesuai pada suatu daerah tangkapan air. Ada ketentuan-
ketentuan yang digunakan untuk menentukan metode apa 
yang akan dipakai seperti Tabel 2.1. 

 
Tabel 2.1 Pertimbangan Cara yang Dapat Digunakan 

Parameter Kondisi Cara yang dapat 
digunakan 

Jumlah 
stasiun hujan 

Cukup 
 

Aritmetika, Thiessen 
Polygon, Ishoyet 

Terbatas Rerata Aritmetik, 
Thiessen Poligon 

Luas Das >5000 km2 
(Besar) 
501 – 5000 km² 
(sedang) 

Ishoyet 
Thiessen Poligon 

<500 km² (kecil) Rerata Aritmatik 
Kondisi 
Topografi 

Pegunungan Thiessen Poligon 
Dataran Aljabar 
Berbukit dan 
Tidak Beraturan 

Ishoyet dan Thiessen 
Poligon 

Sumber : Suripin, 1998 
 

Pada kawasan DAS Gunungsari jumlah stasiun hujan 
yang ada tergolong cukup, yang terletak pada wilayah 
dataran, dan memiliki luas DAS < 500 km2, maka untuk 
menghitung curah hujan digunakan cara Poligon 
Thiessen,Rerata Aritmatik, dan Aljabar. 

Cara Thiessen ini memberikan hasil yang lebih teliti dari 
pada cara Aljabar rata-rata (Suyono, 2006). Oleh karena itu 
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untuk perhitungan curah hujan wilayah menggunakan 
metode Poligon Thiessen. 

 

𝑅� =
𝐴1.𝑅1 + 𝐴2.𝑅2 + 𝐴3.𝑅3 + ⋯+ 𝐴𝑛.𝑅𝑛

𝐴1 + 𝐴2 + 𝐴3 +⋯+ 𝐴𝑛
 

Dimana : 
𝑅� = tinggi hujan rata-rata 
A = luas daerah aliran 
𝐴1= luas daerah pengaruh stasiun 1 
𝑅2 = tinggi hujan pada stasiun 

Sumber: Suyono, 2006 
 
2.2.2 Parameter Dasar Statistik 

Dalam statistik ada beberapa parameter yang berkaitan 
dengan analisis data, yaitu meliputi rata-rata, standart 
deviasi, koefisien skewness, dan koefisien kurtosis. 
Parameter statistik ini digunakan untuk menentukan 
distribusi frekuensi yang akan digunakan. Berikut setiap 
jenis distribusi mempunyai parameter statistik yang terdiri 
dari : 

 
• Nilai rata-rata tinggi hujan 

Tinggi rata-rata hujan diperoleh dari rata-rata penakaran 
tinggi hujan. Rumus yang digunakan : 

𝑋� =  
1
𝑛
� 𝑋𝑖

𝑛

𝑖=1
 

Dimana : 
𝑋� : rerata (mm) 
𝑋𝑖 : variabel random (mm) 
𝑛 : jumlah data 

Sumber: Triatmojo, 2010 
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• Standar Deviasi 

𝑆𝑑 =  �
∑(𝑋𝑖 − 𝑋�)2

𝑛 − 1
 

Dimana : 
𝑆𝑑 : standar deviasi 
𝑋� : nilai curah hujan rata-rata (mm) 
𝑋𝑖 : variabel random (mm) 
𝑛 : jumlah data 

Sumber: Soewarno, 1995 
 

• Koefisien Kemencengan (Cs) 
Koefisien Kemencengan disebut juga Koefisien 

Skewness adalah suatu nilai yang menunjukkan derajat 
ketidaksimetrisan dari suatu bentuk distribusi (Soewarno, 
1995). Dapat dihitung menggunakan rumus : 

𝐶𝑠 =  
𝑛

(𝑛 − 1)(𝑛 − 2)𝑠3 � (𝑥𝑖 − 𝑥̅)3
𝑛

𝑖=1
 

Dimana : 
𝐶𝑠 : koefisien skewness 
𝑆𝑑 : standart deviasi 
𝑋� : nilai rata-rata curah hujan (mm) 
𝑋𝑖 : variabel random (mm) 
n : jumlah data 

Sumber : Triatmojo, 2010 
 

• Koefisien Keruncingan (Ck) 
Koefisien Keruncingan atau disebut juga dengan 

Koefisien Kurtosis adalah nilai yang digunakan untuk 
mengukur keruncingan suatu kurva distribusi (Soewarno, 
1995). Koefisien kurtosis dapat dihitung dengan rumus : 

 

𝐶𝑘 =  
𝑛2.∑(𝑋𝑖 − 𝑋�)4

(𝑛 − 1)(𝑛 − 2)𝑆𝑑4
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Dimana : 
𝐶𝑘 : koefisien kurtosis 
𝐶𝑣   : koefisien variasi 
𝑛 : jumlah data 
𝑆𝑑 : standar deviasi 
𝑋� : nilai rata-rata curah hujan (mm) 
𝑋𝑖 : variabel random (mm) 

Sumber : Triatmojo, 2010 
 

Perhitungan curah hujan rencana dihitung dengan 
analisis distribusi frekuensi. Distribusi frekuensi yang 
digunakan diantaranya adalah distribusi normal, distribusi 
gumbel, distribusi log pearson tipe III. 

Setiap distribusi memiliki syarat-syarat parameter 
statistik. Adapun syarat-syarat parameter statistik dapat 
dilihat pada tabel dibawah ini. 

 
Tabel 2.2. Parameter Statistik untuk Menentukan Jenis Distribusi 
No Distribusi Persyaratan 
1 Normal Cs = 0 
  Ck = 3 
2 Log Normal Cs = Cv³ + 3 Cv 
  Ck = Cv8 + 6Cv6 + 15Cv4 + 16Cv2 + 3 
3 Gumbel Cs = 1.14 
  Ck = 5.4 
4 Log Pearson 

III 
Selain dari nilai diatas / flexibel 

Sumber : Triatmodjo, 2010 
 
2.2.3 Analisa Distribusi Frekuensi 

Ada beberapa distribusi yang sering digunakan pada 
analisis hidrologi, yaitu : 

• Distribusi Normal 
• Distribusi Gumbel 
• Distribusi Log Person Tipe III 
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Sebelum dilakukan perhitungan analisis frekuensi dari 
data yang tersedia, terlebih dahulu dilakukan pemilihan 
distribusi yang sesuai berdasarkan parameter statistik. 

 
2.2.3.1 Distribusi Normal 

Distribusi normal disebut pula Distribusi Gauss. 
Persamaan umum yang digunakan adalah : 

𝑋 =  𝑋� + 𝑘. 𝑆 
Dimana : 
𝑋 : perkiraan nilai yang diharapkan terjadi dengan 

besar  peluang tertentu atau pada periode ulang 
tertentu. 

𝑋�  : nilai rata-rata hitung variat 
𝑆  : deviasi standar nilai variat 
𝑘  : faktor frekuensi,merupakan fungsi dari pada 

peluang atau periode ulang dan tipe model 
matematik dari distribusi  peluang yang 
digunakan untuk analisis peluang. 

Sumber : Soewarno, 1995 
 

2.2.3.2 Distribusi Gumbel 
Persamaan Distribusi Gumbel adalah : 

𝑋 =  𝑋� +  
𝑆
𝑆𝑛

 (𝑌 − 𝑌𝑛) 
Dimana : 
𝑋  : nilai variat yang diharapkan terjadi 
𝑋�  : nilai rata-rata hitung variat 
𝑌  : nilai reduksi variat dari variabel yang 

diharapkan terjadi pada periode ulang tertentu, 
atau dapat dihitung dengan rumus : 

𝑌 =  − ln �− ln
𝑇 − 1
𝑇 � 

Untuk T ≥ 20 , maka Y = Ln T 
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𝑌𝑛 : nilai rata-rata dari reduksi variat (mean of 
reduced variate) nilainya tergantung dari jumlah 
data (n) dan dapat dilihat pada Tabel 2.3 A 

𝑆𝑛  : deviasi standar dari reduksi variat (standard 
deviation of the reduced variate), nilainya 
tergantung dari jumlah data (n) dan dapat dilihat 
pada Tabel 2.3 B 

Sumber : Soewarno, 1995 
 

Tabel 2.3.A Hubungan Reduksi Variat Rata-Rata (Yn) dengan  
jumlah data (n) 

 
n Yn n Yn n Yn 

10 0,4952 41 0,5442 72 0,5552 
11 0,4996 42 0,5448 73 0,5555 
12 0,5053 43 0,5453 74 0,5557 
13 0,5070 44 0,5258 75 0,5559 
14 0,5100 45 0,5463 76 0,5561 
15 0,5128 46 0,5468 77 0,5563 
16 0,5157 47 0,5473 78 0,5565 
17 0,5181 48 0,5447 79 0,5567 
18 0,5202 49 0,5481 80 0,5569 
19 0,5220 50 0,5485 81 0,5570 
20 0,5235 51 0,5489 82 0,5572 
21 0,5252 52 0,5493 83 0,5574 
22 0,5268 53 0,5497 84 0,5576 
23 0,5283 54 0,5501 85 0,5578 
24 0,5296 55 0,5504 86 0,5580 
25 0,5309 56 0,5508 87 0,5581 
26 0,5320 57 0,5511 88 0,5583 
27 0,5332 58 0,5515 89 0,5585 
28 0,5343 59 0,5518 90 0,5586 
29 0,5353 60 0,5521 91 0,5587 
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n Yn n Yn n Yn 
30 0,5362 61 0,5524 92 0,5589 
31 0,5371 62 0,5527 93 0,5591 
32 0,5380 63 0,5530 94 0,5592 
33 0,5388 64 0,5533 95 0,5593 
34 0,5396 65 0,5535 96 0,5595 
35 0,5403 66 0,5538 97 0,5596 
36 0,5410 67 0,5540 98 0,5598 
37 0,5418 68 0,5543 99 0,5599 
38 0,5424 69 0,5545 100 0,5600 

 
Tabel 2.3.B Hubungan antara Deviasi Standar dan Reduksi 
Variat (Sn) dengan Jumlah Data (n) 

n 𝝈Rn n 𝝈Rn n 𝝈Rn 
10 0,9497 41 1,1436 72 1,1873 
11 0,9676 42 1,1458 73 1,1881 
12 0,9833 43 1,1480 74 1,8900 
13 0,9972 44 1,1490 75 1,1898 
14 1,0098 45 1,1518 76 1,1906 
15 1,0206 46 1,1538 77 1,1915 
16 1,0316 47 1,1557 78 1,1923 
17 1,0411 48 1,1574 79 1,1930 
18 1,0493 49 1,1590 80 1,1938 
19 1,0566 50 1,1607 81 1,1945 
20 1,0629 51 1,1623 82 1,1953 
21 1,0696 52 1,1638 83 1,1959 
22 1,0754 53 1,1653 84 1,1967 
23 1,0811 54 1,1667 85 1,1973 
24 1,0864 55 1,1681 86 1,1980 
25 1,0914 56 1,1696 87 1,1987 
26 1,0961 57 1,1708 88 1,1994 
27 1,1004 58 1,1721 89 1,2001 
28 1,1047 59 1,1734 90 1,2007 
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n 𝝈Rn n 𝝈Rn n 𝝈Rn 
29 1,1086 60 1,1747 91 1,2013 
30 1,1124 61 1,1759 92 1,2020 
31 1,1159 62 1,1770 93 1,2026 
32 1,1193 63 1,1782 94 1,2032 
33 1,1226 64 1,1793 95 1,2038 
34 1,1255 65 1,1803 96 1,2044 
35 1,1285 66 1,1814 97 1,2049 
36 1,1313 67 1,1824 98 1,2055 
37 1,1339 68 1,1834 99 1,2060 
38 1,1363 69 1,1844 100 1,2065 

Sumber : Soewarno, 1995 
 

2.2.3.3 Distribusi Log Person Tipe III 
Prosedur untuk menentukan kurva distribusi log person 

tipe III adalah : 
1) Tentukan logaritma dari semua nilai variat X 
2) Hitung nilai rata-ratanya : 

log 𝑥������ =  
∑ log𝑥
𝑛

 
n = jumlah data 

3) Hitung nilai deviasi standar dari log X : 

𝑆 log𝑋��������� =  �
∑(𝐿𝑜𝑔 𝑋 −  𝐿𝑜𝑔 𝑋��������)2

𝑛 − 1
 

4) Hitung nilai koefisien kemencengan 

𝐶𝑠 =  
𝑛∑(𝐿𝑜𝑔 𝑋 −  𝐿𝑜𝑔 𝑋��������)3

(𝑛 − 1)(𝑛 − 2)(𝑆 𝐿𝑜𝑔 𝑋����������)3
 

Sehingga persamaan umum dari log pearson III adalah : 
𝐿𝑜𝑔 𝑋 =  𝐿𝑜𝑔 𝑋�������� + 𝑘. (𝑆. 𝐿𝑜𝑔 𝑋�����������) 

5) Menentukan anti log dari log X, untuk mendapatkan nilai 
X yang diharapkan terjadi pada tingkat peluang atau 
periode tertentu sesuai dengan CS nya. Nilai k dapat 
dilihat pada Tabel 2.4. 
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Tabel 2.4 Nilai k Distribusi Pearson tipe III 

(CS) 

Periode Ulang (tahun) 
2 5 10 25 50 100 200 1000 

Peluang (%) 
50 20 10 4 2 1 0,5 0,1 

3,0 -0,360 0,420 1,180 2,278 3,152 4,051 4,970 7,250 
2,5 -0,360 0,518 1,250 2,262 3,048 3,845 4,652 6,600 
2,2 -0,330 0,574 1,284 2,240 2,970 3,705 4,444 6,200 
2,0 -0,307 0,609 1,302 2,219 2,912 3,605 4,298 5,910 
1,8 -0,282 0,643 1,318 2,193 2,848 3,499 4,147 5,660 
1,6 -0,254 0,675 1,329 2,163 2,780 3,388 3,990 5,390 
1,4 -0,225 0,707 1,337 2,128 2,706 3,271 3,828 5,110 
1,2 -0,195 0,732 1,340 2,087 2,626 3,149 3,661 4,820 
1,0 -0,164 0,758 1,340 2,043 2,542 3,022 3,489 4,540 
0,9 -0,148 0,769 1,339 2,018 2,498 2,957 3,401 4,395 
0,8 -0,132 0,780 1,336 1,998 2,453 2,891 3,312 4,250 
0,7 -0,116 0,790 1,333 1,967 2,407 2,824 3,223 4,105 
0,6 -0,099 0,800 1,328 1,939 2,359 2,755 3,132 3,960 
0,5 -0,083 0,808 1,323 1,910 2,311 2,686 3,041 3,815 
0,4 -0,066 0,816 1,317 1,880 2,261 2,615 2,949 3,670 
0,3 -0,050 0,824 1,309 1,849 2,211 2,544 2,856 3,525 
0,2 -0,033 0,830 1,301 1,818 2,159 2,472 2,763 3,380 
0,1 -0,017 0,836 1,292 1,785 2,107 2,400 2,670 3,235 
0,0 0,000 0,842 1,282 1,751 2,053 2,326 2,576 3,090 
-0,1 0,017 0,836 1,270 1,761 2,000 2,252 2,482 3,950 
-0,2 0,033 0,850 1,258 1,680 1,945 2,178 2,388 2,810 
-0,3 0,050 0,853 1,245 1,643 1,890 2,104 2,294 2,675 
-0,4 0,066 0,855 1,231 1,606 1,834 2,029 2,201 2,540 
-0,5 0,083 0,856 1,216 1,567 1,777 1,955 2,108 2,400 
-0,6 0,099 0,857 1,200 1,528 1,720 1,880 2,016 2,275 
-0,7 0,116 0,857 1,183 1,488 1,663 1,806 1,926 2,150 
-0,8 0,132 0,856 1,166 1,448 1,606 1,733 1,837 2,035 
-0,9 0,148 0,854 1,147 1,407 1,549 1,660 1,749 1,910 
-1,0 0,164 0,852 1,128 1,366 1,492 1,588 1,664 1,800 
-1,2 0,195 0,844 1,086 1,282 1,379 1,449 1,501 1,625 
-1,4 0,225 0,832 1,041 1,196 1,270 1,318 1,351 1,465 
-1,6 0,254 0,817 0,994 1,116 1,161 1,197 1,216 1,280 
-1,8 0,282 0,799 0,945 1,035 1,063 1,087 1,097 1,130 
-2,0 0,307 0,777 0,895 0,959 0,980 0,990 1,995 1,000 
-2,2 0,330 0,752 0,844 0,888 0,900 0,905 0,907 0,910 
-2,5 0,360 0,711 0,711 0,793 0,798 0,799 0,800 0,802 
-3,0 0,396 0,636 0,660 0,666 0,666 0,667 0,667 0,668 

Sumber : Soewarno, 1995 
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2.2.4 Uji Kecocokan 
Ada dua cara yang dapat dilakukan untuk menguji 

apakah jenis distribusi yang dipilih sesuai dengan data yang 
ada, yaitu uji Chi-Kuadrat dan Smirnov-Kolmogorov 
(Bambang Triatmojo, 2010). 

 
2.2.4.1 Uji Chi-Kuadrat 

Uji Chi-Kuadrat dimaksudkan untuk menentukan 
apakah persamaan distribusi peluang yang telah dipilih 
dapat mewakili dari distribusi statistik sampel data yang 
dianalisis (Soewarno, 1995). Parameter Chi-kuarat dihitung 
dengan rumus: 

 

𝑋ℎ2 =  �
(𝑂𝑖 − 𝐸𝑖)2

𝐸𝑖

𝐺

𝑖=1
 

Dimana : 
Xh² = Parameter chi kuadrat terhitung 
G = jumlah sub kelompok 
Oi = jumlah nilai pengamatan pada sub kelompok ke i 
Ei = jumlah nilai teoritis pada sub kelompok ke i 

 
Prosedur uji Chi-kuadrat adalah : 

1) Urutkan data pengamatan (dari besar ke kecil atau 
sebaliknya) 

2) Kelompokkan data menjadi G sub-group, tiap-tiap sub 
group minimal 4 data pengamatan. Pengelompokan data 
(G) dapat dihitung dengan rumus : 
𝐺 = 1 + 1,37 𝐿𝑛 (𝑛) 
n = jumlah data 

3) Jumlahkan data pengamatan sebesar Oi tiap-tiap sub group. 
4) Jumlahkan data dari persamaan distribusi yang digunakan 

sebesar Ei. 
5) Pada tiap sub grup hitung nilai : 

(𝑂𝑖 − 𝐸𝑖)2 𝑑𝑎𝑛 
(𝑂𝑖 − 𝐸𝑖)2

𝐸𝑖
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6) Jumlah seluruh G sub-grup nilai (𝑂𝑖−𝐸𝑖)
2

𝐸𝑖
 untuk menentukan 

nilai chi kuadrat. 
7) Tentukan derajat kebebasan dk= G –R – 1 (nilai R=2 untuk 

distribusi normal dan binominal, dan nilai R=1 untuk 
distribusi Poisson). 

8) Parameter Xh² mrupakan variabel acak. Peluang untuk 
mencapai nilai Xh² sama atau lebih besar dari pada nilai chi 
kuadrat yang sebenarnya (X²) bisa dilihat pada Tabel 2.5 . 

Sumber :  Soewarno,1995 
 

Tabel 2.5 Nilai Chi Kuadrat Teoritis 

dk 
α derajat kepercayaan 

0,995 0,99 0,975 0,95 0,05 0,025 0,01 0,005 
1 0,0000393 0,000157 0,000982 0,00393 3,841 5,024 6,635 7,879 
2 0,0100 0,0201 0,0506 0,103 5,991 7,378 9,210 10,597 
3 0,0717 0,115 0,216 0,352 7,815 9,348 11,345 12,838 
4 0,207 0,297 0,484 0,711 9,488 11,143 13,277 14,860 
5 0,412 0,554 0,831 1,145 11,070 12,832 15,086 16,750 
6 0,676 0,872 1,237 1,635 12,592 14,449 16,812 18,548 
7 0,989 1,239 1,690 2,167 14,067 16,013 18,475 20,278 
8 1,344 1,646 2,180 2,733 15,507 17,535 20,090 21,955 
9 1,735 2,088 2,700 3,325 16,919 19,023 21,666 23,589 
10 2,156 2,558 3,247 3,940 18,307 20,483 23,209 25,188 
11 2,603 3,053 3,816 4,575 19,675 21,920 24,725 26,757 
12 3,074 3,571 4,404 5,226 21,026 23,337 26,217 28,300 
13 3,565 4,107 5,009 5,892 22,362 24,736 27,688 29,819 
14 4,075 4,660 5,629 6,571 23,685 26,119 29,141 31,319 
15 4,601 5,229 6,262 7,261 24,996 27,488 30,578 32,801 
16 5,142 5,812 6,908 7,962 26,296 28,845 32,000 34,267 
17 5,697 6,408 7,564 8,672 27,587 30,191 33,409 35,718 
18 6,265 7,015 8,231 9,390 28,869 31,526 34,805 37,156 
19 6,844 7,633 8,907 10,117 30,144 32,582 36,191 38,582 
20 7,434 8,260 9,591 10,851 31,410 34,170 37,566 39,997 
21 8,034 8,897 10,283 11,591 32,671 35,479 38,932 41,401 
22 8,643 9,542 10,982 12,338 33,924 36,781 40,289 42,796 
23 9,260 10,196 11,689 13,091 36,172 38,076 41,638 44,181 
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dk 
α derajat kepercayaan 

0,995 0,99 0,975 0,95 0,05 0,025 0,01 0,005 
24 9,886 10,856 12,401 13,848 36,415 39,364 42,980 45,558 
25 10,520 11,524 13,120 14,611 37,652 40,646 44,314 46,928 
26 11,160 12,198 13,844 15,379 38,885 41,923 45,642 48,290 
27 11,808 12,879 14,573 16,151 40,113 43,194 46,963 49,645 
28 12,461 13,565 15,308 16,928 41,337 44,461 48,278 50,993 
29 13,121 14,256 16,047 17,708 42,557 45,722 49,588 52,336 
30 13,787 14,953 16,791 18,493 43,773 46,979 50,892 53,672 

Sumber : Soewarno, 1995 
 

2.2.4.2 Uji Smirnov-Kolmogorov 
Uji kecocokan Smirnov-Kolmogorof, sering juga disebut 

juga uji kecocokan non parametik (non parametic test), 
karena pengujiannya tidak menggunakan fungsi distribusi 
tertentu (Soewarno, 1995). 
Prosedurnya adalah sebagai berikut : 

1) Urutkan data (dari besar ke kecil atau sebaliknya) dan 
tentukan besarnya peluang dari masing-masing data 
tersebut. 
X1 = P(X1) 
X2 = P(X2) 
Xm = P(Xm) 
Xn = P(Xn) 
𝑃(𝑋) =

𝑚
𝑛 + 1

 
𝑃(𝑋 <) = 1 − 𝑃(𝑋) 
Dimana : 
P(X) = Peluang 
m  = nomor urut kejadian 
n = jumlah data 

2) Tentukan masing-masing peluang teoritis dari hasil 
penggambaran data (persamaan distribusinya) : 
X1 = P’(X1) 
X2 = P’(X2) 
Xm = P’(Xm) 
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Xn = P’(Xn) 

𝑓(𝑡)   =
𝑥 − 𝑥̅
𝑆𝑑

 
Dimana : 
F(t) = distribusi normal standar 
x  = curah hujan 
𝑥̅  = curah hujan rata-rata 

3) Tentukan peluang teoritis yang terjadi pada nomor ke-m 
P’(Xm), peluang teoritis tersebut didapat dari tabel. 

4) Tentukan peluang pengamatan dari rumus: 
𝑃(𝑋𝑚) = 1 − 𝑃′(𝑋𝑚) 

5) Dari kedua nilai peluang tersebut tentukan selisih 
terbesarnya antara peluang pengamatan dengan peluang 
teoritis, 𝐷𝑚𝑎𝑥 =  [𝑃(𝑋𝑚) − 𝑃′(𝑋𝑚)] 

6) Berdasarkan tabel nilai kritis (Smirnov-Kolmogorov test) 
tentukan harga Do (lihat Tabel 2.6) 

7) Apabila D lebih kecil dari Do maka distribusi teoritis yang 
digunakan untuk menentukan persamaan distribusi dapat 
diterima, namun apabila D lebih besar dari Do maka 
distribusi teoritis yang digunakan untuk menentukan 
persamaan distribusi tidak dapat diterima. 

Sumber  : Soewarno,1995. 
 
Tabel 2.6 Nilai Kritis Do untuk Uji Smirnov-Kolmogorov 

N α  (derajat kepercayaan) 
0,2 0,1 0,05 0,01 

5 0,45 0,51 0,56 0,67 
10 0,32 0,37 0,41 0,49 
15 0,27 0,3 0,34 0,4 
20 0,23 0,26 0,29 0,36 
25 0,21 0,24 0,27 0,32 
30 0,19 0,22 0,24 0,29 
35 0,18 0,2 0,23 0,27 
40 0,17 0,19 0,21 0,25 
45 0,16 0,18 0,2 0,24 
50 0,15 0,17 0,19 0,23 

Sumber  : Soewarno,1995 
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2.2.5 Periode Ulang Hujan (PUH) 
  Dari perhitungan uji kecocokan,akan diketahui jenis 

distribusi yang akan digunakan curah hujan rencananya. 
Selanjutnya curah hujan rencana tersebut diubah menjadi 
PUH (Periode Ulang Hujan) yang akan digunakan sebagai 
input di HEC RAS. Rumus perhitungan PUH sebagai 
berikut:  

𝑅𝑡 =  
𝑅24
𝑡

 𝑥 �
𝑡

𝑡 𝑘𝑒 − 𝑛
�
2/3

 
 
𝑅𝑡′ = 𝑡 .𝑅𝑡 − (𝑡 − 1). (𝑅(𝑡−1)) 
Dimana : 
R24 = Tinggi hujan hasil perhitungan distribusi hujan  

(mm) 
Rt  = Tinggi hujan pada waktu ke –t (mm) 
Rt’ = Tinggi hujan pada waktu ke-t yang digunakan 

sebagai   input pada HMS (mm) 
t = waktu yang digunakan (4 jam) 

Sumber  : Power Point Hidrologi 
 

Karena lama hujan di Surabaya menurut SDMP paling 
lama  adalah 4 jam/hari. Maka t yang digunakan adalah 4 
jam. 

 
2.2.6 Analisa Debit 

Analisa debit dimaksudkan untuk menghitung besarnya 
debit banjir rencana yang terjadi, yang nantinya akan 
digunakan untuk perencanaan saluran. Dalam tugas akhir 
ini, digunakan program bantu HEC-HMS untuk 
memperoleh debit banjir pada setiap saluran. 

 
2.2.6.1 Metode Perhitungan Debit dengan HEC-HMS 

Pada pemodelan HEC-HMS terdapat beberapa metode 
perhitungan limpasan (runoff) yang dapat kita gunakan, 
yaitu (HEC-HMS Technical Reference Manual, 2000:38): 
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1. The initial and constant-rate loss model, 
2. The deficit and constant-rate loss model, 
3. The SCS curve number (CN) loss model (composite 
or gridded), dan 
4. The Green and Ampt loss model 
Karena data yang tersedia adalah data karakteristik 

catchment area yang berupa luas, panjang, kemiringan dan 
data tata guna lahan, maka digunakan metode SCS curve 
number (CN) yang dianggap paling mudah di aplikasikan 
dalam perhitungan. 

 
2.2.6.2 Perhitungan Parameter HEC-HMS  

Parameter yang dibutuhkan sebagai data inputan HEC-
HMS dengan metode Soil Conservation Service (SCS) 
meliputi: tinggi hujan, nilai impervious, nilai curve number, 
nilai rata-rata kemiringan lahan, dan time lag. 

Sebelum melakukan pemodelan HEC-HMS, perlu 
perhitungan data yang digunakan sebagai input parameter 
pada HMS. Perhitungan data tersebut adalah : 

1. Perhitungan luas catchment tiap saluran. Untuk 
perhitungan luas bisa diketahui dengan bantuan autocad. 
Dengan cara ketik area, klik catchment yang akan dicari 
luasnya, kemudian klik enter, maka akan keluar secara 
otomatis berapa luas dari catchment area tersebut.  

2. Perhitungan panjang aliran permukaan (overland flow). 
Untuk catchment simetrik dapat dihitung dengan 
persamaan: 

𝑃𝑎𝑛𝑗𝑎𝑛𝑔 =  
𝐿𝑢𝑎𝑠

2 𝑥 𝑝𝑎𝑛𝑗𝑎𝑛𝑔 𝑠𝑎𝑙𝑢𝑟𝑎𝑛
 

Sedangkan untuk daerah aliran satu sisi, panjang aliran 
permukaan dapat dihitung: 

𝑃𝑎𝑛𝑗𝑎𝑛𝑔 =  
𝐿𝑢𝑎𝑠

𝑝𝑎𝑛𝑗𝑎𝑛𝑔 𝑠𝑎𝑙𝑢𝑟𝑎𝑛
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Gambar 2.1 Pendekatan untuk menghitung panjang overland 
flow 

Sumber : Modul Hidrologi 8 
 

3. Perhitungan kemiringan rata-rata lahan. Cara 
menghitungnya dengan cara : 

𝑌 =  
𝑡1 − 𝑡2

𝐿
 𝑥 100% 

Dimana : 
Y = kemiringan rata-rata lahan 
t1 = elevasi di titik awal/bagian tinggi (m) 
t2 = elevasi di bagian akhir/bagian rendah (m) 
L = panjang saluran dari titik awal ke akhir (m) 
Sumber : Modul Hidrologi 8 
 

4. Perhitungan nilai Impervious dan Curve Number. Nilai 
Impervious adalah nilai kedap air, sedangkan Curve 
Number adalah nilai serap air. Perhitungan nilai IM dan CN 
tiap catchment dihitung  menggunakan prosentase dengan 
nilai-nilai tata guna lahan DAS Gunungsari yang telah 
diinterpretasikan sesuai dengan kelompok-kelompok 
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penggunaan lahan dengan karakteristik air limpasan yang 
berbeda. 

Tabel 2.7 Harga CN yang Disesuaikan dengan DAS di Indonesia 

Kelompok Penggunaan Lahan untuk Pematusan Kedap Air % Serap Air CN 

Areal pemukiman (dengan kepadatan penduduk): 
  50-150 orang/ha (kawasan perumahan baru) 85 74 

50-150 orang/ha (kawasan perumahan lama) 70 74 
150-250 orang/ha 85 79 
250-350 orang/ha 90 84 
Lebih dari 350 orang/ha 95 88 
Lahan terbuka : 

  Rerumputan (>75%) 0 74 
Campuran (wilayah rerumputan 25-75%) 0 79 
Lain-lain : 

  Industri, bisnis, dan perdagangan 95 88 
Fasilitas umum/kampus 70 79 
Jalan utama, areal parkir motor dsb 100 

 Sumber  : Surabaya Drainase Master Plan Report 
 
5. Perhitungan Time Lag (tL) 

Sedangkan untuk time lag bisa dihitung dengan rumus : 

𝑡𝐿 =
𝐿0,8𝑥(𝑆 + 1)0,7

1900 𝑥 𝑌0,5  
Dimana : 
𝑡𝐿 = waktu antara datangnya hujan dengan waktu terjadinya 
debit puncak 
L = panjang over land flow (ft) 
S = retensi maksimum (inchi) 
S = 1000/CN-10 
CN = Curve Number yang berisi pengaruh dari tanah, tata 
guna lahan, kondisi hidrologi dan soil moisture. 
Y= kemiringan rata-rata lahan (%) 
Sumber : Modul Hidrologi 8 
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2.2.6.3 Pemodelan HEC-HMS  
  Setelah perhitungan parameter yang akan diinputkan 

pada HEC HMS selesai, maka langkah berikutnya dalah 
pemodelan. Langkah-langkah pemodelan HEC-HMS 
adalah: 

1. Pembuatan Skema Jaringan 
2. Pengisian parameter pada HEC-HMS.  

a. Pengisian luas catchment diisi di menu Parameter → 
Subbasin area. 

b. Pengisian panjang overland flow, manning, width 
diisi di menu Parameter →Routing→Kinematic 
Wave. 

c. Pengisian nilai IM dan CN diisi di menu 
Parameter→Loss→SCS Curve Number. 

d. Pengisian Time Lag diisi di menu Parameter 
→Transform→SCS Unit Hydrograph.  

3. Membuat HMS Component Models 
a. Meteorologic Model adalah model data curah hujan. 

Pembuatannya dengan menu Component → 
Meteorologic Model Manager.  

b. Control Spesifications memuat input waktu kapan 
dimulai dan berakhirnya eksekusi (running) dari 
program serta interval waktu yang diinginkan (15 menit, 
1 jam, atau 1 hari). Pembuatannya dengan cara 
Component →Control Spesifications Manager.  

c. Time-Series Data beberapa tipe data yang akan 
digunakan dalam aplikasi model HEC-HMS dapat 
dibuat. Diantaranya adalah data hujan dan data debit. 
Pembuatannya dengan menu Component →Time Series 
Data Manager. 

4. Pengisian data pada HMS Component Models 
a. Pengisian data pada Time-Series Data. Pengisian data 

hujan pada Time-Series Data ini dengan cara klik Time 
Series Data → Precipitation Gages. 
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b. Pengisian data pada Control Spesification. Untuk 
pengisian waktu pada control spesification ini dengan 
cara klik Control Spesification → Control 1. 

c. Pengisian data pada Meteorologic Models. Untuk 
pengisian model data curah hujan ini dengan cara klik 
Meteorologic models → Met 1 → Specified 
Hyterograph. 

5. Simulasi HMS 
Setelah semua parameter dan data terisi, maka HMS bisa 
disimulasi (running) untuk mendapatkan data debit pada 
saluran tersier, sekunder, dan primer. Untuk simulasi, klik 
Compute → Create Compute → Simulation Run. 
 

2.2.7 Kontrol Debit dengan Hidrograf 
Hasil simulasi pada HMS memberikan hasil berupa 

inflow dan outflow pada tiap catchment area. Untuk 
mengetahui permodelan dengan HMS benar apa tidak, 
maka perlu di kontrol debit dengan hidrograf 

Cara untuk kontrol hidrograf ini adalah, klik result, 
kemudian cari saluran yang akan di kontrol debitnya. 
Kemudian klik Graph, maka aka muncul grafik hidrograf 
dari saluran tersebut. 

Dari grafik tersebut, bisa dihitung volume tiap jam 
dengan cara mencari luasan dari debit pada tiap jam. 
Perhitungan luasan tiap jam tergantung pada bentuk grafik 
per jam. Jika bentuk grafik segitiga maka luasan dihitung 
dengan menggunakan rumus segitiga. Jika grafik berbentuk 
trapesium,maka luasan juga dihitung dengan luasan 
trapesium.  

Setelah volume diketahui, selanjutnya dihitung curah 
hujan efektifnya dengan cara: 
𝑅𝑒𝑓𝑓 = �

𝑡𝑜𝑡𝑎𝑙 𝑣𝑜𝑙𝑢𝑚𝑒 (𝑚3)
𝑙𝑢𝑎𝑠 𝑐𝑎𝑡𝑐ℎ𝑚𝑒𝑛𝑡 𝑠𝑎𝑙𝑢𝑟𝑎𝑛 𝑦𝑎𝑛𝑔 𝑑𝑖𝑡𝑖𝑛𝑗𝑎𝑢 (𝑚2)�𝑥 1000  
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Curah hujan dari perhitungan hidrograf akan dibandingkan 
dengan penjumlahan PUH selama 4 jam pada perhitungan 
2.2.5 . Jika hasil curah hujan efektif mendekati dengan 
penjumlahan PUH, maka pemodelan HMS benar dan bisa 
digunakan sebagai input HEC-RAS. 
 

2.3 Analisa Hidrolika 
Analisa hidrolika bertujuan untuk mengetahui 

kemampuan penampang dalam menampung debit rencana. 
Dalam studi ini perhitungan analisa hidrolika menggunakan 
pemodelan HEC-RAS.  

Data-data yang diperlukan dalam analisa hidrolika ini 
meliputi : 

1. Penampang memanjang sungai 
2. Potongan melintang sungai 
3. Data debit yang melalui sungai 
4. Angka manning penampang sungai 

Analisa hidrolika ini terdiri dari analisa penampang 
eksisting dan analisa penampang rencana. 

 
2.3.1 Analisa Penampang Eksisting 

Analisa penampang eksisting ini bertujuan untuk 
mengetahui apakah kondisi eksisting saluran mampu 
menampung debit yang direncanakan. Modul aliran yang 
digunakan adalah steady flow data.  

Steady flow data adalah aliran yang mana kondisi 
alirannya (kecepatan, tekanan, densitas, dsb) tidak berubah 
dengan waktu.  

Untuk membuat model aliran eksisiting, input data yang 
digunakan adalah: 
1. Data Geometri yang meliputi skema alur saluran yang 

ditinjau, data penampang memanjang dan melintang 
sungai. 

2. Data debit yang masuk ke saluran berdasarkan 
pemodelan HEC-HMS 
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3. Data hidrolika yang meliputi; koefisien manning (n) 
yang menunjukkan kekasaran dasar saluran dan tanggul 
kanan kiri. 
Langkah-langkah yang harus dilakukan untuk analisa 

penampang eksisting : 
1. Membuat sket saluran yang ditinjau dengan cara klik 

menu Edit → Geometric Data. 
2. Input data cross section saluran dengan cara klik menu 

Edit → Geometric Data → Cross Section → Options 
→ Add new cross section. 

3. Input data debit yang diperoleh dari pemodelan HEC-
HMS. Untuk memasukkan data debit pilih menu 
Edit→Steady Flow Data.  

4. Simulasi HEC-RAS 
Setelah semua data selesai di input, maka HEC-RAS 
bisa disimulasi (running) untuk mengetahui profil muka 
air penampang eksisting dan mengetahui apakah 
penampang eksisting mampu menampung debit yang 
direncanakan. 

 
2.3.2 Analisa Penampang Rencana 

 Analisa ini disebut juga normalisasi, bertujuan untuk 
mendapatkan dimensi yang bisa menampung debit yang 
mengalir. Modul yang digunakan adalah unsteady flow 
data. 

Unsteady flow data adalah aliran yang mana kondisi 
alirannya (kecepatan, tekanan, densitas, dsb) berubah 
dengan waktu. Langkah-langkah untuk analisa penampang 
rencana adalah: 

1. Perencanaan kemiringan dasar saluran 
Perencanaan berdasarkan dengan kondisi eksiting, diambil 
rata-rata dari kemiringan eksisting hulu sampai hilir. 
Kemudian dibuat elevasi dasar saluran yang baru sehingga 
akan menghasilkan kemringan rencana. Rumus perhitungan 
kemringan sebagai berikut : 
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𝐼 =  
𝑡1 − 𝑡2

𝐿
  

Dimana : 
I = kemiringan dasar saluran 
t1= elevasi di titik awal/bagian tinggi (m) 
t2= elevasi di bagian akhir/bagian rendah (m) 
L = panjang saluran dari titik awal ke akhir (m) 

 
2. Perhitungan Dimensi Rencana 

Bertujuan untuk mendapatkan dimensi yang bisa 
menampung debit yang mengalir. Perhitungan ini dihitung di 
excel dengan rumus manning. Hasil dimensi yang sesuai 
kemudian akan dimodelkan di HEC-RAS. 
Rumus manning:  𝑄 =  1

𝑛
 𝑥 𝐼1/2 𝑥 𝑅2/3 𝑥 𝐴 

Dimana : 
Q : Debit aliran (m3/s) 
A : Luas penampang basah (m2) 
n : Koefisien kekasaran manning 
R : Jari-jari hidrolis sungai (m) 
I : Kemiringan hidraulik sungai 

 
3. Pemodelan pada HEC-RAS 

Setelah diketahui dimensi yang bisa menampung debit 
perencanaan yang mengalir, dimensi tersebut bisa 
dimodelkan pada HEC-RAS. Proses pemodelan HEC-RAS 
hampir sama dengan pemodelan pada kondisi eksisiting. 
Adapun tahapannya sebagai berikut: 
a) Save as geometry data 

Pada geometry data kondisi eksisting sket saluran yang 
ditinjau telah dibuat, agar tidak membuat sket lagi maka 
geometry data perlu di save as dan disimpan dengan 
nama yang berbeda, dengan cara klik File →Save 
Geometry Data As→Isikan nama file pada Title → OK. 
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b) Input data dimensi penampang rencana 
Sama seperti tahapan pada pengisian data pada kondisi 
eksiting, klik cross section pada geometric data. Pilih 
Cross Section→Options→Add new cross section. Isikan 
data-data perencanaan. Setelah semua data diisi, klik 
apply data. Kemudian akan muncul bentuk penampang 
sesuai dengan data cross section yang dimasukkan. 

c) Input data debit (Unsteady Flow Data) 
Data debit diperoleh dari pemodelan HEC-HMS. Debit 
yang dimasukkan pada HEC-RAS adalah debit jam-
jaman atau debit yang berupa unit hydrograph yang 
masuk ke tiap saluran primer dan lateral inflow yang 
terdapat pada saluran primer tersebut.Untuk memasukkan 
data debit pilih menu Edit → Unsteady Flow Data. Pada 
boundary condition klik flow/lateral hydrograph. Isikan 
data debit yang masuk. 

d) Run program  
Setelah semua data selesai dimasukkan, pilih 
Run→Unsteady Flow Analysis. 
 

4. Pemodelan pintu air pada HEC-RAS 
Tahapan pemodelan pintu pada HEC-RAS adalah sebagai 
berikut: 

a) Save as geometry data normalisasi 
Agar tidak input data dari awal, maka perlu save as 
geometry data hasil normalisasi. klik File →Save 
Geometry Data As→Isikan nama file pada Title → OK. 

b) Menentukan letak pintu air 
Tentukan letak pintu air yang akan dipasang pintu air 
kemudian buat cross section baru. Pada geometry data 
klik cross section → cari cross section yang akan di 
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copy → Options →Copy current cross section → ketik 
nama RS pada kolom River Sta. 

c) Inline Structure 
Setelah membuat cross section baru klik inline structure 
pada editor geometric data. Kemudian klik Options → 
Add an Inline Structure. Klik Gate, kemudian isikan 
berapa tinggi dan lebar pintu rencana. Klik 
weir/embankment, ini bertujuan untuk memodelkan 
struktur beton di sekitar pintu air. Pada distance isikan 
jarak dari river sta ke lokasi pintu air, width adalah tebal 
pintu air, sedangkan untuk station dan elevation isikan 
jarak dan elevasi tanggul pada river sta lokasi pintu air. 

d) Pengisian unsteady flow data 
Setelah pemodelan pintu selesai langkah selanjutnya 
adalah mengatur tinggi bukaan pintu. Untuk mengatur 
tinggi bukaan pintu klik menu Edit → Unsteady Flow 
Data. Pada boundary condition klik T.S Gate Openings. 
Isikan tinggi bukaan pintu. 

e) Simulasi program 
Setelah semua data selesai dimasukkan, pilih 
Run→Unsteady Flow Analysis. 

 
5. Pemodelan pompa air pada HEC-RAS 

Tahapan pemodelan pompa pada HEC-RAS adalah sebagai 
berikut: 
a) Menentukan letak pompa 

Tentukan cross section yang akan dipasang pompa 
kemudian buat cross section baru. 

b) Operasional Pompa 
Pada geometric data klik pump station, kemudian isikan 
data pada pump station data editor.Data yang diisi antara 
lain letak pompa di cross section mana, elevasi tertinggi 
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dari letak pompa, kapasitas pompa, jumlah pompa yang 
beroperasi, elevasi dimana pompa akan mulai beroperasi 
dan elevasi dimana pompa berhenti beroperasi. 

c) Simulasi program 
Setelah semua data selesai dimasukkan, pilih 
Run→Unsteady Flow Analysis. 
 

2.3.3 Analisa Backwater 
 Backwater terjadi akibat pengaruh pasang surut di 
muara sungai yaitu pada saat permukaan air laut melebihi 
permukaan air sungai, sehingga alirannya berbalik dari laut 
masuk menuju sungai. Tentunya hal ini dapat berpengaruh 
terhadap sungai itu sendiri diantaranya adalah banjir karena 
meluapnya air.  
 Untuk menghindari backwater bisa dengan 
perencanaan pintu air. Akan tetapi jika nilai pasang surut 
rendah dan pengaruh backwater kecil, maka bisa 
direncanakan tanggul saja. 
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BAB III 
METODOLOGI 

 
 Dalam penulisan tugas akhir ini metode pengerjaan 
yang digunakan adalah: 
 
3.1 Tahap Persiapan 
  Tahap persiapan ini untuk menentukan lokasi yang 
ditinjau untuk pengerjaan tugas akhir. Lokasi yang ditinjau 
adalah saluran primer di DAS Gunungsari bagian hilir, yaitu di 
saluran primer Margomulyo, Kali Balong, Kali Kandangan, 
dan Kali Sememi. 
 
3.2 Studi Literatur 
 Mempelajari ilmu-ilmu dan mencari referensi tentang 
drainase, HEC-HMS, dan HEC-RAS untuk menunjang 
pengerjaan tugas akhir. 
 
3.3 Pengumpulan Data 
 Pengumpulan data diperoleh dari data primer dan data 
sekunder. 
3.3.1  Data Primer : 
 Data primer yang harus dikumpulkan antara lain: 

a) Data pengukuran dan survei 
Data yang didapat adalah dimensi saluran eksisting 
saluran yang ditinjau dan arah aliran. 

3.3.2 Data Sekunder: 
 Data sekunder yang harus dikumpulkan antara lain: 

a) Peta jaringan saluran drainase 
b) Peta lokasi dan peta DAS Gunungsari 
c) Peta topografi 
a) Data curah hujan 

Data hujan diperlukan dari 4 stasiun pencatat curah 
hujan, yaitu stasiun hujan Kandangan, stasiun hujan 
Banyu urip, stasiun Gubeng dan stasiun hujan 
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Gunungsari. Data curah hujan tersebut kemudian 
dijadikan input dalam program bantu HEC-HMS. 

b) Data tata guna lahan. 
Data tata guna lahan ini diperlukan untuk 
mendapatkan nilai koefisien pengaliran pada DAS 
Gunungsari. 
 

3.4  Sistematika Penyelesaian Masalah 
  Penyusunan penyelesaian masalah berdasarkan 
perencanaan pengendalian banjir, yaitu meliputi: 
3.4.1 Analisa Hidrologi  
 Pada tahap analisa hidrologi akan dilakukan proses 
perhitungan data curah hujan dengan perhitungan distribusi 
curah hujan wilayah dan analisa distribusi sehingga 
mendapatkan curah hujan tahunan sesuai dengan periode yang 
direncanakan. Tahap selanjutnya curah hujan tahunan tersebut 
diubah menjadi PUH (periode ulang hujan). 

Setelah diketahui nilai PUH, selanjutnya adalah 
perhitungan analisa debit.  Analisa debit dimaksudkan untuk 
menghitung besarnya debit banjir rencana periode ulang 10 
tahun, yang nantinya akan digunakan untuk perencanaan 
saluran. Dalam tugas akhir ini, digunakan program bantu 
HEC-HMS untuk memperoleh debit banjir pada setiap saluran. 

Metode HEC-HMS yang digunakan adalah metode 
Soil Conservation Service (SCS) curve number (CN). 
Parameter yang dibutuhkan sebagai data input meliputi : luas 
area tiap catchment, panjang overlandflow, nilai impervious, 
nilai curve number, nilai rata-rata kemiringan lahan, time lag, 
dan tinggi PUH. 

Setelah semua parameter dimasukkan dalam model, 
maka langkah selanjutnya proses simulasi model yang 
hasilnya berupa data debit saluran dan diharapkan akan sesuai 
dengan kenyataan dilapangan. 
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3.4.2 Analisa Hidrolika 
Analisa hidrolika ini meliputi analisa penampang 

eksisting, analisa penampang rencana, dan analisa backwater. 
Analisa ini akan dihitung dengan program bantu HEC-RAS. 

Input data yang digunakan meliputi: profil memanjang 
dan melintang saluran, debit yang masuk ke saluran 
berdasarkan perhitungan HEC-HMS, dan koefisien manning.
 Untuk output dari HEC-RAS berupa profil muka air 
dan kecepatan aliran. Dari output tersebut bisa digunakan 
untuk melakukan normalisasi pada saluran. 
 
3.4.3  Analisa Backwater 

 Backwater terjadi akibat pengaruh pasang surut di 
muara sungai yaitu pada saat permukaan air laut melebihi 
permukaan air sungai, sehingga alirannya berbalik dari laut 
masuk menuju sungai. Tentunya hal ini dapat berpengaruh 
terhadap sungai itu sendiri diantaranya adalah banjir karena 
meluapnya air yang seharusnya dibuang ke laut. Untuk 
mencegah terjadinya pengaruh backwater bisa dengan cara 
direncanakan pintu air di bagian hilir. Namun jika pengaruh 
backwater kecil, maka bisa juga dengan direncanakan tanggul. 
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3.5  Diagram Alir Perencanaan 

Berikut adalah diagram alir dalam penyusunan tugas 
akhir : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mulai 

Tinjauan Lapangan 
dan Study Literatur 

Analisa Hidrologi dengan pemodelan HEC-HMS 

 

Pengumpulan data : 

1. Peta jaringan saluran 
2. Peta lokasi dan DAS 
3. Peta topografi 
4. Peta tata guna lahan 
5. Geometri saluran 
6. Data hujan 

 

A 
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Selesai 

Tidak 

Penampang saluran 
mampu menampung 

debit banjir 

Analisa Hidrolika  dengan pemodelan HEC-RAS 

Ya 

A 

Gambar 3.1 Diagram Alir Perencanaan 
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3.6  Alur Kegiatan Pengerjaan Tugas Akhir 

 

 

 

 

 

 

 

No Uraian Kegiatan Minggu 
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 

1 Survei Lapangan                                 
2 Pengumpulan data                                 
3 Analisa Hidrologi                                 
4 Analisa Hidrolika                                 

5 
Penyusunan Laporan Tugas 
Akhir                                 

Tabel 3.1 Alur Kegiatan Pengerjaan Tugas Akhir 
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BAB IV 

ANALISA HIDROLOGI 
 

4.1 Analisa Topografi  
Perencanaan drainase saluran primer Kali Sememi, Kali 

Kandangan, dan Kali Balong terletak pada DAS Gunungsari. 
Jarak Kali Balong dengan Kali Kandangan bagian hilir sungai 
adalah 974 m. Sedangkan jarak antara Kali Kandangan dan Kali 
Sememi bagian hilir adalah 1741 m. Gambar 4.1 menunjukkan 
lokasi perencanaan drainase. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4.1 DAS Gunungsari Surabaya 
 
Sumber : Surabaya Drainage Master Plan 2000 
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4.2 Daerah Aliran Sungai (DAS) 
Peta DAS dan stasiun hujan yang ditinjau untuk 

perencanaan drainase sudah di dapatkan dari SDMP Surabaya 
dalam bentuk CAD. Dari peta tersebut dapat diketahui luas DAS 
dan luas stasiun hujan yang ditinjau. Stasiun hujan yang ditinjau 
adalah stasiun hujan Gunungsari, stasiun hujan Kandangan, 
stasiun hujan Banyu Urip dan stasiun hujan Gubeng. 

Langkah-langkah untuk memperoleh luasan tersebut 
adalah : 

1. Peta yang ada dalam bentuk Autocad.  
2. Pada peta tersebut sudah diketahui batas DAS dan letak 

stasiun hujan yang ditinjau. 
3. Dari stasiun hujan yang ditinjau ditarik garis yang 

menghubungkan antara letak stasiun hujan. Kemudian 
masing-masing garis penghubung tersebut dicari titik 
tengah yang memotong sama panjang di kedua sisinya.  

4. Dari titik-titik tersebut ditarik garis tegak lurus yang 
memotong garis penghubung antara stasiun hujan 1 
dengan yang lainnya, kemudian terbentuklah garis 
pengaruh. Dari garis pengaruh tersebut diperpanjang 
sampai memotong batas DAS dan sampai keempat garis 
tersebut memotong satu sama lain.  

5. Garis penghubung bisa dihilangkan untuk memudahkan 
mengetahui daerah pengaruh dari tiap-tiap stasiun hujan 
yang ditinjau.  

6. Pakai icon bantu polyline untuk membuat batas DAS dan 
batas pengaruh supaya dapat dicari luasannya. Kemudian 
pakai icon bantu list.  

7. Maka bisa diketahui luasan tiap stasiun hujan 
8. Luas DAS bisa dihitung dengan menjumlah luas keempat 

stasiun tersebut 
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Gambar 4.2 Peta DAS Gunungsari dan Stasiun Hujan yang 
ditinjau 

 
Sumber : Surabaya Drainage Master Plan 2000 
 

4.3 Analisa Curah hujan  
Untuk perhitungan analisa hidrologi , dibutuhkan data 

hujan pada kawasan yang akan direncanakan sistem drainase. 
Digunakan 4 stasiun hujan terdekat yang akan mempengaruhi 
DAS Gunungsari dengan data hujan ditiap-tiap stasiun hujan 
minimal 10 tahun.  

Ada 3 metode yang sering digunakan untuk perhitungan 
analisa curah hujan, yaitu Metode Aritmatik, Metode Poligon 
Thiessen, dan Metode Ishoyet. Dari ketiga metode diatas perlu 
dipilih metode yang sesuai untuk digunakan pada suatu daerah 
tangkapan air. Ada ketentuan-ketentuan yang digunakan untuk 
menentukan metode apa yang akan dipakai seperti tabel dibawah 
ini.  
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Tabel 4.1 Pertimbangan Cara yang Dapat Digunakan 
Parameter Kondisi Cara yang dapat 

digunakan 
Jumlah 
stasiun 
hujan 

Cukup 
 

Aritmetika, Thiessen 
Poligon, Ishoyet 

Terbatas Rerata Aritmetik, 
Thiessen Poligon 

Luas Das >5000 km2 (Besar) 
501 – 5000 km² 
(sedang) 

Ishoyet 
Thiessen Poligon 

<500 km² (kecil) Rerata Aritmatik 
Kondisi 
Topografi 

Pegunungan Thiessen Poligon 
Dataran Aljabar 
Berbukit dan Tidak 
Beraturan 

Ishoyet dan Thiessen 
Poligon 

Sumber : Suripin, 1998 
 

Pada kawasan DAS Gunungsari, jumlah stasiun yang ada 
termasuk kategori cukup, terletak pada wilayah dataran, dan 
memiliki luas DAS < 500 km², maka untuk menghitung curah 
hujan digunakan cara Poligon Thiessen,Rerata Aritmatik, dan 
Aljabar. 

Metode perhitungan dengan Rerata Aritmatik merupakan 
cara yang yang paling sederhana, tetapi memberikan hasil yang 
tidak teliti (Suyono,1987). Hal tersebut diantaranya karena setiap 
stasiun dianggap mempunyai bobot yang sama. Hal ini hanya 
dapat digunakan kalau hujan yang terjadi dalam DAS homogen 
dan variasi tahunnya tidak terlalu besar. Keadaan hujan di 
Indonesia (daerah tropik pada umumnya) sangat bersifat 
‘setempat’, dengan variasi ruang yang sangat besar. 

Sedangkan cara hitungan dengan rumus metode Thiessen 
merupakan metode yang memperhitungkan bobot dari masing-
masing stasiun yang mewakili luasan disekitarnya. Metode ini 
digunakan apabila penyebaran stasiun hujan didaerah yang 
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ditinjau tidak merata (Suyono,2006). Untuk bobot dari masing-
masing stasiun bisa dihitung dengan rumus koefisien DAS =  
 

 
Karena data yang tersedia adalah data hujan harian 

selama 10 tahun, maka dicari curah hujan maksimal tiap 
tahunnya dengan metode kejadian yang sama, dimana setiap 
hujan maksimum di setiap stasiun dijadikan patokan untuk 
kejadian hujan di tanggal yang sama. Kemudian dari curah hujan 
maksimal tersebut bisa dihitung curah hujan wilayah 
menggunakan metode Poligon Thiessen, dengan persamaan 
rumus berikut: 
𝑅� = 𝑅1𝑥 𝑘𝑜𝑒𝑓. 𝑠𝑢𝑏 𝐷𝐴𝑆 1 + 𝑅2 𝑥 𝑘𝑜𝑒𝑓. 𝑠𝑢𝑏 𝐷𝐴𝑆 2 +  𝑅3 𝑥 𝑘𝑜𝑒𝑓. 𝑠𝑢𝑏 𝐷𝐴𝑆 3)    

Gambar pembagian metode Poligon Thiessen pada 
Gambar 4.3  

 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 4.3 Poligon Thiessen 

Contoh perhitungan koefisien sub DAS / bobot tiap stasiun : 
Koefisien stasiun Kandangan = 𝐿𝑢𝑎𝑠 𝑆𝑢𝑏 𝐷𝐴𝑆 𝐾𝑎𝑛𝑑𝑎𝑛𝑔𝑎𝑛

𝐿𝑢𝑎𝑠 𝑡𝑜𝑡𝑎𝑙 𝐷𝐴𝑆 𝐺𝑢𝑛𝑢𝑛𝑔𝑠𝑎𝑟𝑖
 

 
   =  40,6 𝑘𝑚2

49,09 𝑘𝑚2 = 0,827 
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Maka koefisien tiap stasiun sebagai berikut: 
Koef. stasiun Kandangan  = 0,827 
Koef. stasiun Gunungsari  = 0,070 
Koef. stasiun Gubeng  = 0,001 
Koef. stasiun Banyu Urip  = 0,102 

 
Contoh perhitungan curah hujan maksimal : 
Data curah hujan pada tahun 2003: 
R1max (Stasiun Kandangan) di tahun 2003 = 117 mm, terjadi 
pada tanggal 14 Februari 2003. Maka di tanggal yang sama, 
nilai hujan tiap stasiun adalah:  
R2 (Stasiun Gunungsari) = 16 mm 
R3 (Stasiun Gubeng)  = 23.5 mm 
R4 (Stasiun Banyu Urip) = 19 mm 
 
R2max (Stasiun Gunungsari) di tahun 2003 = 98 mm, terjadi 
pada tanggal 16 Maret 2003. Maka di tanggal yang sama, nilai 
hujan tiap stasiun adalah: 
R1 (Stasiun Kandangan) = 45 mm 
R3 (Stasiun Gubeng)  = 14.5 mm 
R4 (Stasiun Banyu Urip) = 166 mm 
 
R3max (Stasiun Gubeng)  di tahun 2003 = 68 mm, terjadi pada 
tanggal 27 November  2003. Maka di tanggal yang sama, nilai 
hujan tiap stasiun adalah: 
R1 (Stasiun Kandangan) = 20 mm 
R2 (Stasiun Gunungsari) = 4 mm 
R4 (Stasiun Banyu Urip) = 60 mm 
 
R4max (Stasiun Banyu Urip) di tahun 2003 = 174 mm, terjadi 
pada tanggal 28 November  2003. Maka di tanggal yang sama, 
nilai hujan tiap stasiun adalah: 
R1 (Stasiun Kandangan) = 99 mm 
R2 (Stasiun Gunungsari) = 76 mm 
R3 (Stasiun Gubeng)  = 33 mm 
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tahun tanggal Stasiun Kandangan Stasiun Gunungsari Stasiun Gubeng Stasiun Banyu Urip
0.827 0.070 0.001 0.102

2003 14-Feb-03 117 16 23.5 19 99.85
2003 16-Mar-03 45 98 14.5 166 60.98
2003 27-Nov-03 20 4 68 60 23.03
2003 28-Nov-03 99 76 33 174 104.95
2004 24-Dec-04 79 27 83 81 75.59
2004 5-Mar-04 62 103 0 152 73.94
2004 27-Mar-04 67 16 86 74 64.19
2004 5-Mar-04 62 103 67 152 74.03
2005 24-Dec-05 79 0 0 0 65.34
2005 24-Nov-05 0 114 0 0 7.94
2005 8-Mar-05 0 16 89 89 10.31
2005 13-Dec-05 0 86 89 138 20.18
2006 1-Jan-06 87 5 7 5 72.82
2006 7-Mar-06 29 110 60 57 37.54
2006 14-Jan-06 22 54 106 70 29.24
2006 22-Feb-06 9 34 5 132 23.27

65.34

72.82

75.59

R CH WILAYAH
koefisien 

104.95

Curah hujan wilayah 14 Februari 2003 : 
𝑅� = (117 𝑚𝑚 𝑥0,827) + (16 𝑚𝑚 𝑥0,070) + (23.5 𝑚𝑚 𝑥0,001) + (19 𝑚𝑚 𝑥 0,102) 
𝑅� = 99,85 𝑚𝑚  
 
Curah hujan wilayah 16 Maret 2003: 
𝑅� = (45 𝑚𝑚 𝑥0,827) + (98 𝑚𝑚 𝑥0,070) + (14.5 𝑚𝑚 𝑥0,001) + (166 𝑚𝑚 𝑥 0,102) 
𝑅� = 60,98 𝑚𝑚  
 
Curah hujan wilayah 27 November  2003: 
𝑅� = (20 𝑚𝑚 𝑥0,827) + (4 𝑚𝑚 𝑥0,070) + (68 𝑚𝑚 𝑥0,001) + (60 𝑚𝑚 𝑥 0,102) 
𝑅� = 23,03 𝑚𝑚  
 
Curah hujan wilayah 28 November  2003: 
𝑅� = (99 𝑚𝑚 𝑥0,827) + (76 𝑚𝑚 𝑥0,070) + (33 𝑚𝑚 𝑥0,001) + (174 𝑚𝑚 𝑥 0,102) 
𝑅� = 104,95 𝑚𝑚  
 
Dari perhitungan curah hujan wilayah diatas, maka untuk 
mengetahui curah hujan wilayah pada tahun 2003 adalah dipilih 
yang terbesar yaitu 104,95 mm. Curah hujan wilayah tiap tahun 
bisa dilihat pada Tabel 4.2 . 
 
Tabel 4.2 Curah Hujan Wilayah tiap Tahun di DAS Gunungsari 
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 tahun tanggal Stasiun Kandangan Stasiun Gunungsari Stasiun Gubeng Stasiun Banyu Urip

0.000 0.000 0.000 0.000
2007 8-Mar-07 97 63 56 89 93.76
2007 21-Mar-07 69 96 101 74 71.43
2007 18-Dec-07 82 58 104 9 72.92
2007 4-Dec-07 35 64 70 107 44.41
2008 13-Dec-08 120 47 46 79 110.64
2008 28-Dec-08 57 81 48 67 59.68
2008 14-Dec-08 37 9 98 42 35.65
2008 17-Dec-08 26 58 32 87 34.45
2009 17-Dec-08 78 22 57 97 76.01
2009 9-Jan-09 76 78 58 107 79.27
2009 28-Nov-09 16 8 86 19 15.85
2009 9-Jan-09 76 78 58 107 79.27
2010 3-Dec-10 127 92 106 0 111.59
2010 1-Dec-10 9 114 19 0 15.41
2010 3-Dec-10 127 92 106 0 111.59
2010 25-Mar-10 83 73 20 89 82.83
2012 30-Jan-12 82 89 57 67 80.92
2012 1-Jan-12 18 102 69 41 26.26
2012 16-Jan-12 57 63 70 45 56.21
2012 30-Jan-12 82 89 57 67 80.92
2014 5-Mar-14 81 71 78 0 72.04
2014 19-Dec-14 33 86 109 78 41.38
2014 19-Dec-14 33 86 109 70 40.57
2014 6-Dec-14 0 44 61 78 11.10

R CH WILAYAH
koefisien 

80.92

72.04

93.76

110.64

79.27

111.59

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

4.4 Perhitungan Parameter Dasar statistik  
Perhitungan ini digunakan untuk menentukan distribusi 

frekuensi yang akan digunakan. Dalam perhitungan parameter 
dasar statistik ini akan dicari nilai Cs, Ck, Cv, Standar deviasi, 
dan Xrata-rata. Adapun perhitungan terlampir pada Tabel 4.3 . 

 
 
 
 
 
 
 
 



45 
 

 
 

Tabel 4.3 Parameter Dasar Statistik 

Tahun CH max 
 

  
 

2003 104.95 18.26 333.35 6086.39 111125.27 
2004 75.59 -11.10 123.25 -1368.37 15191.65 
2005 65.34 -21.35 455.91 -9734.55 207852.02 
2006 72.82 -13.87 192.43 -2669.42 37030.22 
2007 93.76 7.07 49.96 353.09 2495.66 
2008 110.64 23.95 573.51 13734.34 328909.94 
2009 79.27 -7.42 55.09 -408.85 3034.48 
2010 111.59 24.90 619.91 15434.53 384288.91 
2012 80.92 -5.77 33.32 -192.30 1109.95 
2014 72.04 -14.65 214.68 -3145.51 46087.98 

jumlah 866.92   2651.41 18089.35 1137126.07 
rata-rata 86.69         
 
n    = 10 
n-1 = 9 
n-2 = 8 
n-3 = 7 

 
 Metode Normal dan Gumbel 

Perhitungan Standar Deviasi 

𝑆𝑑 =  �∑(𝑋𝑖−𝑋�)2

𝑛−1
=  �2651,41

10
= 17,16 𝑚𝑚  

 Perhitungan Nilai Koefisien Skewness (Cs) 
𝐶𝑠 =  𝑛

(𝑛−1)(𝑛−2)𝑠3 ∑ (𝑥𝑖 − 𝑥̅)3𝑛
𝑖=1   

𝐶𝑠 =  10
9 𝑥 8 𝑥 17,163

 𝑥 18089,35 = 0,50  
 Perhitungan Nilai Koefisien Kurtosis (Ck) 

𝐶𝑘 =  𝑛2.
(𝑛−1)(𝑛−2)𝑆4

∑ (𝑥𝑖 − 𝑥̅)4𝑛
𝑖=1   

𝐶𝑘 = 100
9 𝑥 8 𝑥 17,164

𝑥 1137126,07  
𝐶𝑘 = 2,60 

 
 

iX X− 2( )iX X− 3( )iX X− 4( )iX X−
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 Perhitungan Nilai Koefisien Variasi (Cv) 
𝐶𝑣 =  𝑠

𝑥̅
  

𝐶𝑣 =  17,16
86,69

= 0,20  
 Metode Log Normal 

Cs = Cv³ + 3(Cv) 
Cs = 0,20³ + 3 (0,20) 
Cs = 0,60 
Ck = Cv8 + 6Cv6 + 15Cv4 + 16Cv2 + 3 
Ck = 0,20⁸+6(0,20⁶)+15(0,20⁴)+16(0,20²)+3 
Ck = 3,65 

 
Setiap distribusi memiliki syarat-syarat parameter 

statistik. Pada Tabel 4.4 akan dipaparkan penentuan distribusi 
hujan berdasarkan syarat-syarat parameter statistik. 

Tabel 4.4 Penentuan Distribusi Curah Hujan 
No Distribusi Persyaratan Hasil 

Hitungan keterangan 

1 Normal Cs = 0 0,50 tidak 
diterima 

  
Ck = 3 2,60 

2 Log Normal Cs = Cv³+3Cv 0,60 tidak 
diterima 

  
Ck = Cv⁸ + 6Cv⁶ + 15Cv⁴ +16Cv² + 3 3,65 

3 Gumbel Cs = 1,14 0,50 tidak 
diterima 

  
Ck = 5,4 2,60 

4 Log Pearson III Selain dari nilai diatas/flexibel 
 

Diterima 
sumber : Triatmodjo, 2010 

 
Dari perhitungan parameter statistik diatas dan ditinjau 

dari persyaratannya,maka distribusi yang sesuai adalah distribusi 
Log Pearson tipe III. 

 
4.5 Analisa Distribusi Frekuensi 

Dari perhitungan parameter dasar statistik, distribusi 
frekuensi yang sesuai adalah distribusi Log Pearson tipe III. Dari 
perhitungan ini akan dihasilkan hujan rencana pada periode yang 
telah ditentukan. 
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1 2010 111.59 2.05 0.1171 0.0137 0.00161 0.000188
2 2008 110.64 2.04 0.1134 0.0129 0.00146 0.000165
3 2003 104.95 2.02 0.0905 0.0082 0.00074 0.000067
4 2007 93.76 1.97 0.0415 0.0017 0.00007 0.000003
5 2012 80.92 1.91 -0.0225 0.0005 -0.00001 0.000000
6 2009 79.27 1.90 -0.0314 0.0010 -0.00003 0.000001
7 2004 75.59 1.88 -0.0521 0.0027 -0.00014 0.000007
8 2006 72.82 1.86 -0.0683 0.0047 -0.00032 0.000022
9 2014 72.04 1.86 -0.0729 0.0053 -0.00039 0.000028

10 2005 65.34 1.82 -0.1153 0.0133 -0.00153 0.000177
19.31 0.0000 0.0640 0.00145 0.000659
1.93

Jumlah
Rata-rata

xi - x (xi - x)² (xi-x)³ (xi-x)⁴No Tahun xi Log xi

Tabel 4.5 Perhitungan Log Pearson tipe III 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Perhitungan Standar Deviasi 
 

𝑆 log𝑋��������� =  �∑(𝐿𝑜𝑔 𝑋− 𝐿𝑜𝑔 𝑋��������)2

𝑛−1
  

𝑆 log𝑥�������� = �0.0640
9

= 0,08 𝑚𝑚  

o Perhitungan koefisien skewness (Cs) untuk Log Pearson tipe III 
𝐶𝑠 =  𝑛∑(𝐿𝑜𝑔 𝑋− 𝐿𝑜𝑔 𝑋��������)3

(𝑛−1)(𝑛−2)(𝑆 𝐿𝑜𝑔 𝑋�����������)3  
 

𝐶𝑠 =  
10 𝑥 (0,00145)

9 𝑥 8 𝑥 0,8³
 

 
𝐶𝑠 =  0,34  0,3 

o Perhitungan Curah Hujan Rencana 
Berdasarkan nilai Cs = 0,3 , maka dapat ditentukan nilai k untuk 
setiap periode ulang, sehingga untuk periode ulang : 

• 2 tahun : 
𝐿𝑜𝑔 𝑋2 =  𝐿𝑜𝑔 𝑋�������� + 𝑘. (𝑆. 𝐿𝑜𝑔 𝑋�����������)  
𝐿𝑜𝑔 𝑋2 = 1,93 + (−0,05) 𝑥 0,08  
𝑋2          = 84,39 𝑚𝑚  
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• 5 tahun 
𝐿𝑜𝑔 𝑋5 =  𝐿𝑜𝑔 𝑋�������� + 𝑘. (𝑆. 𝐿𝑜𝑔 𝑋�����������)  
𝐿𝑜𝑔 𝑋5 = 1,93 + 0,824 𝑥 0,08  
𝑋5          = 100  𝑚𝑚  

• 10 tahun 
𝐿𝑜𝑔 𝑋10 =  𝐿𝑜𝑔 𝑋�������� + 𝑘. (𝑆. 𝐿𝑜𝑔 𝑋�����������)  
𝐿𝑜𝑔 𝑋10 = 1,93 + 1,309 𝑥 0,08  
𝑋10          = 109,87 𝑚𝑚  
Untuk nilai k pada perhitungan curah hujan rencana, 

didapat dari tabel Nilai k Distribusi Pearson tipe III dan Log 
Pearson tipe III seperti pada gambar 4.4 berikut ini: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Sumber : Soewarno, 1995. 
Gambar 4.4 Tabel Nilai k untuk Distribusi Log Pearson tipe III 
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4.6 Uji Kecocokan 
Ada dua cara yang dapat dilakukan untuk menguji apakah 

jenis distribusi yang dipilih sesuai dengan data yang ada, yaitu uji 
Chi-Kuadrat dan Smirnov-Kolmogoro ( Bambang Triatmojo, 2010) 
. 

4.6.1 Uji Chi Kuadrat 
Perhitungan Chi Kuadrat untuk Log Pearson III: 

• Banyaknya data (n)   = 10 
• Derajat signifikan (α)   = 5% 
• Jumlah kelas/Sub Kelompok (G)  = 1 + 3,322 Log n 

= 1 + 3,322 Log 10 
= 4,32~ 4 

• Derajat Kebebasan (DK)  = G – R – 1 
= 4 – 2 – 1 = 1 
 

Tabel 4.6 Perhitungan Chi-Kuadrat untuk Log Pearson tipe III 
Tahun Data CH Peringkat Peluang (xi - x ) (xi - x)2 xi m P = m/(n+1) 
2010 2.05 1 9% 0.12 0.0137 
2008 2.04 2 18% 0.11 0.0129 
2003 2.02 3 27% 0.09 0.0082 
2007 1.97 4 36% 0.04 0.0017 
2012 1.91 5 45% -0.02 0.0005 
2009 1.90 6 55% -0.03 0.0010 
2004 1.88 7 64% -0.05 0.0027 
2006 1.86 8 73% -0.07 0.0047 
2014 1.86 9 82% -0.07 0.0053 
2005 1.82 10 91% -0.12 0.0133 

∑ 19.31 
  

0.00 0.0640 
rata-rata (x) 1.93 

     
• Menentukan nilai batas sub kelompok 

Dari perhitungan diatas didapatkan ada 4 sub kelompok. 
Dari 4 sub kelompok tersebut ditentukan nilai batas tiap 
kelompok. Perhitungan nilai batas sub kelompok menggunakan 
rumus: 
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Log 𝑋 =  𝑋� + 𝑘. 𝑆 
Nilai k didapat dari tabel variabel reduksi Gauss. 

 
    Tabel 4.7 Nilai Variabel Reduksi Gauss 

Periode Ulang T 
(tahun) 

Peluang 
(P) k 

1,001 0,999 -3,05 
1,005 0,995 -2,58 
1,01 0,99 -2,33 
1,05 0,95 -1,64 
1,11 0,9 -1,28 
1,25 0,8 -0,84 
1,33 0,75 -0,67 
1,43 0,7 -0,52 
1,67 0,6 -0,25 
2 0,5 0 
2,5 0,4 0,25 
3,33 0,3 0,52 
4 0,25 0,67 
5 0,2 0,84 
10 0,1 1,28 
20 0,05 1,64 
50 0,2 2,05 
100 0,01 2,33 
200 0,005 2,58 
500 0,002 2,88 
1000 0,001 3,09 

Sumber : Soewarno, 1995.  
 

 Untuk P = 25% → k = 0,67, Log X1 = 𝑋� + 𝑘. 𝑆 
Log X1 =1,93 mm + (0,67 x 0,08) 
Log X1 = 1,99 mm 

 
 Untuk P = 50% → k = 0 , Log X2 = 𝑋� + 𝑘. 𝑆 

Log X2 = 1,93 mm + (0 x 0,08) 
Log X2 = 1,93 mm 
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 Untuk P = 75% → k = 1,91 , Log X3 = 𝑋� + 𝑘. 𝑆 
Log X3 = 1,93 mm + (-0,67 x 0,08) 
Log X3 = 1,87 mm 
 

Dari perhitungan diatas, batas sub kelompok bisa di 
tabelkan seperti Tabel 4.8 di bawah ini: 

 
Tabel 4.8 Nilai Batas Tiap Kelompok 

Kelompok Nilai Batas 
I =              X ≤ 1,87 
II = 1,87 < X ≤ 1,93 
III = 1,93 < X ≤ 1,99 
IV =               X ≥ 1,99 

 
• Menentukan Ei 

Ei adalah frekuensi (banyak pengamatan) yang 
diharapkan sesuai dengan pembagian kelasnya (Bambang 
Triatmodjo, 2010). Maka, untuk mencari Ei menggunakan rumus 
: 
𝐸𝑖 = 𝑗𝑢𝑚𝑙𝑎ℎ 𝑘𝑒𝑙𝑎𝑠 (𝐺)

𝑗𝑢𝑚𝑙𝑎ℎ 𝑑𝑎𝑡𝑎 (𝑛)
  

𝐸𝑖 =  10
4

= 2,5  
 

• Menentukan Chi-Kuadrat hitung (Xh²) 
Rumus untuk menentukan Chi-Kuadrat adalah : 

𝑋ℎ2 =  �
(𝑂𝑖 − 𝐸𝑖)2

𝐸𝑖

𝐺

𝑖=1
 

 
Contoh perhitungan : 

𝑋ℎ2 =  �
(2 − 0,25)2

2,5

𝐺

𝑖=1
 

𝑋ℎ2 =  0,10 
 

Untuk perhitungan chi-kuadrat hitung bisa dilihat pada 
Tabel 4.9. 
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0,995 0,99 0,975 0,95 0,05 0,025 0,01 0,005
1 0,0000393 0,000157 0,000982 0,00393 3,841 5,024 6,635 7,879
2 0,0100 0,0201 0,0506 0,103 5,991 7,378 9,210 10,597
3 0,0717 0,115 0,216 0,352 7,815 9,348 11,345 12,838
4 0,207 0,297 0,484 0,711 9,488 11,143 13,277 14,860
5 0,412 0,554 0,831 1,145 11,070 12,832 15,086 16,750
6 0,676 0,872 1,237 1,635 12,592 14,449 16,812 18,548
7 0,989 1,239 1,690 2,167 14,067 16,013 18,475 20,278
8 1,344 1,646 2,180 2,733 15,507 17,535 20,090 21,955
9 1,735 2,088 2,700 3,325 16,919 19,023 21,666 23,589

10 2,156 2,558 3,247 3,940 18,307 20,483 23,209 25,188
11 2,603 3,053 3,816 4,575 19,675 21,920 24,725 26,757

dk
α derajat kepercayaan

Tabel 4.9 Perhitungan Chi-Kuadrat hitung 
nilai batas Oi Ei (Oi - Ei)2 Xh² 

             X ≤ 1,87 3 2.5 0.25 0.10 
1,87 < X ≤ 1,93 3 2.5 0.25 0.10 
1,93 < X ≤ 1,99 1 2.5 2.25 0.90 

              X ≥ 1,99 3 2.5 0.25 0.10 
  10 10 nilai chi kuadrat = 1.20 

 
Nilai Chi-Kuadrat hitung = 1,20 
Derajat Kebebasan (DK) = 1 
Derajat signifikan alpha  = 5% 
Nilai Chi Teoritis  = 3,841 

 
Dari perhitungan Chi-Kuadrat untuk distribusi hujan 

dengan metode Log Pearson tipe III, diperoleh nilai Chi-Kuadrat 
hitung 1,20. Dengan derajat kebebasan (DK) 1, dan derajat 
signifikan α 5%, maka diperoleh Chi-Kuadrat teoritis 3,841 
(sesuai pada Tabel 4.10) 

Perhitungan akan diterima apabila nilai Chi-Kuadrat 
teoritis > nilai Chi-Kuadrat hitung. Dari perhitungan diatas 
diperoleh nilai 3,841 > 1,20, sehingga perhitungan diterima. 
 

Tabel 4.10 Nilai Chi Kuadrat Teoritis 
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0,995 0,99 0,975 0,95 0,05 0,025 0,01 0,005
12 3,074 3,571 4,404 5,226 21,026 23,337 26,217 28,300
13 3,565 4,107 5,009 5,892 22,362 24,736 27,688 29,819
14 4,075 4,660 5,629 6,571 23,685 26,119 29,141 31,319
15 4,601 5,229 6,262 7,261 24,996 27,488 30,578 32,801
16 5,142 5,812 6,908 7,962 26,296 28,845 32,000 34,267
17 5,697 6,408 7,564 8,672 27,587 30,191 33,409 35,718
18 6,265 7,015 8,231 9,390 28,869 31,526 34,805 37,156
19 6,844 7,633 8,907 10,117 30,144 32,582 36,191 38,582
20 7,434 8,260 9,591 10,851 31,410 34,170 37,566 39,997
21 8,034 8,897 10,283 11,591 32,671 35,479 38,932 41,401
22 8,643 9,542 10,982 12,338 33,924 36,781 40,289 42,796
23 9,260 10,196 11,689 13,091 36,172 38,076 41,638 44,181
24 9,886 10,856 12,401 13,848 36,415 39,364 42,980 45,558
25 10,520 11,524 13,120 14,611 37,652 40,646 44,314 46,928
26 11,160 12,198 13,844 15,379 38,885 41,923 45,642 48,290
27 11,808 12,879 14,573 16,151 40,113 43,194 46,963 49,645
28 12,461 13,565 15,308 16,928 41,337 44,461 48,278 50,993
29 13,121 14,256 16,047 17,708 42,557 45,722 49,588 52,336
30 13,787 14,953 16,791 18,493 43,773 46,979 50,892 53,672

dk
α derajat kepercayaan

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sumber : Soewarno, 1995 
 

4.6.2 Uji Smirnov Kolmogorov 
Uji kecocokan Smirnov-Kolmogorov, sering juga disebut 

uji kecocokan non parametik (non parametic test), karena 
pengujiannya tidak menggunakan fungsi distribusi tertentu 
(Soewarno,1995). 

Perhitungan uji Smirnov-Kolmogorov bisa dilihat pada 
Tabel 4.11. 
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Tabel 4.11 Perhitungan Smirnov-Kolmogorov untuk Log Pearson Tipe III 
 

Tahun xi Peringkat 
(m) 

P = 
m/(n+1) 

P(x<)       
1-P(x) f(t)=(xi-x)/s p'(x) p'(x<) D 

2010 2.05 1 0.09 0.91 1.39 0.0823 0.9177 0.0086 
2008 2.04 2 0.18 0.82 1.35 0.0885 0.9115 0.0933 
2003 2.02 3 0.27 0.73 1.07 0.1423 0.8577 0.1304 
2007 1.97 4 0.36 0.64 0.49 0.3121 0.6879 0.0515 
2012 1.91 5 0.45 0.55 -0.27 0.6064 0.3936 -0.1519 
2009 1.90 6 0.55 0.45 -0.37 0.6443 0.3557 -0.0988 
2004 1.88 7 0.64 0.36 -0.62 0.7324 0.2676 -0.0960 
2006 1.86 8 0.73 0.27 -0.81 0.7910 0.2090 -0.0637 
2014 1.86 9 0.82 0.18 -0.87 0.8078 0.1922 0.0104 
2005 1.82 10 0.91 0.09 -1.37 0.9147 0.0853 -0.0056 

∑ 19.31 
     

Dmax = 0.1304 
rata-rata (x) 1.93 
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Banyaknya data (n) = 10 
Dmax   = 0,1304 
Derajat kepercayaan = 5% 
Do   = 0,41 

 
Dari perhitungan pada tabel 4.11 diperoleh nilai Dmax = 

0,1258 pada peringkat (m) = 3. Dengan derajat kepercayaan = 5% 
dan banyaknya data = 10, maka diperoleh nilai Do=0,41 (sesuai 
pada Tabel 4.12). Karena nilai Dmax < Do (0,1304<0,41), maka 
persamaan distribusi Log Pearson Tipe III diterima. 

 
Tabel 4.12 Nilai Kritis Do untuk Uji Smirnov-Kolmogorov 

N 
α  (derajat kepercayaan) 

0,2 0,1 0,05 0,01 
5 0,45 0,51 0,56 0,67 

10 0,32 0,37 0,41 0,49 
15 0,27 0,3 0,34 0,4 
20 0,23 0,26 0,29 0,36 
25 0,21 0,24 0,27 0,32 
30 0,19 0,22 0,24 0,29 
35 0,18 0,2 0,23 0,27 
40 0,17 0,19 0,21 0,25 
45 0,16 0,18 0,2 0,24 
50 0,15 0,17 0,19 0,23 

Sumber  : Soewarno, 1995 
 
  Kesimpulan yang didapat dari perhitungan diatas, bahwa 
jenis distribusi yang dapat digunakan untuk perhitungan hujan 
rencana adalah distribusi Log Pearson tipe III. Hal ini 
dikarenakan distribusi tersebut memenuhi dari Uji Chi Square 
maupun Kolmogorov. Jadi curah hujan yang digunakan adalah: 
 Periode ulang 2 th dengan curah hujan = 84,39 mm 
 Periode ulang 5 th dengan curah hujan = 100 mm 
 Periode ulang 10 th dengan curah hujan = 109,87 mm 
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   Kemudian akan dihitung tinggi hujan pada jam ke-t 
(Rt’) sebagai input di HEC HMS. Jam ke-t yang digunakan 
adalah 4 jam, karena lama hujan yang terjadi di Surabaya tidak 
kurang dari 4 jam. Rumus perhitungan Rt’ sebagai berikut: 

𝑅𝑡 =  
𝑅24
𝑡

 𝑥 �
𝑡

𝑡 𝑘𝑒 − 𝑛
�
2/3

 
 
𝑅𝑡′ = 𝑡 .𝑅𝑡 − (𝑡 − 1). (𝑅(𝑡−1)) 
Dimana : 
R24 : Tinggi hujan hasil perhitungan log pearson tipe III (mm) 
Rt : Tinggi hujan pada waktu ke –t (mm) 
Rt’  : Tinggi hujan pada waktu ke-t yang digunakan sebagai   

input pada HMS (mm) 
t : Waktu yang digunakan = 4 jam (karena lama hujan di 

Surabaya paling lama adalah 4 jam) 
Sumber  : Power Point Hidrologi 
 
Contoh perhitungan PUH 10 tahun pada jam ke-2 : 

𝑅10 =  
109,87 𝑚𝑚

4
 𝑥 �

4
2
�
2/3

= 43,60 𝑚𝑚 
 
𝑅2′ = 2𝑗𝑎𝑚 𝑥 43,60 𝑚𝑚 − (2 − 1). (69,21) =  17,99 𝑚𝑚 
 
Hasil perhitungan tinggi hujan pada jam ke-t dapat ditabelkan 
sebagai berikut : 
 

Tabel 4.13 Tinggi Hujan pada Jam ke-t 
Rt PUH Rt' PUH 

2 5 10 2 5 10 
jam mm jam mm 

1 53,16 62.99 69.21 1 53.16 62.99 69.21 
2 26.79 39.68 43.60 2 0.42 16.37 17.99 
3 25.56 30.28 33.27 3 23.09 11.49 12.62 
4 21.10 25.00 27.47 4 7.72 9.14 10.05 
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4.7 Analisa Debit Banjir Rencana 
Setelah diketahui nilai hujan per jam, selanjutnya adalah 

perhitungan analisa debit. Analisa debit dimaksudkan untuk 
menghitung besarnya debit banjir rencana yang terjadi yang 
nantinya akan digunakan untuk perencanaan kapasitas saluran. 

Pada perancanaan ini debit banjir rencana dihitung 
menggunakan metode US-SCS (Soil Conservation Service) 
dengan program bantu HEC-HMS. 

 
4.7.1 Skema Jaringan 

Dalam menggunakan cara SCS pada HEC-HMS, runoff 
dari sebuah daerah aliran (catchment) yang kejatuhan air hujan 
ditentukan berdasarkan ciri-ciri catchment-nya, yang diukur dari 
peta atau penilaian pada saat pengamatan lapangan. Kunci 
parameter dari catchment yang bersangkutan adalah luas, 
panjang dan kemiringan dari tapak aliran, serta tata guna lahan, 
sehingga bisa dibuat skema jaringan. 

Skema jaringan DAS Gunungsari pada HEC-HMS bisa 
dilihat pada gambar 4.5 : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4.5 Skema Jaringan DAS Gunungsari 
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Langkah-langkah untuk membuat skema jaringan 
seperti diatas : 

1. Membuat project baru 
Untuk memulai project baru maka pilih menu File → 
New → Create a New Project atau dapat juga meng-klik  

 
 
  
 
 
 
 
 
 
 
 

 
 

Gambar 4.6 Membuat Project Baru pada HMS 
 

Kemudian isikan Gunungsari pada Name dan HMS 
Gunungsari pada Description seperti yang ditunjukkan 
dalam gambar diatas. Menggunakan isian tersebut, maka 
file project akan tersimpan dalam folder Gunungsari. Atur 
Default Unit Sytem menjadi metric dan klik tombol 
Create untuk membuat project. 
 

2. Atur pilihan project sebelum membuat komponen-
komponen model. Pilih menu Tools → Program 
Settings. Atur Loss menjadi SCS Curve Number, 
Transform menjadi SCS Unit Hydrograph, Baseflow 
menjadi None, Routing menjadi Kinematic Wave, Gain 
Loss menjadi None, Precipitation menjadi Specified 
Hyeterograph, Evaporation menjadi None, dan Snowmelt 
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menjadi None. Klik tombol OK untuk menyimpan dan 
menutup Program Settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 4.7 Pengisian Komponen-Komponen Model pada 

Program Setting 
 

3. Pembuatan Basin Model 
Pembuatan basin model langkahnya adalah pilih menu : 
Component → Basin → Model Manager 
 

 
 
 
 
 
 
 
 
 

       Gambar 4.8 Membuat Basin Model 
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 Klik New pada layar akan muncul Create A New Basin 
Model editor. Isikan nama Basin Model beserta 
deskripsinya seperti gambar berikut. 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4.9 Membuat Nama Basin Model 
 
Setelah pengisian nama basin dan deskripsi maka click 
Create, sehingga akan muncul Basin Model Manager 
beserta nama basin yang telah dimasukkan tadi. Selanjutnya 
tutup editor tersebut dan pada layer akan muncul tampilan 
seperti berikut. 
 
 

 
 
 
 
 
 
 
 
 

Gambar 4.10 Basin Model pada HMS 
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Kemudian untuk menggambarkan skema jaringan,klik dua 
kali pada kotak merah, maka akan muncul tampilan layar 
putih (dekstop) 
 

4. Membuat Skema Jaringan 
Untuk membuat skema jaringan, tampilan pada HEC HMS 
harus seperti pada gambar 4.10 yang sudah muncul tampilan 
dekstop. Kemudian gunakan ikon-ikon yang ada pada 
toolbar. 
 
 

 
 
 

 
Gambar 4.11 Ikon – Ikon dan Fungsinya 

 
Dengan ikon-ikon tersebut, skema jaringan bisa 
dimodelkan seperti berikut. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Gambar 4.12 Skema Jaringan pada HMS 
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Untuk luas, panjang dan kemiringan pada DAS 
Gunungsari dapat diukur dari peta dalam bentuk CAD yang 
didapat dari SDMP Surabaya. 

Panjang rata-rata dari aliran permukaan dan kemiringan 
lahan dapat dihitung dari peta. Panjang aliran permukaan 
untuk catchment simetrik dapat dihitung dengan persamaan: 

𝑃𝑎𝑛𝑗𝑎𝑛𝑔 =  
𝐿𝑢𝑎𝑠

2 𝑥 𝑝𝑎𝑛𝑗𝑎𝑛𝑔 𝑠𝑎𝑙𝑢𝑟𝑎𝑛
 

Contoh perhitungan : 
Panjang saluran catchment ST.10 = 1.049.307 𝑚2

2 𝑥 (632 𝑚+2065 𝑚)
 

     = 194,53 𝑚 
 

Sedangkan untuk daerah aliran satu sisi, panjang aliran 
permukaan dapat dihitung :  

𝑃𝑎𝑛𝑗𝑎𝑛𝑔 =  
𝐿𝑢𝑎𝑠

𝑝𝑎𝑛𝑗𝑎𝑛𝑔 𝑠𝑎𝑙𝑢𝑟𝑎𝑛
 

 
Contoh perhitungan : 
Panjang saluran catchment ST.1 = 45.678 𝑚2

102 𝑚
 

     = 447,82 𝑚 
Sumber : Modul Hidrologi 8 

 Perhitungan luas, panjang dan kemiringan pada DAS 
Gunungsari terlampir pada bab lampiran. 

 
4.7.2 Nilai Tata Guna Lahan 

Parameter tata guna lahan meliputi neraca antara 
komponen-komponen yang kedap dan meresap air serta jenis 
dari komponen yang meresap. Tata guna lahan pada DAS 
Gunungsari seperti pada gambar 4.13: 
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Gambar 4.13 Peta Tata Guna Lahan DAS Gunungsari  

 
Sumber : Surabaya Drainage Master Plan 2000 
 

Penggunaan lahan yang ada telah diiterpretasikan sesuai 
dengan kelompok-kelompok penggunaan lahan dengan 
karakteristik air limpasan yang berbeda, sebagai berikut : 

 
Tabel 4.14 Harga CN yang disesuaikan dengan DAS di Indonesia 

Kelompok Penggunaan Lahan untuk 
Pematusan 

Kedap Air Serap Air 
% CN 

Areal pemukiman (dengan kepadatan 
penduduk):     
50 - 150 orang/ha (kawasan perumahan baru) 85 74 
50 - 150 orang/ha (kawasan perumahan lama) 70 74 
150 - 250 orang/ha 85 79 
250 - 350 orang/ha 90 84 
Lebih dari 350 orang/ha 95 88 
Lahan terbuka:     
Rerumputan (>75%) 0 74 



64 
 

Kelompok Penggunaan Lahan untuk 
Pematusan 

Kedap Air Serap Air 
% CN 

Campuran (wilayah rerumputan 25-75%) 0 79 
Lain-lain:     
Industri, bisnis dan perdagangan 95 88 
Fasilitas umum/kampus 70 79 
Jalan utama, areal parkir mobil dsb. 100   

Sumber  : Surabaya Drainage Master Plan Report 
 

Pada DAS Gunungsari tata guna lahan yang digunakan 
adalah: 

• Pemukiman (150 – 250 orang/ha)  :nilai Kedap air 
(Impervious) = 85, CN = 79 

• Industri, bisnis dan perdagangan : nilai IM = 95, CN = 88 
• Fasilitas Umum/kampus  : nilai IM = 70, CN = 79 
• Jalan utama,areal parkir mobil  : nilai IM = 100, CN = 0 
• Pergudangan    : nilai IM = 95, CN = 88 
• Lahan terbuka rerumputan (>75%) : nilai IM = 0, CN = 74 

 
Untuk perhitungan nilai IM dan CN tiap catchment 

dihitung  menggunakan prosentase dengan nilai-nilai tata guna 
lahan DAS Gunungsari. 
Contoh perhitungan : 
Pada catchment ST.1 dari peta tata guna lahan didapatkan 
prosentase: 
• Pemukiman  : 78% 
• Industri  : 4 % 
• Fasilitas umum : 4% 
• Lahan terbuka  : 4% 
• Jalan   : 10% 
• Pergudangan  : 0%  
Nilai impervious (IM) catchment ST.1 = 

= (78% 𝑥 85%) + (4% 𝑥 95%) + (4% 𝑥 70%) + (4% 𝑥 0) + (10% 𝑥 100%) + (0% 𝑥 95%)   
= 82,9 
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Nilai Curve Number (CN) catchment ST.1 = 
  = (78% 𝑥 79%) + (4% 𝑥 88%) + (4% 𝑥 79%) + (4% 𝑥 74%) + (10% 𝑥 0%) + (0% 𝑥 99%)  
  = 71,2 

  Perhitungan nilai IM dan CN tiap catchment akan 
disajikan dalam lampiran. 

 
4.7.3 Perhitungan Time Lag (𝒕𝑳) 

Time Lag adalah waktu antara datangnya hujan dengan 
waktu terjadinya debit puncak.Time Lag merupakan salah satu 
faktor yang harus di input di program HEC-HMS untuk running 
debit banjir rencana. Waktu 𝑡𝐿 dapat dihitung dengan : 

𝑡𝐿 =
𝐿0,8 𝑥 (𝑆 + 1)0,7

1900 𝑥 𝑌0,5  
Dimana : 
L = panjang over land flow (ft) / panjang saluran 
S = retensi maksimum (inchi) 
 S = 1000/CN -10 
Y = kemiringan rata-rata lahan (%) 
CN = Curve Number, yang berisi pengaruh dari tanah, tata 
guna lahan, kondisi hidrologi dan soil moisture 
Sumber : Modul Hidrologi 8 
Contoh perhitungan pada catchment ST.1 : 
L = 1469,22 ft 
Y = 0,4% 
CN = 71,26 
S = 1000/71,26 – 10 
 = 4,03 

𝑡𝐿               =
𝐿0,8 𝑥 (𝑆 + 1)0,7

1900 𝑥 𝑌0,5  
  

𝑡𝐿               =
1469,220,8 𝑥 (4,03 + 1)0,7

1900 𝑥 0,40,5  

𝑡𝐿               = 0,844 𝑗𝑎𝑚 = 50,69 𝑚𝑒𝑛𝑖𝑡 
 
Perhitungan 𝑡𝐿 tiap catchment akan dilampirkan. 
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4.7.4 Pengisian Parameter pada HEC HMS 
Beberapa parameter harus dimasukkan dalam HEC 

HMS untuk mendapatkan data debit. Parameter yang 
dimasukkan antara lain: 
1. Luas Catchment Area 

Luas catchment area tersier, sekunder, dan primer 
didapatkan dari perhitungan autocad yang diperoleh dari 
SDMP Surabaya. Untuk memasukkan data perhitungan 
kedalam HEC HMS yaitu pilih menu Parameter → 
Subbasin area. Pengisian dapat dilihat seperti pada 
gambar berikut. 

 
 
 
 
 
 
 
 
 
 

Gambar 4.14 Cara Mengisi Data Subbasin Area 
 

Isikan luas dalam satuan km pada tabel seperti gambar 4.15 
dan sesuaikan dengan nama catchment yang tertera pada 
subbasin. Kemudian klik apply→close. Dengan begitu luas 
tiap catchment sudah terisi. 
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Gambar 4.15 Pengisian Data Subbasin Area 
 
2. Nilai Impervious, Curve Number, dan Initial Abstraction 

Nilai-nilai tersebut didapatkan dari perhitungan tata guna 
lahan. Impervious adalah nilai kedap air, Curve Number 
adalah nilai serap air. Sedangkan Initial Abstraction adalah 
nilai limpasan awal yang dapat diperkirakan dari efek 
tangkapan oleh pepohonan dan genangan pada daerah-daerah 
rendah. Menurut SDMP Surabaya nilai Initial Abstraction 
disarankan bernilai 2 mm.  
Untuk pengisian pada HEC HMS klik 
Parameter→Loss→SCS Curve Number seperti pada gambar 
berikut. 
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Gambar 4.16 Pengisian Data IM,CN, dan Initial Abstraction 

 
Isikan nilai Impervious, Curve Number, dan Initial 
Abstraction tabel seperti gambar 4.16 dan sesuaikan 
dengan nama catchment yang tertera pada subbasin. 
Kemudian klik apply→close.  
 

3. Lag Time (𝑡𝐿) 
Time Lag adalah waktu antara datangnya hujan dengan 
waktu terjadinya debit puncak. Untuk memasukkan data 
perhitungan kedalam HEC HMS yaitu pilih menu 
Parameter →Transform→SCS Unit Hydrograph.  
 

 
 
 
 
 
 
 
 
 

Gambar 4.17 Cara Mengisi Data pada Transform 



69 
 

 
 

Isikan nilai Lag Time dalam satuan menit pada tabel 
seperti gambar 4.18, untuk Graph Type pilih standard 
dan sesuaikan dengan nama catchment yang tertera pada 
subbasin. Kemudian klik apply→close.  

 
 
 

 

 

 

 

 

 

 

Gambar 4.18 Pengisian Data Lag Time 
 

4. Kinematic Wave 
Pada kinematic wave terdapat beberapa parameter 
yang harus diisikan antara lain: 
• Length : panjang saluran pada tiap catchment 
• Slope :kemiringan lahan, dipakai 0,001 

karena saluran daerah DAS Gunungsari relatif 
landai 

• Manning’s n :koefisien kekasaran, dipakai 0,04 
karena saluran dari beton 

• Subreaches : jarak dan waktu routing = 2 
• Shape :diisi dengan bentuk penampang 

saluran 
• Width : lebar saluran, untuk tersier 2 m, 

sekunder 5 m, primer 7 m 
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Pengisian pada HEC HMS yaitu pilih menu 
Parameter →Routing→Kinematic Wave. 
 

 

 

 

 

  

Gambar 4.19 Cara Mengisi Data pada Routing 
 

Kemudian isikan nilai setiap parameter pada kinematic 
wave seperti pada gambar 4.20 dan sesuaikan dengan 
nama catchment yang tertera pada subbasin. Kemudian 
klik apply→close.  

 

 

 

 

 

 

 

 

 
Gambar 4.20 Pengisian Data pada Kinematic Wave 
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4.7.5 Membuat HMS Component Models 

HMS model components terdiri dari basin model, 
meteorologic model, control spesifications, dan time 
series data. Pembuatan basin model sudah 
dijelaskan pada sub bab 4.7.1. 
 

4.7.5.1 Pembuatan Meteorologic Model (Model   Data 
Curah Hujan)  

  Meteorologic model dapat dibuat dengan prosedur 
yang sama seperti pembuatan basin model yaitu 
dengan cara pilih menu Component → 
Meteorologic Model Manager. 

 
 

 

 

 

  
 

Gambar 4.21 Membuat Meteorologic Model 
 

Klik New pada layar akan muncul Create A New 
Meteorologic Model  editor. Isikan nama 
Meteorologic Model beserta deskripsinya seperti 
gambar berikut. 

 

 
           Gambar 4.22 Pengisian nama pada Meteorologic Model 
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Setelah pengisian nama dan deskripsi maka klik 
Create, sehingga akan muncul Meteorologic Model 
Manager beserta nama yang telah dimasukkan tadi. 
Selanjutnya tutup editor tersebut dan pada layar 
akan muncul tampilan seperti berikut. 
 

 

 

 

 

 
 

Gambar 4.23 Tampilan pada Meteorologic Model 
 

4.7.5.2  Pembuatan Control Specifications 
Control Spesifications memuat input waktu kapan 
dimulai dan berakhirnya eksekusi (running) dari 
program serta interval waktu yang diinginkan (15 
menit, 1 jam, atau 1 hari). Pada studi ini interval 
waktu yang dipakai adalah 1 jam.  

  Prosedur yang digunakan yaitu dengan cara pilih 
menu Component → Control Specifications 
Manager. 

 
 

 

 

 
 

Gambar 4.24 Membuat Control Spesifications 
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Klik New pada layar akan muncul Create A New 
Control Spesifications editor. Isikan nama beserta 
deskripsinya seperti gambar berikut. 

 
 

 

 

 

  

      Gambar 4.25 Pengisian Nama pada Control Spesifications 

Setelah pengisian nama dan deskripsi maka klik 
Create, sehingga akan muncul Control 
Spesifications beserta nama yang telah dimasukkan 
tadi. Selanjutnya tutup editor tersebut dan pada 
layar akan muncul tampilan seperti berikut. 

 

 

 

 

 

 

                 Gambar 4.26 Tampilan pada Control Spesifications 
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4.7.5.3  Pembuatan Time-Series Data  
Melalui Time-Series Data Manager beberapa tipe 
data yang akan digunakan dalam aplikasi model 
HEC-HMS dapat dibuat. Diantaranya adalah data 
hujan dan data debit. 
Prosedur yang digunakan yaitu dengan cara pilih 
menu Component → Time-Series Data 
Manager. 

 

 

 

 

 
                Gambar 4.27 Membuat Time-Series Data 

 
Klik New pada layar akan muncul Create A New 
Precipitation Gage editor. Isikan nama beserta 
deskripsinya seperti gambar berikut. 

 

 

  

 

  

Gambar 4.28 Pengisian Nama pada Time-Series Data 
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Setelah pengisian nama dan deskripsi maka klik 
Create, sehingga akan muncul Time-Series Data 
beserta nama yang telah dimasukkan tadi. 
Selanjutnya tutup editor tersebut dan pada layar 
akan muncul tampilan seperti berikut. 

 

 

 

 

 

  

             Gambar 4.29 Tampilan pada Time-Series Data 

4.7.6 Pengisian Data Pada HMS Component Models 
 Setelah membuat beberapa component models antara 

lain meteorologic model, Control Spesifications, dan Time-
Series Data. Setiap component models tersebut ada beberapa 
data yang harus diisi sebelum dilakukan simulasi (running). 

 
4.7.6.1 Pengisian Data Pada Time-Series Data 

Prosedur dalam pengisian data yaitu klik Time Series 
Data → Precipitation Gages → 10thn (nama dari 
gage yang dibuat). Klik 10thn sampai dia berwarna 
biru. Akan muncul editor Time Series Gage di 
bawahnya.  
Isikan Data Source dan Units seperti pada gambar 
4.28. Untuk Time Interval diisikan 1 hour,karena pada 
studi ini direncanakan menggunakan time interval 1 
jam. 
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       Gambar 4.30 Pengisian Data pada Time-Series Gage 

Setelah itu klik tulisan 01 Jan 2000 yang tertera di 
bawah 10thn. Maka aka muncul editor Time Window, 
isikan data seperti pada gambar 4.29 . Waktu yang 
digunakan pada studi ini adalah 1 hari, dari tanggal 01 
Januari 2000 pukul 00:00 sampai dengan tanggal 02 
Januari 2000 pukul 00.00. 
 
 
 
 
 
 
 
 
 
 
 
 

       Gambar 4.31 Pengisian Data pada Time Window 
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Kemudian klik Table pada kotak editor yang sama. 
Isikan data hujan PUH yang sudah dihitung pada 
pembahasan sub bab 4.6.2. Pada studi ini PUH yng 
digunakan adalah PUH 10 tahun karena objek yang 
ditinjau adalah saluran primer Gunungsari. Isikan data 
PUH 4 jam di kotak editor Table pada 4 jam pertama, 
untuk jam berikutnya isikan dengan angka 0.   

  

 

 
 
 
 
 
 
 
 
 
 
 

  

 Gambar 4.32 Pengisian Data pada Table 

4.7.6.2 Pengisian Data Pada Control Spesification 
Untuk mengisi data yaitu klik Control Spesification → 
Control 1 . Kemudian akan ada kotak editor 
dibawahnya. Isikan data kotak editor tersebut seperti 
pada time-series data seperti pada gambar berikut. 
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         Gambar 4.33 Pengisian Data pada Control Spesification 
 

4.7.6.3 Pengisian Data Pada Meteorologic Models 
Untuk mengisi data yaitu klik Meteorologic models → 
Met 1 → Specified Hyterograph. Kemudian akan 
muncul kotak editor seperti pada gambar 4.32. Pada 
kotak gage isikan dengan 10thn pada setiap subbasin. 
Ini dimaksudkan bahwa data hujan yang digunakan 
setiap subbasin adalah data hujan periode ulang 10 
tahun yang sudah diisikan pada time-series data. 
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       Gambar 4.34 Pengisian Data pada Meteorologic models 
 

4.7.7 Simulasi HMS 
Setelah semua parameter dan data terisi, maka HMS 
bisa di simulasi (running) untuk mendapatkan data debit 
pada saluran tersier, sekunder, dan primer. Untuk 
simulasi, klik Compute → Create Compute → 
Simulation Run, Seperti pada gambar berikut. 

 

 

 

 

 

 

Gambar 4.35 Langkah-langkah Simulasi HMS 
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Akan muncul Create a Simulation Run, isikan nama 
untuk simulasi HMS kemudian klik next hingga finish. 

 

 

 

 

 
Gambar 4.36 Langkah-Langkah Simulasi HMS 

 
 

Setalah itu klik RUN HMS (nama yang telah dibuat 
untuk simulasi tadi), kemudian klik simbol   . Maka 
HMS akan melakukan simulasi. Jika sudah 100% maka 
klik close. 

 

 

 

 

Gambar 4.37 Langkah-Langkah Simulasi HMS 
 

Untuk mengetahui hasil simulasi HMS yaitu dengan 
cara klik result→ simulation run → RUN HMS. Akan 
ditampilkan global summary yang isinya berupa data 
debit, data volume, dan luas daerah drainase tiap 
catchment. Data tersebut yang nantinya akan digunakan 
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untuk simulasi HEC-RAS. Hasil simulasi seperti pada 
gambar 4.38. Dan untuk hasil simulasi tiap catchment 
akan dilampirkan. 

 

 

 

 

 

 

 

  

 Gambar 4.38 Hasil Simulasi HMS 
 

4.8 Kontrol Debit dengan Hidrograf 
Hasil simulasi pada HMS memberikan hasil berupa 

inflow dan outflow pada tiap catchment area. Untuk 
mengetahui permodelan dengan HMS benar apa tidak, maka 
perlu di kontrol debit dengan hidrograf, kemudian dari data 
debit tersebut diolah menjadi volume dan curah hujan effektif. 
Jika hasil curah hujan effektif sama atau hampir mendekati 
dengan penjumlahan curah hujan pada PUH selama 4 jam, maka 
permodelan HMS benar. 

Cara untuk kontrol hidrograf ini adalah, klik result , 
kemudian cari saluran yang akan di kontrol debitnya, misal 
kontrol debit pada Junction SP. 38 A. Junction SP.38 A ini 
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adalah debit yang akan masuk ke saluran primer Margomulyo. 
Kemudian klik Graph, maka aka muncul grafik hidrograf dari 
junction sp. 38 A. Seperti pada gambar berikut. 

 

 

 

 

 

 

 

 
  Gambar 4.39 Grafik Hidrograf Junction SP.38A 
 

 Dari grafik tersebut, bisa kita hitung volume tiap jam 
dengan cara mencari luasan dari debit pada tiap jam. Untuk 
perhitungan luasnya disesuaikan dengan bentuk grafik tersebut. 
Pada jam ke 00:00 sampa pada jam ke 01:00 bentuk grafik 
adalah segitiga. Maka luasan dihitung menggunakan rumus 
segitiga, dengan jam sebagai alas, dan debit sebagai tinggi. 
Untuk jam ke 01:00 sampai dengan jam ke 02:00 bentuk grafik 
adalah trapesium, maka luasan dihitung menggunakan 
trapesium. Begitu seterusnya sampai jam ke 24:00, karena 
pemodelan pada simulasi adalah 24 jam. 

 Untuk mengetahui debit pada tiap jam dari grafik 
hidrograf tersebut klik Time Series Table. Sehingga muncul 
debit pada junction sp.38A seperti pada gambar berikut. 
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Gambar 4.40 Waktu dan Debit pada Junction SP.38A 
 
Perhitungan kontrol debit seperti di bawah ini : 

Tabel 4.15 Tabel Perhitungan Volume Hidrograf 

jam 
debit 

(m3/dt) Vol (m3) 
0:00 0 0 
1:00 76,101 136981,8 
2:00 97,451 312393,6 
3:00 76,580 313255,8 
4:00 55,593 237911,4 
5:00 34,732 162585,0 
6:00 19,356 97358,4 
7:00 10,409 53577,0 
8:00 5,698 28992,6 
9:00 3,252 16110,0 

10:00 1,944 9352,8 
11:00 1,215 5686,2 
12:00 0,791 3610,8 



84 
 

jam 
debit 

(m3/dt) Vol (m3) 
13:00 0,533 2383,2 
14:00 0,371 1627,2 
15:00 0,265 1144,8 
16:00 0,194 826,2 
17:00 0,145 610,2 
18:00 0,110 459,0 
19:00 0,085 351,0 
20:00 0,067 273,6 
21:00 0,053 216,0 
22:00 0,042 171,0 
23:00 0,034 136,8 
0:00 0,028 111,6 

Total volume 1386126 m3 
R eff 109.41 mm 

 
Contoh perhitungan pada jam ke-00:00 sampai jam ke 01:00 : 
Bentuk grafik adalah segitiga, dengan alas 1 jam dan debit 
76,101 m3/dt. Maka volume pada jam ke 01:00 adalah : 

𝑣𝑜𝑙𝑢𝑚𝑒 = 0,5 𝑥 3600 𝑑𝑡 𝑥 76,101
𝑚3

𝑑𝑡
= 136.981, 8 𝑚3 

Diketahui: 
Total volume = 1.386.126 m3 

luas catchment area junction sp. 38 A adalah = 12.668.620,07 
m2 
maka, curah hujan effektif (R eff) =  
𝑅 𝑒𝑓𝑓 = (1.386.126 𝑚3: 12.668.620,07 𝑚2 𝑥 1000 
𝑅 𝑒𝑓𝑓 = 109, 41 𝑚𝑚 
Didapatkan hasil R eff adalah 109,41 mm . Kemudian di 
bandingkan dengan penjumlahan PUH selama 4 jam periode 
ulang 10 tahun. Pada perhitungan PUH pada tabel 4.13 
didapatkan data hujan sebagai berikut : 
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Tabel 4.16 Tabel PUH Periode Ulang 10 Tahun 

 

 

 

 

Hasil penjumlahan PUH periode ulang 10 tahun adalah 109,87 
mm, sedangkan hasil perhitungan R effektif pada hidrograf 
adalah 109,41 mm. Nilai curah hujan tersebut mendekati, 
maka permodelan HEC HMS benar, dan data debit hasil 
simulasi bisa digunakan sebagai input pada HEC RAS. 

 

 

 

 

 

 

 

 

 

 

jam R (mm) 
1 69.21 
2 17.99 
3 12.62 
4 10.05 

Total 109.87 
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“Halaman ini sengaja dikosongkan” 
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BAB V 

ANALISA HIDROLIKA 
 

5.1 Tinjauan Umum 
Analisa hidrolika bertujuan untuk mengetahui 

kemampuan penampang dalam menampung debit rencana. Dalam 
studi ini perhitungan kapasitas saluran drainase menggunakan 
pemodelan HEC-RAS 4.0. Dengan analisa ini dapat diketahui 
elevasi muka air pada penampang saat suatu debit air melalui 
saluran drainase tersebut. 

Data-data yang diperlukan dalam analisa penampang 
sungai dengan bantuan software HEC-RAS adalah: 
1. Penampang memanjang sungai 
2. Potongan melintang sungai 
3. Data debit yang melalui sungai 
4. Angka manning penampang sungai 

Analisa hidrolika ini terdiri dari analisa penampang 
eksisting sungai dan analisa penampang rencana. 
 

5.2 Analisa Penampang Eksisting  
Analisa penampang eksisting dengan menggunakan 

HEC-RAS bertujuan untuk mengetahui kondisi dari saluran 
primer Margomulyo, Kali Balong, Kali Kandangan, dan Kali 
Sememi saat ini (eksisting). Dengan mengunakan modul aliran 
steady flow data maka dapat diketahui profil dari muka air saat 
terjadi banjir. 

Untuk membuat model aliran eksisting, input data yang 
digunakan untuk analisa ini adalah : 
1. Data Geometri 

a. Skema alur saluran primer Margomulyo, Kali 
Balong, Kali Kandangan, dan Kali Sememi. 
Skema eksisting 4 saluran primer dimulai dari hulu 
(saluran primer Gunungsari) dan hilirnya yang 
bermuara ke Selat Madura. 

b. Data penampang memanjang dan melintang sungai 
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2. Data debit yang masuk ke setiap saluran. 

Data debit ini dari pemodelan menggunakan HEC-HMS 
3. Data Hidrolika 

Yaitu koefisien manning (n) merupakan parameter yang 
menunjukkan kekasaran dasar saluran dan tanggul kanan 
kiri. 

 Pada analisa penampang eksisting dengan menggunakan 
simulasi aliran tetap (steady flow simulation) hanya 
menggunakan satu data debit sebagai input yaitu debit banjir 
rencana maksimal. 
 Berikut ini adalah langkah-langkah yang harus dilakukan 
untuk analisa penampang eksisting: 
1. Membuat project baru 

Buka software HEC-RAS, klik  File →New Project 
 
 
 

 
 
 

Gambar 5.1 Tampilan HEC-RAS 
Masukkan nama project, kemudian pilih lokasi 

penyimpanan file pemodelan HEC-RAS tersebut. 
 
 
 
 
 
 

 
 
 
           Gambar 5.2 Tampilan Input New Project 
 

2. Pilih Options → Unit System pilih sistem Intenasional untuk 
membuat data dalam satuan SI, kemudian klik OK. 
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         Gambar 5.3 Tampilan Unit System 

 
3. Membuat sket saluran yang ditinjau 

Untuk membuat sket saluran yang ditinjau, pilih Edit → 
Geometric Data. Maka akan muncul seperti gambar 
dibawah ini: 
 

 

 

 

 

 

 

 
Gambar 5.4 Tampilan Geometric Data 

 
Klik ikon pada kotak berwarna merah pada gambar 5.4. 

Kemudian akan muncul kotak pada gambar 5.5. Klik 
Display Currently Selected Picture in Schematic → Add 
kemudian pilih gambar peta saluran yang ditinjau → OK → 
gambar yang akan ditinjau → Close. 
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Gambar 5.5 Tampilan Background Picture on Schematic 

 
Setelah muncul background pada layar Geometric Data, 

bisa digambar sket saluran yang ditinjau dengan 
menggunakan menu River Reach.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 5.6 Tampilan Background Picture 

Setelah menggambar sket saluran yang ditinjau, 
background bisa dihilangkan dengan cara hilangkan tanda 
centang pada kotak editor Background Picture on 
Schematic.  
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Gambar 5.7 Tampilan Hasil Sket Kali Balong dan Saluran 

Primer Margomulyo 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
Gambar 5.8 Tampilan Hasil Sket Kali Kandangan 
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Gambar 5.9 Tampilan Hasil Sket Kali Sememi 
4. Input data cross section saluran 

Untuk memasukkan data cross section tiap saluran, klik 
cross section pada geometric data 
 

 

 

 

 

 

 

 

 
Gambar 5.10 Tampilan Edit Cross Section 
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Pilih Cross Section→Options→Add new cross section. 
Masukkan data untuk masing-masing cross section yang 
meliputi: 

a. River Sta : Nama potongan melintang, diisi dengan angka 
yang berurutan. 

b. Station :Jarak kumulatif antara titik elevasi potongan dari 
titik paling pinggir yang bernilai 0. 

c. Elevation : Elevasi titik pada station. 
d. Downstream reach length  : Jarak tiap potongan 

melintang sungai dengan potongan melintang sebelumnya. 
e. Manning’s value   : Nilai angka manning 

saluran. 
f. Main Channel Bank Station : Station titik saluran 

utama sungai. 
g. Cont/Exp Coeficients  : Koefisien kontraksi 

dan ekspansi (otomatis akan mengisi sendiri).   
Dalam tugas akhir ini, untuk penomoran River Sta angka 

1 dimulai dari hilir, dan angka terbesar menunjukkan daerah 
hulu. Setelah semua data diisi, klik apply data. Kemudian 
akan muncul bentuk penampang sesuai dengan data cross 
section yang dimasukkan.  

 
 

 

 

 

 

 
Gambar 5.11 Tampilan Cross Section Data 
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5. Menyimpan data cross section saluran 

Jika semua penampang cross section sudah dibuat, Klik 
Exit. Kemudian akan kembali ke layar editor Geometric 
Data seperti pada gambar 5.4. Kemudian klik File→Save 
Geometry Data. Isikan nama pada Title. Pilih tempat 
menyimpan file, kemudian klik OK. 

 
 

 

 

 

Gambar 5.12 Tampilan Penyimpanan Cross Section 

6. Input data debit (Steady Flow Data) 
Data debit diperoleh dari pemodelan HEC-HMS. Debit 

yang dimasukkan pada HEC-RAS adalah debit maksimal 
yang masuk ke tiap saluran primer dan lateral inflow yang 
terdapat pada saluran primer tersebut. 

Untuk memasukkan data debit pilih menu Edit→Steady 
Flow Data.  

 

 

 

 

Gambar 5.13 Memilih Steady Flow Data 
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Isikan data debit pada kotak PF. Untuk memasukkan 
lateral inflow perlu menambah kolom debit lagi, maka 
caranya pilih River Sta tempat lateral inflow masuk, 
kemudian klik Add Flow Change Location. 

 

 

 

 

 

 

Gambar 5.14 Debit yang Masuk pada Kali Balong dan Saluran 
Primer Margomulyo 

Kemudian pilih Reach Boundary Condition →Known 
WS  pada downstream, untuk mengisikan boundary hilir 
pada tiap saluran. Karena muara sungai merupakan Selat 
Madura maka akan terpengaruh pasang surut air laut. Pada 
Kali Balong, Kali Kandangan, dan Kali Sememi nilai 
pasangnya pada elevasi 0 menurut SDMP Surabaya. 
 
 
 
 
 
 
 
 

Gambar 5.15 Tampilan Reach Boundary Condition 
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Gambar 5.16 Tampilan Known WS 

Berikut debit yang diisikan pada saluran primer 
Kandangan dan saluran primer Sememi. 

 

 

 

 

 

 

 

Gambar 5.17 Debit yang Masuk pada Kali Kandangan 
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Gambar 5.18 Debit yang Masuk pada Kali Sememi 

7. Run program Eksisting 
Setelah semua data selesai dimasukkan, pilih 
Run→Steady Flow Analysis. 
 
 
 
 

 

 

Gambar 5.19 Memilih Run Steady Flow Analysis 

 

 

 

 

Gambar 5.20 Tampilan Run Steady Flow Analysis 
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 Pada gambar 5.20 pilih Compute, dan program akan 
menghitung data yang sudah kita input. Output yang 
dihasilkan yaitu profil muka air, kecepatan aliran, dan 
kapasitas tampungan sungai,sehingga kita dapat mengetahui 
daerah-daerah yang mengalami banjir.  

8. Output data 
a. Profil penampang memanjang 
 

 

 

 

 

 

Gambar 5.21 Hasil Running Penampang Memanjang Kali 
Balong 

 

 

 

 

 

Gambar 5.22 Hasil Running Penampang Memanjang Saluran 
Primer Margomulyo 
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Gambar 5.23 Hasil Running Penampang Memanjang Kali 
Kandangan 

 

 

 

 

 

 

 

Gambar 5.24 Hasil Running Penampang Memanjang Kali 
Sememi 
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b. Profil penampang melintang (cross section) 

Untuk profil melintang tiap cross section akan dilampirkan. 
 

 

 

 

 

 

 

   Gambar 5.25 Profil Penampang Melintang Kali Balong RS 32 

 

 

 

 

 

 

 

   Gambar 5.26 Profil Penampang Melintang Saluran Primer 
Margomulyo RS 18 
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   Gambar 5.27  Profil Penampang Melintang Kali Kandangan 
RS 36 

 

 

 

 

 

 

 

Gambar 5.28  Profil Penampang Melintang Kali Sememi RS 53 

Setelah dilakukan running program HEC-RAS ternyata 
penampang eksisting sungai tidak dapat menampung debit banjir 
yang ada, maka direncanakan normalisasi sungai. Normalisasi 
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sungai dilakukan untuk mengatasi banjir di saluran primer 
Margomulyo, Kali Balong, Kali Kandangan, dan Kali Sememi 
yaitu dengan cara memperbesar atau mendesain ulang 
penampang. 

5.3 Analisa Penampang Rencana 
Normalisasi pada saluran primer Margomulyo, Kali 

Balong. Kali Kandangan, dan Kali Sememi didasarkan pada hasil 
analisa kondisi eksisting sungai dengan program HEC RAS 
dimana ada beberapa titik penampang yang tidak mampu 
menampung debit rencana Q10 yang mengalir. 

Normalisasi pada saluran primer Margomulyo 
direncanakan dengan penampang persegi dan tepi saluran terbuat 
dari pasangan batu kosong seperti kondisi eksisting yang ada. 
Sedangkan untuk Kali Balong, Kali Kandangan, dan Kali 
Sememi merupakan saluran alam, sehingga untuk normalisasi ini 
bentuk penampang akan di buat trapesium dan juga persegi sesuai 
dengan lahan yang tersedia di lapangan. Langkah-langkah untuk 
normalisasi yaitu: 

5.3.1 Perencanaan kemiringan dasar saluran (I rencana) 
Dari hasil profil memanjang simulasi HEC-RAS pada 

pembahasan sebelumnya bisa dilihat I eksisting sangat tidak 
beraturan. Kemiringan dasar saluran yang tidak beraturan 
tersebut bisa saja diakibatkan sedimentasi yang mengendap di 
dasar saluran. Pada kenyataannya kemiringan dasar saluran 
sangat berpengaruh pada kecepatan dan debit yang mengalir, oleh 
karena itu salah satu upaya normalisasi penampang adalah 
dengan memperbaiki kemiringan dasar saluran. 

Memperbaiki kemiringan dasar saluran ini adalah dengan 
cara mencari rata-rata dari kemiringan eksisting, kemudian 
digunakan sebagai patokan membuat elevasi dasar saluran baru 
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dengan mengeruk atau menimbun dasar saluran. Sehingga dari 
elevasi baru tersebut bisa didapatkan kemiringan rencana. 

Rumus perhitungan kemiringan sebagai berikut: 

𝐼 =  
𝑡1 − 𝑡2

𝐿
  

Dimana : 
I = kemiringan dasar saluran 
t1 = elevasi di titik awal/bagian tinggi (m) 
t2 = elevasi di bagian akhir/bagian rendah (m) 
L = panjang saluran dari titik awal ke akhir (m) 
Contoh perhitungan kemiringan di saluran primer Margomulyo: 
Diketahui data elevasi rencana river sta 1 = -2,65 , elevasi 
rencana river sta 2 = -2,70. Jarak antar river sta = 200 m, maka 
kemiringan rencana adalah: 

𝐼 𝑟𝑒𝑛𝑐𝑎𝑛𝑎 =  
−2,65− (−2,70)

200
  

 
𝐼 𝑟𝑒𝑛𝑐𝑎𝑛𝑎 =  0,0003  
Data elevasi rencana akan disajikan dalam tabel sebagai berikut: 
a) Saluran primer Margomulyo direncanakan dengan 

kemiringan 0,0003  
Tabel 5.1 Data Elevasi Saluran Primer Margomulyo 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

1 0 -2.171 -2.30 
2 200 -2.040 -2.25 
3 400 -1.803 -2.20 
4 600 -1.829 -2.15 
5 800 -1.657 -2.10 
6 1000 -2.152 -2.05 
7 1200 -1.888 -2.00 
8 1400 -1.806 -1.95 
9 1600 -2.101 -1.90 

10 1800 -1.758 -1.85 
11 2000 -1.601 -1.80 
12 2200 -1.272 -1.75 
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Dari tabel tersebut, bisa dibuat grafik dari hulu ke hilir untuk 
mengetahui penurunan elevasi dan kemiringan rencana. 

 

 

 

 

 

 

 Grafik 5.1 Kemiringan Rencana Saluran Primer Margomulyo 

b) Kali Balong direncanakan dengan kemiringan 0,0007 
Tabel 5.2 Data Elevasi Kali Balong 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

1 0 -3.119 -3.65 
2 140 -3.090 -3.64 
3 280 -3.100 -3.63 
4 420 -3.180 -3.62 
5 560 -3.690 -3.61 
6 700 -3.372 -3.60 
7 840 -2.539 -3.40 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

13 2400 -1.410 -1.70 
14 2600 -1.252 -1.65 
15 2800 -0.647 -1.60 
16 3000 -0.316 -1.55 
17 3200 -0.343 -1.50 
18 3400 0.090 -1.45 
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Dari tabel tersebut, bisa dibuat grafik dari hulu ke hilir untuk 
mengetahui penurunan elevasi dan kemiringan rencana. 

 

 

 

 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

8 980 -2.940 -3.20 
9 1120 -2.733 -3.20 

10 1260 -2.934 -3.10 
11 1400 -2.600 -3.10 
12 1540 -2.250 -3.00 
13 1680 -2.652 -3.00 
14 1820 -1.760 -2.90 
15 1960 -2.460 -2.90 
16 2100 -1.809 -2.80 
17 2240 -1.736 -2.80 
18 2380 -1.810 -2.70 
19 2520 -1.463 -2.70 
20 2660 -1.195 -2.60 
21 2800 -1.602 -2.60 
22 2940 -0.348 -2.50 
23 3080 -1.955 -2.50 
24 3220 -0.890 -2.40 
25 3360 -1.127 -2.40 
26 3500 -1.265 -2.30 
27 3640 -1.200 -2.30 
28 3780 -1.144 -2.30 
29 3920 -0.870 -2.30 
30 4060 -0.644 -2.20 
31 4200 -0.826 -2.10 
32 4340 -1.099 -2.00 
33 4480 -0.973 -1.90 
34 4620 -0.830 -1.80 
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c) Kali Kandangan direncanakan dengan kemiringan 0,0003 
Tabel 5.3 Data Elevasi Kali Kandangan 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

1 0 -1.717 -2.30 
2 100 -2.336 -2.28 
3 200 -0.875 -2.25 
4 300 -1.566 -2.23 
5 400 -2.135 -2.20 
6 500 -1.308 -2.18 
7 600 -1.460 -2.15 
8 700 -1.637 -2.13 
9 800 -0.919 -2.10 
10 900 -0.970 -2.08 
11 1000 -0.936 -2.05 
12 1100 -1.096 -2.03 
13 1200 -1.030 -2.00 
14 1300 -1.202 -1.98 
15 1400 -0.960 -1.95 
16 1500 -1.414 -1.93 
17 1600 -1.046 -1.90 
18 1700 -0.837 -1.88 
19 1800 -0.850 -1.85 
20 1900 -1.172 -1.83 
21 2000 -1.668 -1.80 

Grafik 5.2 Kemiringan Rencana Kali Balong 
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Dari tabel tersebut, bisa dibuat grafik dari hulu ke hilir untuk 
mengetahui penurunan elevasi dan kemiringan rencana. 

 

 

 

 

 

 

 

Grafik 5.3 Kemiringan Rencana Kali Kandangan 

 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

22 2100 -1.147 -1.78 
23 2200 -1.815 -1.75 
24 2300 -1.625 -1.73 
25 2400 -0.561 -1.70 
26 2500 -0.545 -1.68 
27 2600 -1.775 -1.65 
28 2700 -0.885 -1.63 
29 2800 -1.194 -1.60 
30 2900 -0.869 -1.58 
31 3000 -1.328 -1.55 
32 3100 -1.004 -1.53 
33 3200 -0.973 -1.50 
34 3300 -0.486 -1.48 
35 3400 -0.888 -1.45 
36 3500 -0.540 -1.43 
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d) Kali Sememi direncanakan dengan kemiringan 0,0002 

Tabel 5.4 Data Elevasi Kali Sememi 
River Sta jarak (m) elevasi 

eksisting 
elevasi 

rencana 
1 0 -1.662 -2.20 
2 100 -1.633 -2.18 
3 200 -1.695 -2.16 
4 300 -1.594 -2.14 
5 400 -2.061 -2.12 
6 500 -1.866 -2.10 
7 600 -1.772 -2.08 
8 700 -1.647 -2.06 
9 800 -1.704 -2.04 
10 900 -1.717 -2.02 
11 1000 -1.582 -2.00 
12 1100 -1.750 -1.98 
13 1200 -1.700 -1.96 
14 1300 -1.603 -1.94 
15 1400 -1.610 -1.92 
16 1500 -1.671 -1.90 
17 1600 -0.879 -1.88 
18 1700 -1.841 -1.86 
19 1800 -2.202 -1.84 
20 1900 -1.830 -1.82 
21 2000 -1.153 -1.80 
22 2100 -1.892 -1.78 
23 2200 -1.510 -1.76 
24 2300 -1.040 -1.74 
25 2400 -1.645 -1.72 
26 2500 -1.436 -1.70 
27 2600 -1.438 -1.68 
28 2700 -1.350 -1.66 
29 2800 -1.785 -1.64 
30 2900 -1.603 -1.62 
31 3000 -0.921 -1.60 
32 3100 -1.231 -1.58 
33 3200 -1.423 -1.56 
34 3300 -1.209 -1.54 
35 3400 -1.380 -1.52 
36 3500 -0.897 -1.50 
37 3600 -1.054 -1.48 



109 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Dari tabel tersebut, bisa dibuat grafik dari hulu ke hilir untuk 
mengetahui penurunan elevasi dan kemiringan rencana. 
 
 

 

 

 

 

 

 

 

Grafik 5.4 Kemiringan Rencana Kali Sememi 

 

River Sta jarak (m) elevasi 
eksisting 

elevasi 
rencana 

38 3700 -1.184 -1.46 
39 3800 -1.198 -1.44 
40 3900 -1.231 -1.42 
41 4000 -1.364 -1.40 
42 4100 -1.335 -1.38 
43 4200 -1.021 -1.36 
44 4300 -1.133 -1.34 
45 4400 -1.235 -1.32 
46 4500 -1.165 -1.30 
47 4600 -0.132 -1.28 
48 4700 -0.921 -1.26 
49 4800 -0.821 -1.24 
50 4900 -0.831 -1.22 
51 5000 -0.679 -1.20 
52 5100 -0.555 -1.18 
53 5200 -0.438 -1.16 
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5.3.2  Perhitungan Dimensi Rencana 
   Setelah perencanaan kemiringan saluran, langkah 
selanjutnya adalah perhitungan dimensi rencana. Bertujuan untuk 
mendapatkan dimensi penampang yang dapat menampung debit 
yang mengalir. 
  Normalisasi saluran primer Margomulyo, Kali Balong, 
Kali Kandangan dan Kali Sememi direncanakan dengan bantuan 
rumus manning dengan debit banjir Q 10 th. Debit yang masuk 
terdapat pada point 6 pada sub bab 5.2. Untuk bentuk penampang 
direncanakan sesuai dengan kondisi eksisting. Saluran primer 
Margomulyo direncanakan dengan bentuk penampang persegi. 
Pada saluran primer Margomulyo untuk River Sta 18- River Sta 3 
sisi penampang terbuat dari pasangan batu kali, sedangkan untuk 
River Sta 2- River Sta 1 sisi penampang terbuat dari beton. Untuk 
dasar saluran terbuat dari tanah. Sedangkan untuk Kali Balong, 
Kali Kandangan, dan Kali Sememi direncanakan dengan bentuk 
penampang trapesium dan persegi sesuai kondisi eksisting, 
karena saluran tersebut merupakan saluran alam.  
  Contoh perhitungan rumus manning sebagai berikut: 
Rumus manning:  𝑄 =  1

𝑛
 𝑥 𝐼1/2 𝑥 𝑅2/3 𝑥 𝐴 

Dimana : 
Q : Debit aliran (m3/s) 
A : Luas penampang basah (m2) 
n : Koefisien kekasaran manning 
R : Jari-jari hidrolis sungai (m) 
I : Kemiringan hidraulik sungai 
 

1. Contoh perhitungan pada saluran primer Margomulyo 
 

 
 
 
 
 
 

Gambar 5.29  Saluran Penampang Persegi untuk Ruas Hulu 
Saluran Primer Margomulyo 
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Dengan Qhidrologi  = 30,37 m3/dt 
B = 10 m (sesuai eksisting) 
h = 3,43 m 
m = 1 
I = 0,0003 
A = b x h 
 = 10 x 3,43 
 = 34,3 m2 
P = b+2h 
 = 10 + (2x3,43) 
 = 16,9 m 
R = A/P 
 = 34,3/16,9 = 2,03 m 

Q hidrolika =  1
𝑛

 𝑥 𝐼1/2 𝑥 𝑅2/3 𝑥 𝐴 

 = 1
0,025

 𝑥 0,00031/2 𝑥 2,032/3 𝑥 34,3 

= 34,83 m3/dt 

Q hidrolika = 34,83 m3/dt > Qhidrologi  = 30,37 m3/dt (Aman) 

2. Contoh perhitungan pada Kali Kandangan 
 

 

 

 

Gambar 5.30  Saluran Penampang Trapesium untuk Ruas Hulu 
Kali Kandangan 
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Dengan Qhidrologi  = 63,59 m3/dt 

B = 20 m (coba-coba) 

h = 3,12 m 

m = 1 

I  = 0,0003 

n = 0,0025 

A = (B + m x H) H 

 = ( 20 + 1 x 3,12) 3,12 

 = 72 m2 

P = B + 2H √1 + 𝑚2 

 = 20 + 2 x 3,12 √1 + 12 

 = 28,81 m 

R = A/P 

 = 72/28,81 = 2,5 m 

Q hidrolika =  1
𝑛

 𝑥 𝐼1/2 𝑥 𝑅2/3 𝑥 𝐴 

 = 1
0,025

 𝑥 0,00031/2 𝑥 2,52/3 𝑥 72 

= 91,87 m3/dt 

Q hidrolika = 91,87 m3/dt > Qhidrologi  = 63,59 m3/dt (Aman). 
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b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

18 10.00 3.43 1 34.3 16.9 2.03 0.0003 0.025 34.83 30.37 OK
17 10.00 3.42 1 34.2 16.8 2.03 0.0003 0.025 34.69 30.37 OK
16 10.00 3.41 1 34.1 16.8 2.03 0.0003 0.025 34.55 30.37 OK
15 10.00 3.40 1 34.0 16.8 2.02 0.0003 0.025 34.41 30.37 OK
14 10.00 3.39 1 33.9 16.8 2.02 0.0003 0.025 34.26 30.37 OK
13 10.00 3.38 1 33.8 16.8 2.02 0.0003 0.025 34.12 30.37 OK
12 10.00 3.37 1 33.7 16.7 2.01 0.0003 0.025 33.98 30.37 OK
11 10.00 3.37 1 31.6 16.7 1.89 0.0003 0.025 30.46 30.37 OK
10 10.00 3.37 1 31.5 16.7 1.88 0.0003 0.025 30.38 30.37 OK
9 10.00 3.36 1 31.5 16.7 1.89 0.0003 0.025 30.39 30.37 OK
8 10.00 3.36 1 31.5 16.7 1.88 0.0003 0.025 30.40 30.37 OK
7 10.00 3.36 1 32.8 16.7 1.96 0.0003 0.025 32.51 30.37 OK
6 10.00 3.36 1 32.8 16.7 1.96 0.0003 0.025 32.43 30.37 OK
5 10.00 3.36 1 32.7 16.7 1.96 0.0003 0.025 32.34 30.37 OK
4 10.00 3.36 1 32.6 16.7 1.95 0.0003 0.025 32.18 30.37 OK
3 10.00 3.36 1 32.5 16.7 1.94 0.0003 0.025 32.01 30.37 OK
2 15.00 3.13 1 52.2 21.3 2.46 0.0003 0.018 83.45 82.33 OK
1 15.00 3.13 1 52.1 21.3 2.45 0.0003 0.018 83.19 82.33 OK

River 
Sta m i n Ket

b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

34 20 3.36 1 78.5 29.5 2.66 0.0007 0.025 161.10 69.29 OK
33 20 3.39 1 79.3 29.6 2.68 0.0007 0.025 163.54 69.29 OK
32 20 3.44 1 80.6 29.7 2.71 0.0007 0.035 119.75 69.29 OK
31 20 3.48 1 81.7 29.8 2.74 0.0007 0.035 122.12 69.29 OK
30 20 3.52 1 82.8 30.0 2.76 0.0007 0.035 124.50 69.29 OK
29 20 3.57 1 84.1 30.1 2.80 0.0007 0.035 127.51 69.29 OK
28 20 3.52 1 82.8 30.0 2.76 0.0007 0.035 124.50 69.29 OK
27 20 3.46 1 81.2 29.8 2.73 0.0007 0.035 120.93 69.29 OK
26 20 3.41 1 79.8 29.6 2.69 0.0007 0.035 117.99 69.29 OK
25 20 3.45 1 80.9 29.8 2.72 0.0007 0.035 120.34 69.29 OK

River 
Sta m i n Ket

Untuk perhitungan dimensi rencana pada setiap River Sta, akan di 
tabelkan sebagai berikut. 

Tabel 5.5 Perencanaan Dimensi Saluran Primer Margomulyo 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

Tabel 5.6 Perencanaan Dimensi Kali Balong 
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b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

36 20 3.12 1 72.00 28.81 2.50 0.0003 0.025 91.87 63.59 OK
35 15 3.04 1 54.84 23.60 2.32 0.0003 0.025 66.66 63.59 OK
34 19 3.04 1 71.89 27.58 2.61 0.0003 0.035 67.38 63.59 OK
33 20 3.03 1 71.67 28.57 2.51 0.0003 0.035 65.48 63.59 OK
32 20 3.01 1 71.45 28.50 2.51 0.0003 0.035 65.25 63.59 OK
31 20 2.99 1 71.23 28.46 2.50 0.0003 0.035 64.98 63.59 OK
30 25 3.00 1 83.85 33.47 2.50 0.0003 0.035 76.53 63.59 OK
29 25 3.00 1 84.00 33.49 2.51 0.0003 0.035 76.75 63.59 OK
28 25 3.00 1 83.85 33.47 2.50 0.0003 0.035 76.53 63.59 OK
27 25 3.00 1 84.00 33.49 2.51 0.0003 0.035 76.75 63.59 OK
26 25 3.00 1 83.85 33.47 2.50 0.0003 0.035 76.53 63.59 OK

River 
Sta m i n Ket

b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

24 32 3.44 1 121.9 41.7 2.92 0.0007 0.035 190.25 69.29 OK
23 32 3.52 1 125.0 42.0 2.98 0.0007 0.035 197.71 69.29 OK
22 32 3.50 1 124.3 41.9 2.97 0.0007 0.035 195.83 69.29 OK
21 32 3.59 1 127.8 42.2 3.03 0.0007 0.035 204.34 69.29 OK
20 32 3.57 1 127.0 42.1 3.02 0.0007 0.035 202.43 69.29 OK
19 32 3.66 1 130.5 42.4 3.08 0.0007 0.035 211.05 69.29 OK
18 32 3.64 1 129.7 42.3 3.07 0.0007 0.035 209.12 69.29 OK
17 32 3.73 1 133.3 42.6 3.13 0.0007 0.035 217.86 79.77 OK
16 40 3.71 1 162.2 50.5 3.21 0.0007 0.035 269.55 79.77 OK
15 40 3.80 1 166.4 50.7 3.28 0.0007 0.035 280.56 82.18 OK
14 40 3.79 1 166.0 50.7 3.27 0.0007 0.035 279.32 82.18 OK
13 40 3.88 1 170.3 51.0 3.34 0.0007 0.035 290.49 82.18 OK
12 40 3.87 1 169.8 50.9 3.33 0.0007 0.035 289.24 82.18 OK
11 40 3.96 1 174.1 51.2 3.40 0.0007 0.035 300.57 82.18 OK
10 40 3.95 1 173.6 51.2 3.39 0.0007 0.035 299.30 82.18 OK
9 40 4.04 1 177.9 51.4 3.46 0.0007 0.035 310.78 82.18 OK
8 40 4.03 1 177.4 51.4 3.45 0.0007 0.035 309.50 82.18 OK
7 48 4.23 1 220.9 60.0 3.68 0.0007 0.035 402.45 185.82 OK
6 48 4.06 1 211.4 59.5 3.55 0.0007 0.035 375.83 185.82 OK
5 48 4.05 1 210.8 59.5 3.55 0.0007 0.035 374.28 185.82 OK
4 48 3.90 1 202.4 59.0 3.43 0.0007 0.035 351.45 185.82 OK
3 48 3.82 1 198.0 58.8 3.37 0.0007 0.035 339.52 185.82 OK
2 48 3.74 1 193.5 58.6 3.30 0.0007 0.035 327.75 185.82 OK
1 48 3.65 1 188.5 58.3 3.23 0.0007 0.035 314.71 185.82 OK

River 
Sta m i n Ket 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Tabel 5.7 Perencanaan Dimensi Kali Kandangan 
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b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

25 25 2.99 1 83.69 33.46 2.50 0.0003 0.035 76.32 63.59 OK
24 28 3.01 1 93.17 36.50 2.55 0.0003 0.035 86.12 81.53 OK
23 28 2.97 1 91.98 36.40 2.53 0.0003 0.035 84.45 81.53 OK
22 28 2.96 1 91.47 36.36 2.52 0.0003 0.035 83.73 81.53 OK
21 28 2.95 1 91.30 36.34 2.51 0.0003 0.035 83.50 81.53 OK
20 28 2.95 1 91.13 36.33 2.51 0.0003 0.035 83.26 81.53 OK
19 28 2.93 1 90.62 36.29 2.50 0.0003 0.035 82.55 81.53 OK
18 28 2.93 1 90.46 36.27 2.49 0.0003 0.035 82.32 81.53 OK
17 28 2.91 1 89.95 36.23 2.48 0.0003 0.035 81.61 81.53 OK
16 28 2.91 1 89.78 36.22 2.48 0.0003 0.035 81.65 81.53 OK
15 28 2.89 1 89.27 36.17 2.47 0.0003 0.035 81.68 81.53 OK
14 28 2.88 1 88.77 36.13 2.46 0.0003 0.035 81.72 81.53 OK
13 28 2.87 1 98.73 36.12 2.73 0.0003 0.035 95.52 93.54 OK
12 28 2.83 1 98.41 35.99 2.73 0.0003 0.035 95.23 93.54 OK
11 28 2.80 1 98.09 35.92 2.73 0.0003 0.035 94.84 93.54 OK
10 28 2.78 1 97.77 35.85 2.73 0.0003 0.035 94.45 93.54 OK
9 28 2.74 1 97.45 35.75 2.73 0.0003 0.035 94.10 93.54 OK
8 28 2.72 1 97.24 35.68 2.73 0.0003 0.035 93.89 93.54 OK
7 28 2.68 1 100.54 35.58 2.83 0.0003 0.035 99.45 98.69 OK
6 28 2.63 1 100.33 35.42 2.83 0.0003 0.035 99.39 98.69 OK
5 30 2.60 1 108.35 37.35 2.90 0.0003 0.035 109.06 108.08 OK
4 30 2.52 1 108.23 37.11 2.92 0.0003 0.035 109.32 108.08 OK
3 30 2.45 1 108.11 36.93 2.93 0.0003 0.035 109.48 108.08 OK
2 30 2.39 1 107.99 36.75 2.94 0.0003 0.035 109.65 108.08 OK
1 30 2.30 1 107.87 36.51 2.95 0.0003 0.035 109.92 108.08 OK

River 
Sta m i n Ket

b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

53 20 3.92 1 93.8 31.1 3.02 0.0002 0.025 156.60 104.49 OK
52 20 3.89 1 92.9 31.0 3.00 0.0002 0.025 154.56 104.49 OK
51 20 3.86 1 92.1 30.9 2.98 0.0002 0.025 152.54 104.49 OK
50 20 3.83 1 91.3 30.8 2.96 0.0002 0.025 150.53 104.49 OK
49 20 3.79 1 90.2 30.7 2.94 0.0002 0.025 147.87 104.49 OK
48 20 3.76 1 89.3 30.6 2.92 0.0002 0.025 145.88 104.49 OK
47 20 3.73 1 88.5 30.6 2.90 0.0002 0.025 143.91 104.49 OK
46 20 3.68 1 87.1 30.4 2.87 0.0002 0.025 140.65 104.49 OK
45 25 3.68 1 105.5 35.4 2.98 0.0002 0.025 174.88 104.49 OK
44 25 3.65 1 104.6 35.3 2.96 0.0002 0.035 123.20 104.49 OK
43 25 3.62 1 103.6 35.2 2.94 0.0002 0.035 121.50 104.49 OK

River 
Sta m i n Ket

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tabel 5.8 Perencanaan Dimensi Kali Sememi 
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b h A P R Q hidrolikaQ hidrologi
(m) (m) (m) (m) (m) (m/dt) (m/dt)

42 25 3.59 1 102.6 35.2 2.92 0.0002 0.035 119.81 104.49 OK
41 25 3.56 1 101.7 35.1 2.90 0.0002 0.035 118.13 104.49 OK
40 25 3.52 1 100.4 35.0 2.87 0.0002 0.035 115.90 104.49 OK
39 25 3.49 1 99.4 34.9 2.85 0.0002 0.035 114.25 104.49 OK
38 25 3.46 1 98.5 34.8 2.83 0.0002 0.035 112.60 104.49 OK
37 25 3.43 1 97.5 34.7 2.81 0.0002 0.035 110.96 104.49 OK
36 25 3.40 1 96.6 34.6 2.79 0.0002 0.035 109.34 104.49 OK
35 25 3.38 1 95.9 34.6 2.78 0.0002 0.035 108.26 104.49 OK
34 25 3.35 1 95.0 34.5 2.75 0.0002 0.035 106.65 104.49 OK
33 25 3.33 1 94.3 34.4 2.74 0.0002 0.035 105.32 104.49 OK
32 25 3.30 1 93.4 34.3 2.72 0.0002 0.035 105.21 104.49 OK
31 25 3.27 1 92.4 34.2 2.70 0.0002 0.035 104.98 104.49 OK
30 25 3.24 1 91.8 34.2 2.69 0.0002 0.035 104.87 104.49 OK
29 25 3.22 1 91.8 34.1 2.69 0.0002 0.035 104.75 104.49 OK
28 25 3.19 1 91.7 34.0 2.69 0.0002 0.035 104.69 104.49 OK
27 25 3.15 1 91.7 33.9 2.70 0.0002 0.035 104.67 104.49 OK
26 25 3.11 1 91.5 33.8 2.71 0.0002 0.035 104.56 104.49 OK
25 30 3.10 1 102.6 38.8 2.65 0.0002 0.035 112.19 104.49 OK
24 30 3.09 1 102.2 38.7 2.64 0.0002 0.035 111.59 104.49 OK
23 30 3.07 1 101.5 38.7 2.62 0.0002 0.035 110.38 104.49 OK
22 30 3.05 1 100.8 38.6 2.61 0.0002 0.035 109.18 104.49 OK
21 30 3.03 1 100.1 38.6 2.59 0.0002 0.035 107.99 104.49 OK
20 30 3.02 1 99.7 38.5 2.59 0.0002 0.035 107.39 104.49 OK
19 30 3.00 1 99.0 38.5 2.57 0.0002 0.035 106.21 104.49 OK
18 30 2.99 1 98.6 38.5 2.56 0.0002 0.035 105.62 104.49 OK
17 30 2.97 1 97.9 38.4 2.55 0.0002 0.035 104.56 104.49 OK
16 30 2.95 1 97.2 38.3 2.54 0.0002 0.035 104.89 104.49 OK
15 38 2.96 1 129.9 46.4 2.80 0.0002 0.035 147.45 144.08 OK
14 38 2.88 1 129.8 46.1 2.81 0.0002 0.035 147.70 144.08 OK
13 38 2.85 1 129.6 46.1 2.81 0.0002 0.035 147.66 144.08 OK
12 38 2.81 1 129.5 45.9 2.82 0.0002 0.035 147.67 144.08 OK
11 38 2.77 1 129.4 45.8 2.82 0.0002 0.035 147.68 144.08 OK
10 38 2.73 1 129.3 45.7 2.83 0.0002 0.035 147.70 144.08 OK
9 38 2.69 1 129.2 45.6 2.83 0.0002 0.035 147.71 144.08 OK
8 38 2.64 1 129.0 45.5 2.84 0.0002 0.035 147.79 144.08 OK
7 38 2.59 1 128.9 45.3 2.84 0.0002 0.035 147.87 144.08 OK
6 38 2.54 1 128.8 45.2 2.85 0.0002 0.035 147.95 144.08 OK
5 38 2.49 1 128.7 45.0 2.86 0.0002 0.035 148.03 144.08 OK
4 38 2.43 1 128.6 44.9 2.86 0.0002 0.035 148.17 144.08 OK
3 38 2.36 1 128.4 44.7 2.87 0.0002 0.035 148.38 144.08 OK
2 38 2.29 1 128.3 44.5 2.88 0.0002 0.035 148.58 144.08 OK
1 38 2.20 1 128.2 44.2 2.90 0.0002 0.035 148.92 144.08 OK

River 
Sta m i n Ket 
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5.3.3  Pemodelan Pada HEC-RAS 
   Dari perencanaan dimensi saluran, bisa diketahui berapa 
dimensi yang bisa menampung debit yang mengalir. Kemudian 
dari dimensi dan kemiringan dasar saluran yang sudah 
direncanakan bisa dimodelkan pada HEC-RAS. 
  Proses tahapan dalam memasukkan data dimensi rencana 
pada HEC-RAS sama seperti pada saat input data kondisi 
eksisting. Akan tetatpi pada normalisasi metode aliran yang 
digunakan adalah unsteady flow data. Berikut ini adalah langkah-
langkah yang harus dilakukan untuk analisa penampang rencana: 
1. Save as geometry data 

 Pada geometry data kondisi eksisting sket saluran yang 
ditinjau telah dibuat, agar tidak membuat sket lagi maka 
geometry data perlu di save as dan disimpan dengan nama 
yang berbeda, dengan cara klik File →Save Geometry Data 
As→Isikan nama file pada Title → OK. 
 

 

 

 

 

 

 

Gambar 5.31  Tampilan Save Geometry Data As 

2. Input data dimensi penampang rencana 
 Sama seperti tahapan pada pengisian data pada kondisi 
eksiting, klik cross section pada geometric data. Pilih Cross 
Section→Options→Add new cross section. Isikan data-data 
perencanaan. Setelah semua data diisi, klik apply data. 
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Kemudian akan muncul bentuk penampang sesuai dengan 
data cross section yang dimasukkan. 

 

 

 

 

 

Gambar 5.32  Tampilan Cross Section Dimensi Rencana 

3. Input data debit (Unsteady Flow Data) 
Pada analisa penampang rencana, metode aliran yang 

digunakan adalah unsteady flow data. Data debit diperoleh 
dari pemodelan HEC-HMS. Debit yang dimasukkan pada 
HEC-RAS adalah debit jam-jaman atau debit yang berupa 
unit hydrograph yang masuk ke tiap saluran primer dan 
lateral inflow yang terdapat pada saluran primer tersebut. 

Untuk memasukkan data debit pilih menu Edit → 
Unsteady Flow Data.  

 

 

 

 

Gambar 5.33 Memilih Unsteady Flow Data 
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Gambar 5.34 Tampilan Unsteady Flow Data 

 Pada boundary condition klik flow hydrograph untuk 
debit yang masuk ke hulu. Pada gambar 5.29 RS (River Sta) 
34 adalah hulu dari Kali Balong, sedangkan RS 18 adalah 
hulu dari saluran primer Margomulyo. Untuk RS 1 pada 
gambar diatas merupakan hilir dari Kali Balong. Karena hilir 
Kali Balong bermuara ke laut maka akan terpengaruh oleh 
pasang surut air laut. Untuk pengaruh pasang surut air laut 
klik stage hydrograph. 

 Lateral Inflow Hydrograph merupakan debit yang masuk 
ke saluran primer, akan tetapi RS tidak otomatis keluar pada 
tabel seperti gambar 5.29.  RS dapat dimunculkan dengan 
klik Add RS → pilih RS mana yang akan ditampilkan → 
OK. Setelah RS muncul, klik lateral inflow hydrograph. 
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Gambar 5.35 Tampilan Unsteady Flow Data Saluran Primer 
Margomulyo dan Kali Balong 

 

 

 

 

 

 

 

 

Gambar 5.36 Tampilan Input Flow/Lateral Inflow Hydrograph 
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Karena muara sungai merupakan Selat Madura maka 
akan terpengaruh pasang surut air laut. Menurut SDMP 
Surabaya nilai pasang pada Kali Balong, Kali Kandangan, 
dan Kali Sememi adalah pada elevasi 0 m. Data yang 
dimasukkan dalam TA ini hanya dalam kondisi pasang, 
karena sebagai kondisi tertinggi dari hilir. Berikut tampilan 
pengisian data pada stage hydrograph. 

 

 

 

 

 

 

 

 

 

Gambar 5.37 Tampilan Stage Hydrograph 

Berikut tampilan unsteady flow data yang diisikan pada 
saluran primer Kandangan dan saluran primer Sememi 
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Gambar 5.38 Tampilan Unsteady Flow data pada Kali 
Kandangan 

 

 

 

 

 

 

 

Gambar 5.39 Tampilan Unsteady Flow Data pada Kali Sememi 

Untuk debit yang dimasukkan pada flow hydrograph dan Lateral 
Inflow Hydrograf akan dilampirkan. 
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4. Pemodelan Pintu Air pada Kali Balong 
Karena kondisi eksisting pada Kali Balong terdapat pintu 

air pada hilirnya. Maka pada perencanaan normalisasi juga akan 
direncanakan pintu air. Langkah-langkah pemodelan pintu 
sabagai berikut: 

a. Save as geometry data normalisasi 
 Agar tidak input data dari awal, maka perlu save as 
geometry data hasil normalisasi. klik File →Save Geometry 
Data As→Isikan nama file pada Title → OK. 

b. Menentukan letak pintu air 
 Tentukan cross section yang akan dipasang pintu air 
kemudian buat cross section baru. Contoh pada Kali Balong, 
direncanakan letak pintu air akan diletakkan diantara river 
sta. 6 dan river sta.7 . Maka perlu membuat cross section 
baru diantara river sta tersebut.  
 Pada geometry data klik cross section → cari cross 
section 6 → Options →Copy current cross section → ketik 
nama RS pada kolom River Sta. 

  

 

 

 

 

 

 

Gambar 5.40 Tampilan Copy Current Cross Section 
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Untuk cross section 6.5 karena terletak diantara River Sta 6 
dan River Sta 7 maka jarak LOB, Channel, dan ROB yang 
semula 140 m, menjadi 70 m. Begitu juga untuk river sta 7 
jaraknya menjadi 70 m. 

c. Inline Structure 
Setelah membuat cross section baru klik inline structure 

pada editor geometric data. Kemudian klik Options → Add 
an Inline Structure. 

 

 

 

 

 

 

Gambar 5.41 Memilih Inline Structure pada Geometric Data 

 

 

 

 

 

 

Gambar 5.42 Memilih Add an Inline Structure. 
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Akan keluar enter a new river for the new inline 
steucture in reach balong. Masukkan river sta yang akan 
direncanakan pintu air. Ketikkan 6.4 maka otomatis HEC-
RAS akan membaca bahwa pintu air diletakkan di river sta 
6.5 .  

 

 

 

 

 

 

 

 

Gambar 5.43 Input River Sta tempat diletakkan pintu 
air. 

 Klik Gate, kemudian isikan berapa tinggi dan lebar pintu 
rencana. Pada Kali Balong akan di rencanakan tinggi pintu 
air 3 m dan lebar pintu air 3 m. Untuk invert tuliskan elevasi 
terendah dari pintu. Karena dasar saluran terletak pada -3,6 
maka akan direncanakan invert pada elevasi -3,2 m. 
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Gambar 5.44 Tampilan Inline Gate Editor 

 Station pada gambar diatas diisi jarak titik berat dari 
pintu 1 ke pintu selanjutnya. Pada Kali Balong direncanakan 
8 pintu dengan lebar pintu 3 m dan lebar pilar 1,1 m. Jadi 
jarak titik berat antara pintu 1 ke pintu selanjutnya adalah 
4,4 m. 

 Untuk sluce discharge coefficient isikan 0,5 itu adalah 
koefisien untuk debit pintu air. Nilai koefisien antara 0,5 – 
0,7. Sadangkan untuk orifice coefficient dan weir coefficient 
tidak perlu diisi karena HEC-RAS akan mengisi secara 
otomatis. Kemudian klik OK dan akan keluar tampilan 
seperti berikut: 

  



127 
 

 
 

 

 

 

  

 

 

 

 

 

Gambar 5.45 Tampilan Pemodelan Pintu 

 Pada gambar 5.45 jumlah pintu ada 8 buah, kemudian ada 
ruang di sebelah kiri pintu dengan lebar 9 m. Ruang tersebut 
nantinya akan digunakan sebagai pondasi rumah pompa 
balong. 

 Kemudian klik weir/embankment, ini bertujuan untuk 
memodelkan struktur beton di sekitar pintu air. Pada 
distance isikan jarak dari river sta ke lokasi pintu air. Pada 
Kali Balong direncanakan jarak ke pintu air adalah 10 m. 
Sedangkan width adalah tebal pintu air, direncanakan 0,2 m. 
Weir Coef akan otomatis mengisi sendiri. 

 Untuk station dan elevation isikan jarak dan elevasi 
tanggul pada river sta lokasi pintu air. 
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Gambar 5.46 Tampilan Inline Structure Weir Station Elevation 
Editor 

 

 

 

 

 

 

 

 

Gambar 5.47 Tampilan Konstruksi Pintu 
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d. Pengisian unsteady flow data 
Setelah pemodelan pintu selesai langkah selanjutnya 

adalah mengatur tinggi bukaan pintu. Untuk mengatur tinggi 
bukaan pintu klik menu Edit → Unsteady Flow Data. 
Kemudian akan ada RS 6.4 letak pintu air. Pada boundary 
condition klik T.S Gate Openings. Isikan tinggi bukaan 
pintu. Pada Kali Balong tinggi bukaan dianggap sama tiap 
jam yaitu 2,5 m. 

 

 

 

 

 

 

 

Gambar 5.48 Pengaturan Tinggi Bukaan Pintu Air 

5. Pemodelan pompa pada Kali Balong 
Karena kondisi eksisting pada Kali Balong terdapat 

pompa air pada hilirnya. Maka pada perencanaan 
normalisasi juga akan direncanakan pompa. Langkah-
langkah pemodelan pintu sabagai berikut: 

a. Menentukan letak pompa 
   Tentukan cross section yang akan dipasang pompa 

kemudian buat cross section baru. Pada Kali Balong, letak 
pompa eksisting berdekatan dengan lokasi pintu air, 
sehingga direncanakan pompa akan diletakkan diantara river 
sta. 6 dan river sta.7 . Maka perlu membuat cross section 
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baru diantara river sta tersebut. Namun cross section yang 
baru ini berbeda dengan cross section yang dibuat untuk 
perencanaan pintu.  
 Pengerjaan seperti pada membuat cross section baru pada 
perencanaan pintu dengan klik cross section → cari cross 
section 7 → Options →Copy current cross section → ketik 
nama RS pada kolom River Sta. Pada tugas akhir ini cross 
section yan baru adalah cross section 6.8 dan 6.9. 
 Setelah itu klik pump station pada geometric data. 
Letakkan pump station pada cross section baru yang telah 
dibuat. Pada tugas akhir ini di letakkan di cross section 6.9. 
kemudian beri nama pompa. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 5.49 Menentukan Letak Pompa 

b. Operasional pompa 
Pada geometric data klik pump station pada kotak merah. 

Kemudian isikan data pada pump station data editor. 
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Gambar 5.50 Editor Pengisian Data Pompa 

 Pada kotak editor, untuk pump from isikan letak cross 
section dimana letak pompa memompa dari.  Untuk pump to 
isikan cross section tujuan pompa. Untuk distance,isikan jarak 
upstream ke pompa. Sedangkan untuk highest elevation in pump 
isikan nilai elevasi tertinggi letak pompa. Pada Kali Balong, data 
yang disiikan seperti di bawah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 5.51 Pengisian Data pada Pump Station Data Editor 
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 Setelah itu isikan data pada pump group data. Tampilan 
seperti gambar berikut. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 5.52 Pengisian Data Operasional Pompa 

Karena pada Kali Balong ada 5 pompa yang beroperasi, 
maka pada number of pumps in group pilih angka 5. Kemudian 
pada pump operation terdapat WS Elev On (m) dan WS Elev Off  
(m). Itu digunakan untuk mengatur di elevasi berapa pompa akan 
mulai menyala dan kapan pompa akan berhenti beroperasi. 

Kemudian pada tabel pump efficiency curve terdapat 
head (m) dan flow (m3/s). Head adalah perbedaan elevasi dari 
pump from ke pump to. Sedangkan untuk  flow adalah kapasitas 
pompa. Kapasitas 1 unit pompa di Kali Balong adalah 2 m3/s, 
maka total kapasitas keseluruhan adalah 10 m3/s. Setelah data 
terisi klik OK dan simulasi program. 
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6. Simulasi Program 
Setelah semua data selesai dimasukkan, pilih 

Run→Unsteady Flow Analysis. 
 
 
 
 
 

 

Gambar 5.53 Memilih Run Unsteady Flow Analysis 

 

 

 

 

 

 

Gambar 5.54 Tampilan Run Unsteady Flow Analysis 

 Pada gambar 5.53 klik File → New Plan → Isikan 
nama plan pada Title → OK. Centang pada Geometry 
Preprocessor, Unsteady Flow Simulation dan Post 
Processor untuk program to run. Kemudian isikan tanggal 
dan waktu pada Simulation Time Window. Pilih Compute 
dan program akan menghitung data yang sudah kita input.  
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7. Output data 
a) Profil penampang memanjang 

 
 

 

 

 

 

 

 

 

Gambar 5.55 Profil Muka Air Kali Balong Setelah Normalisasi 

 

 

 

 

 

 

 

Gambar 5.56 Profil Muka Air Saluran Primer Margomulyo 
Setelah Normalisasi 
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Gambar 5.57 Profil Muka Air Saluran Kali Kandangan Setelah 
Normalisasi  

 

 

 

 

 

 

 

Gambar 5.58 Profil Muka Air Saluran Kali Sememi Setelah 
Normalisasi 
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b) Profil penampang melintang (cross section) 
 

 

 

 

 

 

 

Gambar 5.59 Profil Penampang Melintang Kali Balong RS 33 
setelah normalisasi 

 

  

 

 

 

 

 

Gambar 5.60 Profil Penampang Melintang Saluran Primer 
Margomulyo RS 18 setelah normalisasi 
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Gambar 5.61 Profil Penampang Melintang Kali Kandangan RS 
36 setelah normalisasi 

 

 

 

 

 

 

 

 

Gambar 5.62 Profil Penampang Melintang Kali Sememi RS 53 
setelah normalisasi 
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Dari profil muka air setelah normalisasi diatas menunjukkan 
bahwa penampang dimensi rencana mampu menampung debit 
yang mengalir. 

5.4 Analisa Backwater 
Backwater terjadi karena ada pengaruh pasang surut air 

laut. Dengan adanya backwater bisa menyebabkan aliran air 
berbalik dari laut menuju sungai sehingga akan terjadi banjir di 
hilir sungai. Akan tetapi karena nilai pasang pada Kali Balong, 
Kali Kandangan, dan Kali Sememi tidak terlalu tinggi dimana 
nilai pasang di elevasi 0 m ,  maka dari itu salah satu upaya 
pencegahan adanya backwater ini adalah dengan membuat 
tanggul di hilir. 

Tinggi tanggul yang direncanakan untuk Kali Balong, 
Kali Kandangan, dan Kali Sememi adalah 0,6 m. 

5.5 Perbandingan Profil Muka Air Penampang Eksisting 
dan Setelah Normalisasi 
Dari hasil analisa penampang eksisting dan analisa 

penampang rencana didapatkan profil muka air yang berbeda, 
yang dimaksud adalah tinggi elevasi muka air dan elevasi dasar 
saluran seperti grafik dibawah ini: 
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a) Saluran primer Margomulyo 

 

 

 

 

 

 

 

Grafik 5.5 Perbandingan Profil Muka Air Saluran Eksisting dan 
Perencanaan Saluran Primer Margomulyo 

b) Kali Balong 
 

 

 

 

 

 

 

Grafik 5.6 Perbandingan Profil Muka Air Eksisting dan 
Perencanaan Kali Balong 
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c)  Kali Kandangan 

 

 

 

 

 

 

 

Grafik 5.7 Perbandingan Profil Muka Air Saluran Eksisting dan 
Perencanaan Kali Kandangan 

d)  Kali Sememi 
 

 

 

 

 

 

 

Grafik 5.8 Perbandingan Profil Muka Air Saluran Eksisting dan 
Perencanaan Kali Sememi 
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Dari hasil analisa penampang eksisting dan analisa penampang 
rencana didapatkan profil muka air saluran yang berbeda. Dimana 
elevasi muka air rencana lebih rendah daripada elevasi muka air 
eksisting. Ini dikarenakan kondisi eksisting sudah di normalisasi 
dengan cara dilebarkan dan elevasi dasar eksisting sudah 
mengalami pengerukan dan beberapa ditimbun, sehingga 
menghasilkan elevasi rencana yang lebih landai. 
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“Halaman ini sengaja dikosongkan” 

 

 









1 2 3 4 Total total OF total OF
m2 km2 m m m m m m ft Y Y (%) % jam menit

1 ST. 1 45677.51 0.05 102.00 102.00 447.82 1469.22 0.00435 0.43544 82.9 71.3 4.03 0.84 50.63
2 ST. 2 61534.72 0.06 163.00 163.00 377.51 1238.56 0.00228 0.22791 79.3 71.2 4.04 1.02 61.16
3 ST. 3 214742.95 0.21 209.00 209.00 1027.48 3370.98 0.00390 0.39000 82.7 71.1 4.06 1.74 104.48
4 ST. 4 200757.23 0.20 192.00 192.00 1045.61 3430.47 0.00921 0.92110 89.5 73.8 3.55 1.07 63.99
5 ST. 5 215363.26 0.22 250.00 250.00 861.45 2826.28 0.00347 0.34686 84.3 79.3 2.62 1.27 76.03
6 ST. 6 129040.79 0.13 120.00 120.00 1075.34 3528.01 0.00220 0.21994 85.0 79.0 2.66 1.92 114.96
7 ST. 7 340467.03 0.34 681.93 681.93 499.27 1638.03 0.00578 0.57776 64.5 74.1 3.50 0.74 44.41
8 ST. 8 372521.56 0.37 656.00 656.00 567.87 1863.08 0.00616 0.61644 61.5 76.3 3.11 0.74 44.67
9 ST. 9 1065708.52 1.07 496.00 496.00 2148.61 7049.22 0.00682 0.68234 78.0 70.7 4.14 2.40 144.16

10 ST. 10 1049307.32 1.05 632.00 2065 2697.00 194.53 638.23 0.00682 0.68234 78.0 70.7 4.14 0.35 21.10
11 ST. 11 333581.18 0.33 764.60 764.60 436.28 1431.38 0.00812 0.81222 87.6 75.3 3.29 0.54 32.48
12 ST. 12 416612.01 0.42 866.39 866.39 480.86 1577.62 0.00790 0.79010 87.0 76.9 3.01 0.57 33.99
13 ST. 13 459660.27 0.46 811.75 811.75 566.26 1857.81 0.01022 1.02224 89.3 78.2 2.79 0.55 32.71
14 ST. 14 466426.81 0.47 884.73 884.73 527.20 1729.65 0.01041 1.04078 88.8 77.8 2.86 0.52 31.03
15 ST. 15 172329.69 0.17 587.25 587.25 293.45 962.77 0.01397 1.39655 80.5 76.7 3.05 0.29 17.32
16 ST. 16 127073.04 0.13 699.56 699.56 181.65 595.95 0.00513 0.51301 27.0 68.3 4.64 0.41 24.57
17 ST. 17 200986.83 0.20 1022.58 1022.58 196.55 644.84 0.00513 0.51301 82.0 76.7 3.05 0.35 20.74
18 ST. 18 100045.89 0.10 368.54 368.54 271.47 890.63 0.01543 1.54259 80.8 74.9 3.36 0.27 16.32
19 ST. 19 270091.58 0.27 536.61 536.61 503.33 1651.35 0.00474 0.47424 85.3 74.3 3.47 0.82 49.05
20 ST. 20 91857.07 0.09 395.74 395.74 232.12 761.54 0.01104 1.10357 82.8 71.4 4.02 0.31 18.77
21 ST. 21 246331.71 0.25 716.17 716.17 343.96 1128.47 0.00255 0.25546 80.8 74.9 3.36 0.81 48.46
22 ST. 22 89773.72 0.09 202.99 202.99 442.25 1450.96 0.00697 0.69666 78.3 75.6 3.24 0.59 35.16
23 ST. 23 410116.45 0.41 689.49 110.507 800.00 256.32 840.95 0.01551 1.55063 81.9 69.8 4.33 0.30 17.90
24 ST. 24 385272.66 0.39 549.97 549.97 700.54 2298.34 0.01205 1.20451 82.3 70.9 4.10 0.73 44.02
25 ST. 25 127609.22 0.13 252.79 252.79 504.80 1656.18 0.02474 2.47431 78.0 66.8 4.98 0.44 26.41
26 ST. 26 800835.91 0.80 724.61 724.61 1105.19 3625.95 0.01379 1.37855 75.4 69.0 4.48 1.04 62.32
27 ST. 27 671839.09 0.67 1112.71 1112.71 603.79 1980.92 0.00596 0.59579 75.9 69.0 4.48 0.97 58.44
28 ST. 28 400082.44 0.40 1012.83 1012.83 395.01 1295.98 0.00596 0.59579 76.3 70.6 4.16 0.66 39.88
29 ST. 29 466595.12 0.47 1012.83 1012.83 460.68 1511.43 0.00596 0.59579 76.3 70.6 4.16 0.75 45.11
30 ST. 30 320747.08 0.32 705.15 705.15 454.86 1492.33 0.00596 0.59579 76.3 70.6 4.16 0.74 44.65
31 ST. 31 340946.16 0.34 705.15 705.15 483.51 1586.31 0.00596 0.59579 76.3 70.6 4.16 0.78 46.88
32 ST. 32 524535.64 0.52 593.84 593.84 883.29 2897.94 0.01013 1.01300 87.3 72.5 3.80 0.92 55.37
33 ST. 33 328127.37 0.33 275.90 275.90 1189.31 3901.93 0.01083 1.08264 87.3 76.4 3.09 1.01 60.72
34 ST. 34 105917.16 0.11 143.77 143.77 736.69 2416.96 0.01143 1.14282 87.5 72.0 3.89 0.76 45.65
35 ST. 35 125663.90 0.13 501.32 501.32 250.67 822.39 0.00299 0.29934 85.5 73.5 3.61 0.60 36.11
36 ST. 36 66769.64 0.07 501.32 501.32 133.19 436.96 0.00988 0.98819 88.5 72.9 3.72 0.20 12.19
37 ST. 37 335254.75 0.34 479.46 479.46 699.23 2294.07 0.00543 0.54270 87.2 74.5 3.43 0.99 59.30
38 ST. 38 336280.55 0.34 901.72 901.72 372.93 1223.52 0.00801 0.80108 87.7 74.9 3.35 0.49 29.14
39 ST. 39 94205.97 0.09 510.22 510.22 184.64 605.76 0.00996 0.99581 88.5 71.1 4.07 0.28 16.59
40 ST. 40 76223.83 0.08 510.22 510.22 149.39 490.13 0.00412 0.41194 88.2 75.4 3.27 0.32 19.30
41 ST. 41 108796.92 0.11 299.25 299.25 363.56 1192.79 0.02053 2.05274 95.9 72.2 3.86 0.32 19.28
42 ST. 42 270226.50 0.27 512.68 512.68 527.09 1729.30 0.01656 1.65585 89.3 73.6 3.58 0.46 27.73
43 ST. 43 292790.44 0.29 378.81 378.81 772.93 2535.84 0.00959 0.95854 88.0 70.6 4.16 0.90 53.83
44 ST. 44 359896.35 0.36 428.96 428.96 838.99 2752.59 0.01249 1.24886 88.0 74.3 3.46 0.76 45.44
45 ST. 45 220481.73 0.22 141.75 141.75 1555.48 5103.26 0.00168 0.16750 84.7 72.4 3.82 3.58 214.56
46 ST. 46 420890.62 0.42 307.67 307.67 1367.99 4488.14 0.00849 0.84937 83.7 67.8 4.75 1.62 97.38

Tabel Perhitungan Luas, Panjang Overland flow, Kemiringan, Retensi,m dan Time Lag tiap Catchment Area

S
Time LagCurve 

NumberNo Catchment
Luas ImperviousPanjang Overland flow Kemiringan 



1 2 3 4 Total total OF total OF
m2 km2 m m m m m m ft Y Y (%) % jam menit

47 ST. 47 227189.67 0.23 328.23 328.23 692.18 2270.91 0.00040 0.03995 87.0 73.4 3.62 3.72 223.43
48 ST. 48 127272.47 0.13 604.12 389.025 993.15 64.08 210.22 0.00014 0.01436 87.3 75.5 3.24 0.87 52.27
49 ST. 49 235095.72 0.24 969.48 969.48 242.50 795.59 0.01134 1.13437 87.7 72.2 3.85 0.31 18.74
50 ST. 50 228911.99 0.23 113.47 113.47 2017.42 6618.81 0.01477 1.47744 84.7 71.1 4.06 1.54 92.14
51 ST. 51 486403.63 0.49 227.34 227.34 2139.53 7019.43 0.01394 1.39418 84.4 73.5 3.61 1.55 93.10
52 ST. 52 110899.01 0.11 557.95 557.95 198.76 652.10 0.02210 2.20958 78.9 68.1 4.69 0.21 12.80
53 ST. 53 148082.69 0.15 339.51 339.51 436.16 1430.97 0.01188 1.18849 82.0 68.5 4.59 0.54 32.34
54 ST. 54 205210.35 0.21 356.44 356.44 575.71 1888.82 0.02734 2.73354 86.9 73.3 3.64 0.39 23.37
55 ST. 55 142260.12 0.14 913.91 913.91 155.66 510.70 0.00733 0.73258 84.3 72.0 3.89 0.27 16.43
56 ST. 56 219880.17 0.22 348.80 348.80 630.39 2068.21 0.03313 3.31285 79.9 70.0 4.29 0.42 25.01
57 ST. 57 295563.82 0.30 841.30 504.136 1345.44 109.84 360.36 0.03362 3.36170 83.2 70.8 4.12 0.10 6.00
58 ST. 58 94388.24 0.09 699.84 699.84 134.87 442.49 0.00941 0.94141 82.5 70.0 4.29 0.23 13.66
59 ST. 59 191950.81 0.19 609.51 370.051 193.348 1172.91 81.83 268.46 0.00838 0.83768 79.6 63.7 5.71 0.19 11.47
60 ST. 60 193642.68 0.19 649.19 649.19 298.28 978.61 0.02069 2.06900 89.0 75.2 3.30 0.25 15.04
61 ST. 61 33449.35 0.03 452.57 452.57 73.91 242.49 0.00171 0.17081 89.0 73.4 3.63 0.30 18.07
62 ST. 62 164663.29 0.16 656.82 656.82 250.70 822.50 0.00689 0.68906 79.9 70.9 4.10 0.43 25.58
63 ST. 63 102985.16 0.10 365.60 365.60 281.69 924.18 0.00171 0.17081 82.1 62.9 5.89 1.16 69.60
64 ST. 64 79367.00 0.08 475.23 475.23 167.01 547.92 0.02307 2.30716 83.6 67.5 4.82 0.18 11.07
65 ST. 65 164901.42 0.16 158.47 158.47 1040.61 3414.06 0.01800 1.79971 89.3 69.0 4.50 0.87 52.10
66 ST. 66 136156.05 0.14 202.87 202.87 671.15 2201.92 0.00555 0.55501 88.5 72.9 3.72 0.99 59.30
67 ST. 67 238455.35 0.24 164.94 164.94 1445.75 4743.26 0.00775 0.77453 76.0 63.2 5.82 2.00 120.09
68 ST. 68 521588.33 0.52 202.87 202.87 2571.03 8435.13 0.02400 2.40030 88.3 72.7 3.75 1.40 83.93
69 ST. 69 391865.002 0.39 436.54 436.54 897.66 2945.06 0.00763 0.76309 76.0 72.2 3.85 1.08 65.08
70 ST. 70 89462.62 0.09 543.62 543.62 164.57 539.92 0.01585 1.58482 0.0 75.0 3.33 0.18 10.74
71 ST. 71 484745.56 0.48 543.62 543.62 891.70 2925.53 0.00763 0.76309 86.5 71.1 4.06 1.11 66.72
72 ST. 72 120127.54 0.12 299.99 299.99 400.44 1313.77 0.04031 4.03083 87.4 70.1 4.27 0.26 15.74
73 ST. 73 599199.33 0.60 468.93 468.93 1277.79 4192.23 0.00596 0.59579 87.4 70.1 4.27 1.73 103.58
74 ST. 74 23849.66 0.02 109.91 109.91 217.00 711.94 0.02307 2.30716 89.0 73.4 3.63 0.19 11.64
75 ST. 75 65638.80 0.07 318.74 318.74 205.93 675.63 0.01800 1.79971 83.4 69.4 4.42 0.24 14.10
76 ST. 76 62525.24 0.06 136.04 136.04 459.62 1507.92 0.00555 0.55501 83.4 69.4 4.42 0.80 48.26
77 ST. 77 196042.95 0.20 345.90 345.90 566.76 1859.44 0.01334 1.33427 81.5 71.5 3.98 0.58 34.72
78 ST. 78 61851.22 0.06 693.25 693.25 89.22 292.71 0.00352 0.35204 90.5 74.7 3.39 0.23 14.09
79 ST. 79 353945.24 0.35 771.12 771.12 459.00 1505.91 0.03343 3.34256 56.8 69.7 4.35 0.32 19.47
80 ST. 80 51877.78 0.05 308.85 308.85 167.97 551.08 0.00858 0.85797 95.8 74.8 3.37 0.25 14.92
81 ST. 81 177960.38 0.18 558.58 558.58 318.60 1045.26 0.03181 3.18076 95.8 73.9 3.53 0.22 13.26
82 ST. 82 263476.90 0.26 617.65 617.65 426.58 1399.54 0.02493 2.49255 89.9 76.7 3.04 0.29 17.49
83 ST. 83 337615.39 0.34 617.65 617.65 546.62 1793.35 0.02115 2.11461 70.6 72.8 3.74 0.43 25.87
84 ST. 84 197706.64 0.20 512.13 512.13 386.05 1266.55 0.01167 1.16659 77.6 69.1 4.47 0.49 29.14
85 ST. 85 492998.31 0.49 423.99 423.99 1162.77 3814.86 0.01135 1.13458 59.3 69.8 4.32 1.17 70.06
86 ST. 86 263397.30 0.26 637.02 637.02 413.48 1356.57 0.01360 1.36009 80.7 69.3 4.43 0.47 28.39
87 ST. 87 114632.11 0.11 753.92 753.92 152.05 498.84 0.01778 1.77793 80.0 69.2 4.45 0.19 11.18
88 ST. 88 121692.34 0.12 201.67 201.67 603.42 1979.72 0.01869 1.86883 84.0 75.1 3.32 0.47 27.92
89 ST. 89 238648.04 0.24 789.11 238.926 1028.03 116.07 380.81 0.02171 2.17105 80.0 66.0 5.14 0.15 8.86
90 ST. 90 451490.84 0.45 537.54 537.54 839.91 2755.61 0.01705 1.70500 76.1 69.2 4.45 0.75 44.80
91 ST. 91 37073.67 0.04 238.17 238.17 155.66 510.70 0.00282 0.28175 87.3 69.2 4.45 0.48 28.61
92 ST. 92 66871.98 0.07 235.74 235.74 283.67 930.67 0.00282 0.28175 87.4 73.8 3.56 0.68 40.80

No Catchment
Luas Panjang Overland flow Kemiringan Impervious Curve 

Number S
Time Lag

Tabel Perhitungan Luas, Panjang Overland flow, Kemiringan, Retensi,m dan Time Lag tiap Catchment Area



1 2 3 4 Total total OF total OF
m2 km2 m m m m m m ft Y Y (%) % jam menit

93 ST. 93 113058.63 0.11 539.42 539.42 209.59 687.63 0.01385 1.38471 87.6 70.2 4.24 0.27 15.92
94 ST. 94 51525.91 0.05 302.28 302.28 170.46 559.24 0.00029 0.02896 88.4 64.1 5.60 1.83 109.71
95 ST. 95 33864.68 0.03 477.53 477.53 70.92 232.66 0.00762 0.76226 83.4 71.1 4.06 0.15 8.81
96 ST. 96 86923.30 0.09 184.32 184.32 471.58 1547.17 0.01163 1.16310 86.5 67.5 4.81 0.60 35.75
97 ST. 97 392551.94 0.39 1373.98 1373.98 285.70 937.35 0.01192 1.19218 83.8 70.9 4.10 0.36 21.57
98 ST. 98 65165.49 0.07 368.67 368.67 176.76 579.91 0.01072 1.07166 81.7 67.8 4.74 0.28 16.84
99 ST. 99 91564.11 0.09 368.67 368.67 248.36 814.83 0.01508 1.50797 89.6 72.9 3.73 0.27 16.26
100 ST. 100 196167.81 0.20 941.92 941.92 208.26 683.28 0.01860 1.85973 80.0 67.6 4.80 0.24 14.68
101 ST. 101 243262.74 0.24 941.92 941.92 258.26 847.32 0.01389 1.38868 81.9 68.5 4.60 0.33 19.69
102 ST. 102 168087.99 0.17 213.71 213.71 786.53 2580.48 0.01906 1.90625 70.1 69.6 4.36 0.66 39.75
103 ST. 103 157850.95 0.16 528.15 528.15 298.88 980.56 0.00956 0.95567 89.0 70.5 4.18 0.42 25.26
104 ST. 104 341496.35 0.34 259.98 259.98 1313.55 4309.53 0.01481 1.48140 88.7 73.1 3.68 1.03 61.80
105 ST. 105 197754.56 0.20 833.94 833.94 237.13 778.00 0.00032 0.03215 83.4 66.2 5.10 2.14 128.27
106 ST. 106 288561.39 0.29 823.01 326.99 176.934 1326.93 108.73 356.73 0.00614 0.61417 80.9 66.5 5.04 0.26 15.63
107 ST. 107 247782.41 0.25 1250.04 403.491 108.381 1761.91 70.32 230.70 0.00105 0.10478 83.8 70.4 4.20 0.40 24.05
108 ST. 108 61897.48 0.06 426.54 426.54 145.11 476.10 0.00291 0.29122 91.4 75.5 3.24 0.37 22.33
109 ST. 109 275635.50 0.28 1053.09 937.029 1990.12 69.25 227.20 0.01144 1.14391 86.2 64.8 5.44 0.14 8.34
110 ST. 110 148372.72 0.15 243.77 360.073 603.84 122.86 403.08 0.01646 1.64576 87.9 66.0 5.14 0.18 10.65
111 ST. 111 55482.88 0.06 353.07 353.07 157.14 515.56 0.00291 0.29122 82.9 74.1 3.50 0.41 24.80
112 ST. 112 301618.05 0.30 698.85 311.707 421.218 173.351 1605.12 93.95 308.25 0.02292 2.29244 82.5 68.8 4.54 0.11 6.77
113 ST. 113 25267.50 0.03 321.01 321.01 78.71 258.24 0.00291 0.29122 90.8 73.1 3.68 0.24 14.65
114 ST. 114 107226.26 0.11 622.97 622.97 172.12 564.70 0.00354 0.35414 81.9 70.0 4.29 0.45 27.07
115 ST. 115 19172.39 0.02 244.16 244.16 78.52 257.62 0.00291 0.29122 86.6 71.0 4.08 0.26 15.49
116 ST. 116 37705.34 0.04 147.98 147.98 254.80 835.96 0.00291 0.29122 79.4 67.8 4.74 0.72 43.29
117 ST. 117 33020.65 0.03 72.88 72.88 453.08 1486.49 0.00354 0.35414 78.6 63.4 5.76 1.16 69.76
118 ST. 118 104259.22 0.10 159.68 159.68 652.93 2142.14 0.00327 0.32659 90.3 57.1 7.51 1.91 114.32
119 ST. 119 162346 0.16 255 103 373 731.00 111.04 364.32 0.01281 1.28121 84.3 68.2 4.66 0.18 10.51
120 ST. 120 17748 0.02 259 259.00 68.53 224.82 0.00466 0.46617 86.5 71.1 4.06 0.18 10.96
121 ST. 121 36363 0.04 295 295.00 123.26 404.41 0.00797 0.79652 89.5 55.3 8.08 0.34 20.18
122 ST. 122 122131 0.12 353 353.00 345.98 1135.10 0.00797 0.79652 85.8 63.2 5.82 0.63 37.72
123 ST. 123 69902 0.07 513 513.00 136.26 447.05 0.00245 0.24522 11.6 11.2 79.53 3.03 181.58
124 ST. 124 130302 0.13 445 445.00 292.81 960.67 0.01491 1.49059 88.1 66.5 5.04 0.37 22.17
125 ST. 125 111314 0.11 631 631.00 176.41 578.77 0.02380 2.37970 87.6 60.2 6.60 0.23 13.73
126 ST. 126 170809 0.17 422 409 831.00 102.77 337.18 0.00777 0.77715 86.4 63.2 5.83 0.24 14.48
127 ST. 127 118852 0.12 419 419.00 283.66 930.63 0.02516 2.51578 86.4 71.1 4.06 0.24 14.70
128 ST. 128 244499 0.24 417 417.00 586.33 1923.65 0.01445 1.44490 76.5 79.0 2.66 0.46 27.64
129 ST. 129 164564 0.16 417 417.00 394.64 1294.74 0.01445 1.44490 81.2 62.9 5.90 0.52 31.37
130 ST. 130 40819 0.04 452 452.00 90.31 296.28 0.01933 1.93340 86.0 63.2 5.83 0.14 8.28
131 ST. 131 126972 0.13 715 715.00 177.58 582.62 0.01517 1.51710 85.9 68.7 4.55 0.23 13.87
132 ST. 132 352082 0.35 938 938.00 375.35 1231.47 0.01360 1.36039 83.5 64.9 5.41 0.49 29.49
133 ST. 133 140238 0.14 715 715.00 196.14 643.49 0.01753 1.75301 73.5 61.0 6.40 0.28 17.09
134 ST. 134 378934 0.38 527 527.00 719.04 2359.05 0.01052 1.05240 91.2 62.1 6.10 1.01 60.56
135 ST. 135 443700 0.44 690 690.00 643.04 2109.72 0.03233 3.23337 88.6 63.3 5.79 0.51 30.63
136 ST. 136 280097 0.28 853 853.00 328.37 1077.32 0.02643 2.64343 84.1 68.6 4.58 0.29 17.24
137 ST. 137 293050 0.29 664 664.00 441.34 1447.96 0.01739 1.73871 72.5 64.6 5.48 0.50 29.92
138 ST. 138 309252 0.31 1032 1032.00 299.66 983.14 0.01692 1.69151 77.6 62.1 6.09 0.40 23.71

Tabel Perhitungan Luas, Panjang Overland flow, Kemiringan, Retensi,m dan Time Lag tiap Catchment Area

No Catchment
Luas Panjang Overland flow Kemiringan Impervious Curve 

Number S
Time Lag



1 2 3 4 Total total OF total OF
m2 km2 m m m m m m ft Y Y (%) % jam menit

139 ST. 139 590219 0.59 849 849.00 695.19 2280.81 0.01959 1.95867 78.5 63.2 5.82 0.70 42.02
140 ST. 140 84880 0.08 489 489.00 173.58 569.48 0.01513 1.51337 83.5 65.1 5.37 0.25 15.03
141 ST. 141 206697 0.21 300 300.00 688.99 2260.46 0.01102 1.10236 81.2 64.0 5.62 0.91 54.49
142 ST. 142 39079 0.04 406 406.00 96.25 315.79 0.01530 1.53038 93.5 47.8 10.92 0.24 14.45
143 ST. 143 208333 0.21 215 215.00 968.99 3179.10 0.00981 0.98072 80.6 68.5 4.61 1.13 67.56
144 ST. 144 308918 0.31 406 406.00 760.88 2496.33 0.01156 1.15569 90.0 57.2 7.49 1.14 68.57
145 ST. 145 31537 0.03 238 238.00 132.51 434.74 0.00291 0.29122 81.8 64.2 5.58 0.47 28.24
146 ST. 146 137582 0.14 711 711.00 193.50 634.86 0.00035 0.03503 83.8 62.4 6.03 1.92 115.35
147 ST. 147 126854 0.13 254 254.00 499.43 1638.53 0.00492 0.49188 88.8 66.7 5.00 0.98 58.87
148 ST. 148 193422 0.19 293 293.00 660.14 2165.82 0.00581 0.58055 88.3 69.0 4.49 1.06 63.62
149 ST. 149 197362 0.20 173 173.00 1140.82 3742.84 0.00582 0.58177 83.7 70.0 4.29 1.60 95.91
150 ST. 150 95700 0.10 683 683.00 140.12 459.70 0.00440 0.44008 87.6 68.5 4.60 0.36 21.45
151 ST. 151 17118 0.02 302 302.00 56.68 185.96 0.00291 0.29122 82.0 65.1 5.37 0.23 13.99
152 ST. 152 77433 0.08 243 243.00 318.65 1045.45 0.00291 0.29122 88.8 64.6 5.49 0.94 56.41
153 ST. 153 22212 0.02 76 76.00 292.26 958.87 0.00291 0.29122 96.8 38.7 15.84 1.71 102.60
154 ST. 154 37113 0.04 334 334.00 111.12 364.56 0.00291 0.29122 81.9 66.9 4.96 0.38 22.87
155 ST. 155 100856 0.10 324 324.00 311.28 1021.27 0.00242 0.24226 78.2 57.2 7.47 1.22 73.15
156 ST. 156 91895 0.09 257 257.00 357.57 1173.12 0.00242 0.24226 87.6 59.1 6.91 1.30 77.92
157 ST. 157 48349 0.05 188 188.00 257.18 843.75 0.02146 2.14577 89.6 43.4 13.06 0.50 30.07
158 ST. 158 80982 0.08 305 305.00 265.51 871.11 0.00143 0.14279 83.7 55.9 7.90 1.45 86.80
159 ST. 159 76567 0.08 384 384.00 199.39 654.18 0.02146 2.14577 87.1 54.9 8.22 0.30 18.27
160 ST. 160 236716 0.24 418 418.00 566.31 1857.96 0.01221 1.22095 88.3 67.2 4.89 0.68 40.76
161 ST. 161 34980 0.03 432 432.00 80.97 265.66 0.00275 0.27538 72.5 67.5 4.83 0.30 17.97
162 ST. 162 46748 0.05 266 266.00 175.74 576.59 0.00139 0.13898 86.3 56.0 7.86 1.05 63.05
163 ST. 163 48972 0.05 273 273.00 179.38 588.53 0.00209 0.20940 85.7 60.8 6.44 0.77 46.24
164 ST. 164 106141 0.11 168 168.00 631.79 2072.80 0.02705 2.70543 81.3 66.9 4.95 0.50 30.12
165 ST. 165 47740 0.05 107 107.00 446.17 1463.80 0.01218 1.21842 89.4 51.3 9.49 0.84 50.51
166 ST. 166 86749 0.09 300 300.00 289.16 948.70 0.01220 1.22020 88.0 56.1 7.83 0.53 31.63
167 ST. 167 220300 0.22 559 559.00 394.10 1292.97 0.01422 1.42208 88.3 61.2 6.34 0.55 32.97
167a ST. 167a 63989.55 0.06 288.46 288.46 221.83 727.79 0.01422 1.42208 88.5 61.4 6.29 0.35 20.72
168 ST. 168 68769 0.07 263 263.00 261.48 857.87 0.0001 0.01348 81.4 67.3 4.85 3.47 208.21
169 ST. 169 71173 0.07 149 149.00 477.67 1567.16 0.0011 0.11162 87.8 55.9 7.89 2.62 156.97
170 ST. 170 36225 0.04 182 182.00 199.04 653.01 0.0011 0.11162 85.1 63.1 5.84 1.08 64.88
171 ST. 171 83497 0.08 177 177.00 471.73 1547.68 0.0018 0.18217 91.1 53.7 8.62 2.14 128.52
172 ST. 172 63033 0.06 156 156.00 404.06 1325.65 0.0018 0.18217 88.7 48.9 10.45 2.14 128.28
173 ST. 173 77182 0.08 606 606.00 127.36 417.86 0.0005 0.04698 86.0 60.2 6.61 1.26 75.39
174 ST. 174 351385 0.35 619 619.00 567.67 1862.42 0.0109 1.08843 90.2 72.7 3.76 0.62 37.29
175 ST. 175 302471 0.30 778 778.00 388.78 1275.52 0.0021 0.20810 16.6 15.7 53.86 5.81 348.56
176 ST. 176 133839 0.13 729 729.00 183.59 602.34 0.0021 0.20810 85.7 59.1 6.93 0.82 49.40
177 ST. 177 66916 0.07 385 385.00 173.81 570.23 0.0021 0.20810 88.0 72.5 3.80 0.55 33.28
178 ST. 178 216534 0.22 1054 1054.00 205.44 674.02 0.0048 0.47784 86.1 67.3 4.85 0.48 28.84
179 ST. 179 51319 0.05 416 416.00 123.36 404.73 0.0048 0.47784 87.2 71.2 4.04 0.29 17.27
180 ST. 180 66742 0.07 614 614.00 108.70 356.63 0.0048 0.47784 83.5 65.6 5.24 0.30 18.12
181 ST. 181 52602 0.05 425 425.00 123.77 406.07 0.0048 0.47784 80.4 65.5 5.28 0.34 20.19
182 ST. 182 52747 0.05 191 191.00 276.16 906.04 0.0048 0.47784 88.4 59.7 6.76 0.74 44.51
183 ST. 183 72810 0.07 320 320.00 227.53 746.49 0.0048 0.47784 84.0 63.1 5.85 0.58 34.91

Tabel Perhitungan Luas, Panjang Overland flow, Kemiringan, Retensi,m dan Time Lag tiap Catchment Area

No Catchment
Luas Panjang Overland flow Kemiringan Impervious Curve 

Number S
Time Lag



1 2 3 4 Total total OF total OF
m2 km2 m m m m m m ft Y Y (%) % jam menit

184 ST. 184 50544 0.05 261 261.00 193.66 635.35 0.0048 0.47784 93.1 53.9 8.56 0.65 38.78
185 ST. 185 59859 0.06 334 334.00 179.22 587.99 0.0048 0.47784 82.3 56.1 7.82 0.57 34.45
186 ST. 186 144716 0.14 560 560.00 258.42 847.84 0.0107 1.06582 82.1 64.8 5.43 0.41 24.78
187 ST. 187 152281 0.15 186 186.00 818.72 2686.07 0.0096 0.96331 86.7 68.9 4.51 0.98 58.84
188 ST. 188 74181 0.07 495 495.00 149.86 491.67 0.0018 0.17727 85.5 64.7 5.45 0.66 39.36
189 ST. 189 176031 0.18 704 704.00 250.04 820.35 0.0018 0.17727 88.7 72.8 3.74 0.80 47.82
190 ST. 190 221784 0.22 771 771.00 287.66 943.76 0.0096 0.95809 86.4 57.4 7.42 0.57 34.37
191 ST. 191 77314 0.08 468 468.00 165.20 542.00 0.0065 0.64970 76.5 71.2 4.05 0.31 18.73
192 ST. 192 105266.04 0.11 350.28 350.28 300.52 985.96 0.0065 0.64970 88.0 63.8 5.67 0.61 36.72
193 ST. 193 183409.16 0.18 323.17 323.17 567.53 1861.95 0.0113 1.13219 82.8 69.3 4.43 0.67 40.07
194 ST. 194 63808.45 0.06 78.27 78.27 815.23 2674.62 0.0107 1.07333 83.3 65.4 5.29 1.02 60.93
195 ST. 195 132928.56 0.13 638.47 638.47 208.20 683.06 0.0011 0.10692 86.0 69.3 4.44 0.98 58.52
196 ST. 196 107397.40 0.11 531.89 531.89 201.92 662.46 0.0041 0.40807 85.6 59.9 6.69 0.62 37.24
197 ST. 197 262641.99 0.26 662.78 662.78 396.27 1300.10 0.0077 0.76907 86.0 62.5 6.01 0.73 43.60
198 ST. 198 93481.03 0.09 892.43 892.43 104.75 343.66 0.0080 0.80282 90.0 68.5 4.59 0.21 12.57
199 ST. 199 47728.54 0.05 563.17 563.17 84.75 278.05 0.0041 0.40807 94.8 70.2 4.25 0.24 14.23
200 ST. 200 267439.73 0.27 530.25 530.25 504.37 1654.75 0.0168 1.68102 90.0 66.4 5.07 0.54 32.35
201 ST. 201 106361.57 0.11 406.42 406.42 261.71 858.61 0.0048 0.47784 89.3 66.0 5.15 0.60 36.21
202 ST. 202 40684.89 0.04 266.96 266.96 152.40 500.00 0.0048 0.47784 90.2 71.6 3.96 0.34 20.23
203 ST. 203 59767.53 0.06 371.03 371.03 161.08 528.49 0.0048 0.47784 79.2 63.6 5.73 0.44 26.16
204 ST. 204 51248.98 0.05 371.03 371.03 138.13 453.17 0.0048 0.47784 87.3 60.0 6.66 0.42 25.32
205 ST. 205 54284.01 0.05 414.50 414.50 130.96 429.67 0.0101 1.01147 88.5 62.7 5.95 0.26 15.60
206 ST. 206 193983.75 0.19 414.50 414.50 468.00 1535.42 0.0101 1.01147 83.8 55.5 8.02 0.86 51.83
207 ST. 207 94194.44 0.09 239.43 239.43 393.41 1290.70 0.0101 1.01147 87.0 66.2 5.11 0.57 34.34
208 ST. 208 40927.35 0.04 379.05 379.05 107.97 354.24 0.0101 1.01147 84.6 66.0 5.16 0.20 12.28
209 ST. 209 219736.45 0.22 540.64 540.64 406.44 1333.47 0.0101 1.01147 81.9 64.4 5.54 0.62 36.96
210 ST. 210 171379.90 0.17 506.17 506.17 338.58 1110.83 0.0101 1.01147 82.8 65.2 5.34 0.52 31.24
211 ST. 211 47893.37 0.05 545.62 545.62 87.78 287.98 0.0101 1.01147 81.1 67.9 4.73 0.16 9.88
212 ST. 212 70581.13 0.07 273.53 273.53 258.03 846.57 0.0101 1.01147 91.1 64.4 5.53 0.43 25.66
213 ST. 213 90782.36 0.09 457.56 457.56 198.41 650.93 0.0101 1.01147 88.2 62.6 5.98 0.36 21.79
214 ST. 214 194068.25 0.19 580.15 580.15 334.51 1097.48 0.0041 0.40792 88.3 61.3 6.31 0.90 53.82
215 ST. 215 394061.78 0.39 638.30 53.2833 691.58 284.90 934.70 0.0026 0.25604 81.8 68.1 4.70 0.84 50.19
216 ST. 216 577777.24 0.58 741.96 741.96 778.72 2554.85 0.0161 1.61454 70.9 72.4 3.82 0.66 39.73
217 ST. 217 377598.55 0.38 619.18 619.18 609.84 2000.77 0.0045 0.44723 82.9 63.5 5.76 1.31 78.70
218 ST. 218 81798.57 0.08 196.15 196.15 417.03 1368.19 0.0048 0.47784 88.8 67.6 4.79 0.84 50.40
219 ST. 219 33365.18 0.03 87.39 87.39 381.78 1252.57 0.0048 0.47784 88.1 65.1 5.35 0.84 50.12
220 ST. 220 120631.84 0.12 312.15 312.15 386.46 1267.91 0.0048 0.47784 87.1 62.4 6.02 0.90 54.30
221 ST. 221 125351.34 0.13 404.57 404.57 309.84 1016.53 0.0048 0.47784 90.2 56.0 7.85 0.89 53.50
222 ST. 222 72156.63 0.07 72.40 72.40 996.64 3269.81 0.0156 1.56490 89.9 58.0 7.24 1.19 71.63
223 ST. 223 194073.93 0.19 764.61 764.61 253.82 832.74 0.0156 1.56490 86.3 54.2 8.44 0.44 26.37
224 ST. 224 126804.03 0.13 480.06 480.06 264.14 866.61 0.0156 1.56490 85.2 82.7 2.10 0.21 12.48
225 ST. 225 197527.21 0.20 480.06 480.06 411.47 1349.96 0.0285 2.85134 31.7 66.1 5.12 0.35 21.23
226 ST. 226 72415.63 0.07 255.73 255.73 283.18 929.06 0.0007 0.07132 86.4 59.9 6.70 1.95 116.92
227 ST. 227 168567.41 0.17 391.68 391.68 430.37 1411.98 0.0213 2.13115 85.8 51.2 9.54 0.62 37.22
228 ST. 228 95996.68 0.10 298.44 298.44 321.66 1055.30 0.0007 0.07132 86.8 50.1 9.95 2.76 165.59
229 ST. 229 421740.38 0.42 587.59 587.59 717.75 2354.83 0.0080 0.80115 79.6 61.3 6.31 1.18 70.76

Tabel Perhitungan Luas, Panjang Overland flow, Kemiringan, Retensi,m dan Time Lag tiap Catchment Area

No Catchment
Luas Panjang Overland flow Kemiringan Impervious Curve 
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1 2 3 4 Total total OF total OF
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230 ST. 230 18250.03 0.02 93.29 93.29 195.63 641.83 0.0006 0.05663 92.6 72.9 3.72 1.15 69.27
231 ST. 231 21724.44 0.02 271.48 271.48 80.02 262.54 0.0006 0.05663 87.8 72.3 3.84 0.57 34.47
232 ST. 232 146692.81 0.15 492.49 492.49 297.86 977.22 0.0086 0.86013 73.3 60.3 6.59 0.58 34.70
233 ST. 233 98815.44 0.10 199.04 199.04 496.47 1628.83 0.0180 1.80330 86.7 56.8 7.60 0.66 39.34
234 ST. 234 108912.64 0.11 458.06 458.06 237.77 780.08 0.0216 2.16199 72.5 64.2 5.58 0.28 16.54
235 ST. 235 108453.95 0.11 462.61 462.61 234.44 769.15 0.0119 1.18660 79.1 66.2 5.11 0.35 20.97
236 ST. 236 503083.73 0.50 1215.36 1215.36 413.94 1358.07 0.0053 0.52781 77.1 60.7 6.47 0.95 56.99
237 ST. 237 190811.33 0.19 434.72 434.72 438.93 1440.06 0.0053 0.53082 91.5 60.4 6.56 1.00 60.09
238 ST. 238 112435.82 0.11 748.76 748.76 150.16 492.66 0.0169 1.68552 89.5 58.8 7.00 0.25 14.86
239 ST. 239 75602.73 0.08 133.40 133.40 566.72 1859.30 0.0169 1.68552 91.5 58.0 7.25 0.73 43.95
240 ST. 240 39658.15 0.04 261.26 261.26 151.79 498.01 0.0169 1.68552 90.7 60.1 6.64 0.24 14.53
241 ST. 241 107546.83 0.11 367.42 367.42 292.71 960.32 0.0043 0.42561 89.4 60.5 6.53 0.81 48.35
242 ST. 242 304202.28 0.30 1093.16 1093.16 278.28 912.98 0.0050 0.49923 82.3 62.6 5.98 0.68 40.67
243 ST. 243 15427.70 0.02 66.22 66.22 232.97 764.34 0.0043 0.42561 87.6 68.4 4.62 0.55 32.84
244 ST. 244 126959.61 0.13 345.50 556.338 901.84 70.39 230.93 0.0067 0.66645 42.8 70.7 4.15 0.16 9.47
245 ST. 245 224367.53 0.22 556.3378 556.34 403.29 1323.14 0.0036 0.35618 27.0 67.6 4.79 0.95 56.87
246 ST. 246 31232.20 0.03 139.91 139.91 223.24 732.40 0.0067 0.66645 87.0 69.7 4.35 0.41 24.49
247 ST. 247 314513.27 0.31 938.20 938.20 335.23 1099.84 0.0060 0.59924 70.7 54.7 8.28 0.88 52.61
248 ST. 248 54920.39 0.05 424.54 424.54 129.36 424.42 0.0318 3.17910 89.6 62.8 5.93 0.14 8.69
249 ST. 249 116408.40 0.12 322.28 322.28 361.20 1185.05 0.0387 3.87370 73.3 65.1 5.35 0.28 16.84
250 SK. 250 5074933.04 5.07 3450.87 3170.72 163.43 6785.02 373.98 1226.97 0.0021 0.21256 83.8 68.1 4.68 1.14 68.39
251 SK. 251 1372630.98 1.37 576.52 804.69 1298.85 2680.06 256.08 840.16 0.0019 0.18908 87.6 69.3 4.44 0.87 51.91
252 SK. 252 1257276.22 1.26 1244.80 1244.80 1010.02 3313.72 0.0033 0.33163 95.0 79.0 2.66 1.48 88.99
253 SK. 253 2311050.28 2.31 769.17 784.66 2148.97 3702.80 312.07 1023.84 0.0014 0.13893 87.1 72.6 3.78 1.08 64.79
254 SK. 254 667010.97 0.67 580.12 580.12 1149.78 3772.24 0.0043 0.42540 95.0 78.8 2.68 1.46 87.64
255 SK. 255 508290.20 0.51 524.65 524.65 968.82 3178.53 0.0005 0.04894 95.5 79.2 2.63 3.71 222.82
256 SK. 256 2094081.75 2.09 1385.95 1385.95 1510.94 4957.13 0.0012 0.12092 91.6 68.8 4.55 4.54 272.32
257 SK. 257 962041.98 0.96 2009.31 2009.31 478.79 1570.84 0.0039 0.38758 92.3 87.0 1.49 0.58 34.65
258 SK.258 5400733.91 5.40 1464.48 1464.48 3687.82 12099.11 0.0039 0.38758 94.0 79.8 2.54 3.78 226.66

Tabel Perhitungan Luas, Panjang Overland flow, Kemiringan, Retensi,m dan Time Lag tiap Catchment Area

No Catchment
Luas Panjang Overland flow Kemiringan Impervious Curve 

Number S
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ST. 1 78% 4% 4% 4% 10% 100% 82.9 71.3
ST. 2 71% 5% 6% 8% 10% 100% 79.3 71.2
ST. 3 80% 2% 4% 4% 10% 100% 82.7 71.1
ST. 4 60% 30% 10% 100% 89.5 73.8
ST. 5 90% 3% 7% 100% 84.3 79.3
ST. 6 100% 100% 85.0 79.0
ST. 7 70% 25% 5% 100% 64.5 74.1
ST. 8 70% 28% 2% 100% 61.5 76.3
ST. 9 80% 10% 10% 100% 78.0 70.7
ST. 10 80% 10% 10% 100% 78.0 70.7
ST. 11 70% 20% 3% 7% 100% 87.6 75.3
ST. 12 70% 20% 5% 5% 100% 87.0 76.9
ST. 13 60% 35% 5% 100% 89.3 78.2
ST. 14 65% 30% 5% 100% 88.8 77.8
ST. 15 50% 20% 20% 5% 5% 100% 80.5 76.7
ST. 16 20% 70% 10% 100% 27.0 68.3
ST. 17 60% 20% 10% 5% 5% 100% 82.0 76.7
ST. 18 85% 5% 5% 5% 100% 80.8 74.9
ST. 19 90% 4% 6% 100% 85.3 74.3
ST. 20 80% 5% 5% 10% 100% 82.8 71.4
ST. 21 85% 5% 5% 5% 100% 80.8 74.9
ST. 22 75% 10% 10% 5% 100% 78.3 75.6
ST. 23 70% 5% 8% 5% 12% 100% 81.9 69.8
ST. 24 85% 5% 10% 100% 82.3 70.9
ST. 25 70% 5% 10% 15% 100% 78.0 66.8
ST. 26 68% 8% 12% 12% 100% 75.4 69.0
ST. 27 71% 5% 12% 12% 100% 75.9 69.0
ST. 28 78% 12% 10% 100% 76.3 70.6
ST. 29 78% 12% 10% 100% 76.3 70.6
ST. 30 78% 12% 10% 100% 76.3 70.6
ST. 31 78% 12% 10% 100% 76.3 70.6
ST. 32 70% 15% 5% 10% 100% 87.3 72.5
ST. 33 80% 15% 5% 100% 87.3 76.4
ST. 34 80% 10% 10% 100% 87.5 72.0
ST. 35 80% 10% 2% 8% 100% 85.5 73.5
ST. 36 70% 20% 10% 100% 88.5 72.9
ST. 37 82% 11% 7% 100% 87.2 74.5
ST. 38 77% 16% 7% 100% 87.7 74.9
ST. 39 71% 17% 12% 100% 88.5 71.1
ST. 40 72% 21% 7% 100% 88.2 75.4
ST. 41 82% 18% 100% 95.9 72.2
ST. 42 62% 28% 10% 100% 89.3 73.6
ST. 43 76% 12% 12% 100% 88.0 70.6
ST. 44 74% 18% 8% 100% 88.0 74.3
ST. 45 70% 16% 4% 10% 100% 84.7 72.4
ST. 46 82% 4% 14% 100% 83.7 67.8
ST. 47 84% 8% 8% 100% 87.0 73.4
ST. 48 80% 14% 6% 100% 87.3 75.5
ST. 49 78% 12% 10% 100% 87.7 72.2
ST. 50 78% 12% 10% 100% 84.7 71.1
ST. 51 82% 11% 7% 100% 84.4 73.5
ST. 52 68% 6% 2% 10% 14% 100% 78.9 68.1
ST. 53 77% 5% 5% 13% 100% 82.0 68.5
ST. 54 85% 7% 8% 100% 86.9 73.3
ST. 55 74% 12% 4% 10% 100% 84.3 72.0
ST. 56 81% 8% 11% 100% 79.9 70.0
ST. 57 76% 8% 5% 11% 100% 83.2 70.8
ST. 58 74% 8% 6% 12% 100% 82.5 70.0
ST. 59 63% 10% 8% 19% 100% 79.6 63.7
ST. 60 64% 28% 8% 100% 89.0 75.2
ST. 61 65% 25% 10% 100% 89.0 73.4
ST. 62 69% 16% 5% 10% 100% 79.9 70.9
ST. 63 73% 7% 20% 100% 82.1 62.9
ST. 64 74% 6% 5% 15% 100% 83.6 67.5
ST. 65 65% 20% 15% 100% 89.3 69.0
ST. 66 70% 20% 0% 10% 100% 88.5 72.9
ST. 67 80% 20% 100% 76.0 63.2

Pergudangan Cek Impervious (%) Curve Number 
(%)

Perhitungan Nilai Impervious dan Curve Number Tiap Catchment Area
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ST. 68 72% 18% 10% 100% 88.3 72.7
ST. 69 80% 12% 8% 100% 76.0 72.2
ST. 70 100% 100% 0.0 75.0
ST. 71 90% 10% 100% 86.5 71.1
ST. 72 82% 6% 12% 100% 87.4 70.1
ST. 73 82% 6% 12% 100% 87.4 70.1
ST. 74 65% 25% 10% 100% 89.0 73.4
ST. 75 84% 4% 12% 100% 83.4 69.4
ST. 76 84% 4% 12% 100% 83.4 69.4
ST. 77 56% 16% 11% 6% 11% 100% 81.5 71.5
ST. 78 50% 40% 0% 10% 100% 90.5 74.7
ST. 79 55% 35% 10% 100% 56.8 69.7
ST. 80 85% 15% 100% 95.8 74.8
ST. 81 84% 16% 100% 95.8 73.9
ST. 82 82% 6% 12% 100% 89.9 76.7
ST. 83 24% 54% 12% 10% 100% 70.6 72.8
ST. 84 73% 5% 10% 12% 100% 77.6 69.1
ST. 85 58% 32% 10% 100% 59.3 69.8
ST. 86 75% 7% 6% 12% 100% 80.7 69.3
ST. 87 80% 8% 12% 100% 80.0 69.2
ST. 88 44% 46% 10% 100% 84.0 75.1
ST. 89 72% 4% 8% 16% 100% 80.0 66.0
ST. 90 54% 26% 8% 12% 100% 76.1 69.2
ST. 91 64% 14% 8% 14% 100% 87.3 69.2
ST. 92 80% 12% 8% 100% 87.4 73.8
ST. 93 80% 8% 12% 100% 87.6 70.2
ST. 94 66% 10% 4% 20% 100% 88.4 64.1
ST. 95 69% 21% 10% 100% 83.4 71.1
ST. 96 73% 4% 8% 15% 100% 86.5 67.5
ST. 97 61% 18% 4% 5% 12% 100% 83.8 70.9
ST. 98 50% 20% 6% 8% 16% 100% 81.7 67.8
ST. 99 45% 37% 6% 12% 100% 89.6 72.9

ST. 100 51% 18% 5% 10% 16% 100% 80.0 67.6
ST. 101 81% 6% 13% 100% 81.9 68.5
ST. 102 53% 10% 5% 20% 12% 100% 70.1 69.6
ST. 103 67% 20% 13% 100% 89.0 70.5
ST. 104 68% 22% 10% 100% 88.7 73.1
ST. 105 71% 10% 3% 16% 100% 83.4 66.2
ST. 106 62% 4% 12% 6% 16% 100% 80.9 66.5
ST. 107 71% 12% 5% 12% 100% 83.8 70.4
ST. 108 41% 49% 10% 100% 91.4 75.5
ST. 109 72% 10% 18% 100% 86.2 64.8
ST. 110 60% 14% 8% 18% 100% 87.9 66.0
ST. 111 68% 18% 6% 8% 100% 82.9 74.1
ST. 112 63% 12% 5% 6% 14% 100% 82.5 68.8
ST. 113 48% 40% 12% 100% 90.8 73.1
ST. 114 70% 8% 4% 6% 12% 100% 81.9 70.0
ST. 115 75% 8% 6% 11% 100% 86.6 71.0
ST. 116 59% 12% 4% 10% 15% 100% 79.4 67.8
ST. 117 60% 8% 12% 20% 100% 78.6 63.4
ST. 118 42% 20% 8% 30% 100% 90.3 57.1
ST. 119 70% 4% 10% 2% 14% 100% 84.3 68.2
ST. 120 90% 10% 100% 86.5 71.1
ST. 121 70% 30% 100% 89.5 55.3
ST. 122 65% 15% 20% 100% 85.8 63.2
ST. 123 10% 3% 13% 11.6 11.2
ST. 124 70% 10% 3% 17% 100% 88.1 66.5
ST. 125 49% 11% 15% 25% 100% 87.6 60.2
ST. 126 74% 5% 1% 20% 100% 86.4 63.2
ST. 127 89% 1% 10% 100% 86.4 71.1
ST. 128 83% 4% 3% 10% 100% 76.5 79.0
ST. 129 72% 8% 20% 100% 81.2 62.9
ST. 130 71% 8% 1% 20% 100% 86.0 63.2
ST. 131 80% 7% 13% 100% 85.9 68.7
ST. 132 46% 22% 5% 7% 20% 100% 83.5 64.9
ST. 133 54% 8% 16% 22% 100% 73.5 61.0
ST. 134 38% 32% 5% 25% 100% 91.2 62.1

Perhitungan Nilai Impervious dan Curve Number Tiap Catchment Area
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ST. 135 56% 20% 2% 22% 100% 88.6 63.3
ST. 136 82% 2% 3% 13% 100% 84.1 68.6
ST. 137 25% 24% 12% 19% 20% 100% 72.5 64.6
ST. 138 52% 12% 14% 22% 100% 77.6 62.1
ST. 139 38% 24% 2% 14% 22% 100% 78.5 63.2
ST. 140 49% 3% 30% 18% 100% 83.5 65.1
ST. 141 55% 13% 3% 9% 20% 100% 81.2 64.0
ST. 142 36% 22% 42% 100% 93.5 47.8
ST. 143 77% 3% 7% 13% 100% 80.6 68.5
ST. 144 55% 12% 4% 29% 100% 90.0 57.2
ST. 145 40% 13% 22% 5% 20% 100% 81.8 64.2
ST. 146 45% 10% 20% 3% 22% 100% 83.8 62.4
ST. 147 71% 12% 17% 100% 88.8 66.7
ST. 148 74% 12% 14% 100% 88.3 69.0
ST. 149 74% 7% 3% 4% 12% 100% 83.7 70.0
ST. 150 79% 6% 1% 14% 100% 87.6 68.5
ST. 151 45% 25% 10% 20% 100% 82.0 65.1
ST. 152 60% 15% 5% 20% 100% 88.8 64.6
ST. 153 10% 35% 55% 100% 96.8 38.7
ST. 154 40% 27% 6% 9% 18% 100% 81.9 66.9
ST. 155 52% 10% 11% 27% 100% 78.2 57.2
ST. 156 44% 17% 10% 2% 27% 100% 87.6 59.1
ST. 157 50% 3% 2% 45% 100% 89.6 43.4
ST. 158 52% 10% 8% 30% 100% 83.7 55.9
ST. 159 48% 15% 5% 32% 100% 87.1 54.9
ST. 160 75% 9% 16% 100% 88.3 67.2
ST. 161 40% 10% 20% 15% 15% 100% 72.5 67.5
ST. 162 55% 10% 5% 30% 100% 86.3 56.0
ST. 163 49% 20% 6% 25% 100% 85.7 60.8
ST. 164 78% 7% 15% 100% 81.3 66.9
ST. 165 64% 1% 35% 100% 89.4 51.3
ST. 166 57% 10% 3% 30% 100% 88.0 56.1
ST. 167 52% 13% 11% 24% 100% 88.3 61.2
ST. 167a 50% 15% 11% 24% 100% 88.5 61.4
ST. 168 70% 5% 3% 7% 15% 100% 81.4 67.3
ST. 169 59% 8% 3% 30% 100% 87.8 55.9
ST. 170 70% 8% 2% 20% 100% 85.1 63.1
ST. 171 47% 18% 1% 34% 100% 91.1 53.7
ST. 172 33% 8% 20% 39% 100% 88.7 48.9
ST. 173 46% 22% 6% 26% 100% 86.0 60.2
ST. 174 18% 63% 4% 15% 100% 90.2 72.7
ST. 175 16% 2% 18% 16.6 15.7
ST. 176 53% 8% 10% 3% 26% 100% 85.7 59.1
ST. 177 75% 15% 10% 100% 88.0 72.5
ST. 178 69% 12% 3% 16% 100% 86.1 67.3
ST. 179 76% 10% 3% 11% 100% 87.2 71.2
ST. 180 62% 12% 2% 6% 18% 100% 83.5 65.6
ST. 181 60% 12% 10% 18% 100% 80.4 65.5
ST. 182 69% 5% 1% 25% 100% 88.4 59.7
ST. 183 58% 10% 6% 5% 21% 100% 84.0 63.1
ST. 184 37% 28% 35% 100% 93.1 53.9
ST. 185 42% 13% 6% 9% 30% 100% 82.3 56.1
ST. 186 55% 12% 7% 7% 19% 100% 82.1 64.8
ST. 187 26% 49% 7% 18% 100% 86.7 68.9
ST. 188 67% 10% 4% 19% 100% 85.5 64.7
ST. 189 14% 65% 6% 15% 100% 88.7 72.8
ST. 190 46% 17% 3% 5% 29% 100% 86.4 57.4
ST. 191 52% 15% 10% 12% 11% 100% 76.5 71.2
ST. 192 68% 7% 5% 20% 100% 88.0 63.8
ST. 193 72% 9% 6% 13% 100% 82.8 69.3
ST. 194 73% 6% 4% 17% 100% 83.3 65.4
ST. 195 66% 16% 1% 3% 14% 100% 86.0 69.3
ST. 196 70% 3% 3% 24% 100% 85.6 59.9
ST. 197 46% 20% 7% 4% 23% 100% 86.0 62.5
ST. 198 32% 42% 7% 1% 18% 100% 90.0 68.5
ST. 199 12% 69% 19% 100% 94.8 70.2
ST. 200 35% 35% 10% 20% 100% 90.0 66.4

Pergudangan Cek Impervious (%) Curve Number 
(%)

Catchment 
Area

Perumahan Perdagangan Fasilitas 
Umum

Lahan 
terbuka

Jalan

Perhitungan Nilai Impervious dan Curve Number Tiap Catchment Area



ST. 201 57% 23% 1% 19% 100% 89.3 66.0
ST. 202 55% 32% 13% 100% 90.2 71.6
ST. 203 70% 1% 10% 19% 100% 79.2 63.6
ST. 204 67% 9% 24% 100% 87.3 60.0
ST. 205 76% 3% 21% 100% 88.5 62.7
ST. 206 39% 14% 9% 7% 31% 100% 83.8 55.5
ST. 207 55% 16% 10% 1% 18% 100% 87.0 66.2
ST. 208 72% 6% 1% 4% 17% 100% 84.6 66.0
ST. 209 45% 16% 12% 7% 20% 100% 81.9 64.4
ST. 210 56% 17% 8% 19% 100% 82.8 65.2
ST. 211 61% 12% 4% 8% 15% 100% 81.1 67.9
ST. 212 45% 31% 2% 22% 100% 91.1 64.4
ST. 213 76% 2% 1% 21% 100% 88.2 62.6
ST. 214 41% 24% 8% 2% 25% 100% 88.3 61.3
ST. 215 38% 32% 3% 10% 17% 100% 81.8 68.1
ST. 216 19% 42% 4% 23% 12% 100% 70.9 72.4
ST. 217 39% 24% 7% 8% 22% 100% 82.9 63.5
ST. 218 70% 14% 16% 100% 88.8 67.6
ST. 219 78% 4% 18% 100% 88.1 65.1
ST. 220 72% 7% 21% 100% 87.1 62.4
ST. 221 61% 8% 1% 30% 100% 90.2 56.0
ST. 222 47% 22% 2% 29% 100% 89.9 58.0
ST. 223 42% 17% 2% 6% 33% 100% 86.3 54.2
ST. 224 45% 42% 10% 3% 100% 85.2 82.7
ST. 225 22% 65% 13% 100% 31.7 66.1
ST. 226 43% 17% 11% 3% 26% 100% 86.4 59.9
ST. 227 54% 7% 4% 35% 100% 85.8 51.2
ST. 228 34% 15% 8% 5% 38% 100% 86.8 50.1
ST. 229 40% 9% 20% 8% 23% 100% 79.6 61.3
ST. 230 31% 10% 14% 45% 100% 92.6 72.9
ST. 231 77% 8% 10% 5% 100% 87.8 72.3
ST. 232 44% 11% 2% 19% 24% 100% 73.3 60.3
ST. 233 55% 10% 2% 4% 29% 100% 86.7 56.8
ST. 234 46% 10% 7% 18% 19% 100% 72.5 64.2
ST. 235 55% 11% 7% 10% 17% 100% 79.1 66.2
ST. 236 29% 23% 8% 15% 25% 100% 77.1 60.7
ST. 237 39% 30% 4% 27% 100% 91.5 60.4
ST. 238 54% 13% 6% 27% 100% 89.5 58.8
ST. 239 50% 21% 29% 100% 91.5 58.0
ST. 240 56% 18% 26% 100% 90.7 60.1
ST. 241 56% 14% 5% 25% 100% 89.4 60.5
ST. 242 35% 23% 11% 8% 23% 100% 82.3 62.6
ST. 243 81% 5% 14% 100% 87.6 68.4
ST. 244 36% 6% 50% 8% 100% 42.8 70.7
ST. 245 16% 1% 2% 70% 11% 100% 27.0 67.6
ST. 246 86% 2% 12% 100% 87.0 69.7
ST. 247 42% 3% 3% 22% 30% 100% 70.7 54.7
ST. 248 65% 13% 22% 100% 89.6 62.8
ST. 249 50% 12% 2% 18% 18% 100% 73.3 65.1
SK. 250 51% 22% 5% 6% 16% 100% 83.8 68.1
SK. 251 81% 6% 13% 100% 87.6 69.3
SK. 252 1% 2% 10% 87% 100% 95.0 79.0
SK. 253 70% 2% 1% 10% 17% 100% 87.1 72.6
SK. 254 3% 1% 10% 86% 100% 95.0 78.8
SK. 255 10% 90% 100% 95.5 79.2
SK. 256 13% 1% 3% 20% 63% 100% 91.6 68.8
SK. 257 8% 2% 90% 100% 92.3 87.0
SK.258 2% 1% 9% 88% 100% 94.0 79.8

Fasilitas 
Umum

PerdaganganPerumahanCatchment 
Area

Perhitungan Nilai Impervious dan Curve Number Tiap Catchment Area

Jalan Pergudangan Cek Impervious (%) Curve Number 
(%)

Lahan 
terbuka



SP.74 SP.73 SP.72 SP.71 SP.70 SP.69 SP.68 SP.67 SP.66 SP.64 SP.63 SK.132 SP.62 SP.61 SP.60 SP.59 SP.58 SP.57 SK.130 SK.131 SP.56 SK.129
0:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.17 0.18 0.19 0.20 0.20 0.20 0.05 0.04 0.28 0.02
1:00 1.23 1.71 1.71 3.65 4.06 5.11 4.93 7.83 8.56 8.62 9.76 3.87 14.17 15.02 15.15 16.00 15.91 15.65 3.81 1.99 22.90 1.73
2:00 0.85 1.35 1.35 3.98 5.14 5.83 5.97 8.38 9.32 10.24 11.09 5.83 17.52 18.19 18.85 19.75 19.85 19.93 5.31 3.68 28.63 2.20
3:00 0.52 0.84 0.84 2.72 3.77 4.27 4.43 5.95 6.60 7.57 8.16 4.05 12.96 13.53 14.30 15.13 15.33 15.55 4.25 2.96 22.39 1.44
4:00 0.37 0.58 0.58 1.87 2.65 3.04 3.16 4.21 4.67 5.37 5.80 2.78 9.16 9.60 10.20 10.85 11.02 11.21 3.26 2.28 16.41 0.98
5:00 0.16 0.29 0.29 1.05 1.58 1.73 1.85 2.33 2.60 3.18 3.41 1.62 5.42 5.67 6.14 6.56 6.72 6.89 2.10 1.55 10.15 0.54
6:00 0.05 0.12 0.12 0.49 0.79 0.86 0.94 1.13 1.26 1.66 1.78 0.73 2.80 2.96 3.30 3.57 3.70 3.83 1.15 0.85 5.65 0.23
7:00 0.02 0.05 0.05 0.22 0.36 0.40 0.46 0.54 0.61 0.84 0.91 0.31 1.42 1.52 1.73 1.91 2.00 2.09 0.64 0.47 3.12 0.10
8:00 0.02 0.03 0.03 0.11 0.18 0.21 0.24 0.29 0.33 0.46 0.50 0.16 0.77 0.83 0.96 1.08 1.13 1.19 0.36 0.27 1.81 0.05
9:00 0.01 0.02 0.02 0.07 0.11 0.13 0.15 0.18 0.21 0.28 0.31 0.10 0.47 0.51 0.59 0.67 0.70 0.74 0.22 0.16 1.13 0.03

10:00 0.01 0.02 0.02 0.05 0.08 0.09 0.10 0.13 0.15 0.20 0.22 0.08 0.33 0.36 0.41 0.46 0.48 0.50 0.15 0.11 0.78 0.03
11:00 0.01 0.02 0.02 0.05 0.07 0.08 0.08 0.11 0.12 0.16 0.17 0.07 0.26 0.28 0.32 0.35 0.37 0.38 0.11 0.08 0.58 0.02
12:00 0.01 0.02 0.02 0.04 0.06 0.07 0.07 0.10 0.11 0.14 0.15 0.06 0.23 0.24 0.27 0.29 0.30 0.31 0.09 0.06 0.48 0.02
13:00 0.01 0.02 0.02 0.04 0.06 0.06 0.07 0.09 0.10 0.12 0.13 0.06 0.21 0.22 0.24 0.26 0.27 0.27 0.07 0.05 0.41 0.02
14:00 0.01 0.02 0.02 0.04 0.05 0.06 0.07 0.09 0.10 0.12 0.13 0.06 0.20 0.21 0.22 0.24 0.24 0.25 0.07 0.05 0.37 0.02
15:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.09 0.10 0.11 0.12 0.06 0.19 0.20 0.21 0.23 0.23 0.23 0.06 0.04 0.34 0.02
16:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.09 0.10 0.11 0.12 0.06 0.19 0.19 0.20 0.22 0.22 0.22 0.06 0.04 0.33 0.02
17:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.09 0.10 0.11 0.12 0.06 0.18 0.19 0.20 0.21 0.21 0.22 0.06 0.04 0.32 0.02
18:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.09 0.09 0.11 0.11 0.06 0.18 0.19 0.20 0.21 0.21 0.21 0.05 0.04 0.31 0.02
19:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.18 0.19 0.19 0.21 0.21 0.21 0.05 0.04 0.30 0.02
20:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.18 0.19 0.19 0.20 0.21 0.21 0.05 0.04 0.30 0.02
21:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.18 0.18 0.19 0.20 0.20 0.21 0.05 0.04 0.30 0.02
22:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.18 0.18 0.19 0.20 0.20 0.20 0.05 0.04 0.29 0.02
23:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.18 0.18 0.19 0.20 0.20 0.20 0.05 0.04 0.29 0.02

0:00 0.01 0.02 0.02 0.04 0.05 0.06 0.06 0.08 0.09 0.10 0.11 0.06 0.18 0.18 0.19 0.20 0.20 0.20 0.05 0.04 0.29 0.02

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS



SP.54 SP.53 SP.52 SK.127 SK.126 SK.125 SK.124 SK.123 SK.122 SP.51 SP.50 SK.121 SK.120 SK.119 SK.118 SK.117 SK.116 SK.115 SK.114 SK.113
0:00 0.31 0.31 0.32 0.11 0.12 0.14 0.14 0.17 0.18 0.52 0.53 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15
1:00 24.60 24.40 24.21 9.45 10.57 12.16 12.52 16.24 17.11 41.55 42.64 3.57 4.50 6.84 7.56 8.43 8.42 10.08 13.82 15.15
2:00 31.37 31.56 32.09 10.71 12.41 13.66 14.03 17.00 18.03 52.75 53.81 2.64 3.47 5.69 6.64 7.84 8.41 9.92 13.20 14.78
3:00 24.42 24.74 25.45 7.46 8.69 9.58 9.86 11.88 12.76 41.00 41.89 1.57 2.09 3.50 4.18 4.95 5.48 6.47 8.65 9.71
4:00 17.83 18.10 18.66 5.24 6.08 6.72 6.92 8.36 9.00 29.77 30.45 1.09 1.44 2.40 2.85 3.38 3.74 4.42 5.94 6.65
5:00 11.04 11.28 11.76 2.87 3.40 3.75 3.88 4.61 5.04 18.47 18.90 0.49 0.68 1.16 1.46 1.76 2.04 2.38 3.19 3.58
6:00 6.11 6.30 6.65 1.28 1.55 1.75 1.83 2.19 2.46 10.26 10.54 0.17 0.26 0.45 0.61 0.73 0.91 1.06 1.44 1.62
7:00 3.35 3.48 3.70 0.56 0.69 0.81 0.85 1.04 1.21 5.61 5.79 0.08 0.12 0.19 0.27 0.32 0.41 0.48 0.67 0.75
8:00 1.94 2.02 2.16 0.29 0.36 0.42 0.45 0.56 0.65 3.23 3.34 0.05 0.07 0.11 0.15 0.17 0.21 0.25 0.36 0.40
9:00 1.21 1.26 1.35 0.18 0.22 0.26 0.28 0.35 0.41 2.02 2.09 0.04 0.06 0.08 0.11 0.12 0.14 0.17 0.24 0.27

10:00 0.83 0.87 0.93 0.14 0.17 0.19 0.20 0.26 0.30 1.39 1.44 0.04 0.05 0.08 0.09 0.10 0.11 0.13 0.19 0.21
11:00 0.63 0.65 0.69 0.12 0.14 0.16 0.17 0.21 0.24 1.05 1.08 0.04 0.05 0.07 0.08 0.09 0.10 0.12 0.16 0.18
12:00 0.51 0.53 0.56 0.11 0.13 0.15 0.16 0.19 0.21 0.86 0.89 0.04 0.05 0.07 0.08 0.09 0.09 0.11 0.15 0.17
13:00 0.44 0.46 0.48 0.11 0.13 0.14 0.15 0.18 0.20 0.74 0.77 0.04 0.05 0.07 0.08 0.09 0.09 0.10 0.15 0.16
14:00 0.40 0.41 0.43 0.11 0.13 0.14 0.14 0.18 0.19 0.67 0.69 0.04 0.05 0.07 0.08 0.09 0.09 0.10 0.14 0.16
15:00 0.37 0.38 0.40 0.11 0.12 0.14 0.14 0.17 0.19 0.63 0.65 0.04 0.05 0.07 0.08 0.08 0.09 0.10 0.14 0.16
16:00 0.36 0.36 0.37 0.11 0.12 0.14 0.14 0.17 0.18 0.60 0.62 0.04 0.04 0.07 0.08 0.08 0.08 0.10 0.14 0.15
17:00 0.35 0.35 0.36 0.11 0.12 0.14 0.14 0.17 0.18 0.58 0.59 0.04 0.04 0.07 0.08 0.08 0.08 0.10 0.14 0.15
18:00 0.34 0.34 0.35 0.11 0.12 0.14 0.14 0.17 0.18 0.57 0.58 0.04 0.04 0.07 0.08 0.08 0.08 0.10 0.14 0.15
19:00 0.33 0.33 0.34 0.11 0.12 0.14 0.14 0.17 0.18 0.56 0.57 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15
20:00 0.33 0.33 0.34 0.11 0.12 0.14 0.14 0.17 0.18 0.55 0.56 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15
21:00 0.32 0.33 0.33 0.11 0.12 0.14 0.14 0.17 0.18 0.54 0.56 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15
22:00 0.32 0.32 0.33 0.11 0.12 0.14 0.14 0.17 0.18 0.54 0.55 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15
23:00 0.32 0.32 0.33 0.11 0.12 0.14 0.14 0.17 0.18 0.54 0.55 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15

0:00 0.32 0.32 0.33 0.11 0.12 0.14 0.14 0.17 0.18 0.53 0.55 0.04 0.04 0.07 0.07 0.08 0.08 0.10 0.14 0.15

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS



SK.112 SK.111 SK.110 SK.109 SK.108 SK.107 SP.49 SP.48 SP.47 SP.46 SP.45 SP.44 SP.43 SK.106 SK.105 SK.104 SK.103 SP.42 SP.41 SK.101 SK.100
0:00 0.16 0.17 0.18 0.18 0.19 0.19 0.72 0.73 0.73 0.75 0.75 0.76 0.76 0.04 0.04 0.04 0.05 0.80 0.80 0.03 0.04
1:00 15.79 16.46 17.83 18.18 17.93 18.04 58.59 59.25 58.79 60.00 60.39 59.53 59.38 3.82 4.13 3.88 3.78 61.40 59.88 3.33 4.01
2:00 15.38 16.74 17.81 18.27 18.70 19.28 73.19 73.92 74.23 75.55 76.06 76.80 76.76 2.97 3.61 4.35 4.55 81.23 81.11 2.58 3.58
3:00 10.13 11.16 11.93 12.32 12.88 13.47 56.46 57.21 57.71 59.09 59.53 60.80 60.89 1.81 2.31 3.39 3.79 65.62 66.48 1.57 2.39
4:00 6.94 7.65 8.20 8.48 8.88 9.30 40.70 41.31 41.73 42.87 43.20 44.27 44.42 1.25 1.60 2.55 2.97 48.43 49.32 1.09 1.66
5:00 3.74 4.20 4.49 4.67 5.03 5.37 25.26 25.67 26.06 26.84 27.07 28.02 28.24 0.56 0.79 1.56 1.95 31.30 32.20 0.48 0.85
6:00 1.70 1.95 2.11 2.23 2.50 2.72 14.09 14.38 14.68 15.24 15.38 16.10 16.36 0.21 0.32 0.86 1.15 18.48 19.25 0.17 0.37
7:00 0.79 0.91 1.00 1.07 1.24 1.37 7.73 7.93 8.14 8.52 8.61 9.10 9.37 0.09 0.14 0.45 0.65 10.73 11.30 0.07 0.17
8:00 0.43 0.49 0.54 0.58 0.67 0.76 4.45 4.59 4.72 4.97 5.03 5.35 5.60 0.05 0.08 0.24 0.37 6.46 6.85 0.04 0.09
9:00 0.28 0.31 0.35 0.37 0.43 0.47 2.79 2.87 2.96 3.13 3.16 3.37 3.60 0.04 0.05 0.15 0.22 4.15 4.41 0.04 0.06

10:00 0.22 0.24 0.26 0.28 0.31 0.34 1.92 1.98 2.03 2.15 2.17 2.31 2.50 0.04 0.05 0.10 0.15 2.86 3.04 0.03 0.05
11:00 0.19 0.20 0.22 0.23 0.26 0.28 1.45 1.49 1.53 1.61 1.63 1.72 1.87 0.04 0.04 0.07 0.10 2.12 2.24 0.03 0.04
12:00 0.17 0.19 0.20 0.21 0.23 0.24 1.19 1.21 1.24 1.30 1.31 1.38 1.50 0.04 0.04 0.06 0.08 1.68 1.76 0.03 0.04
13:00 0.17 0.18 0.19 0.20 0.21 0.22 1.03 1.05 1.07 1.12 1.13 1.18 1.27 0.04 0.04 0.05 0.07 1.41 1.47 0.03 0.04
14:00 0.16 0.17 0.19 0.19 0.20 0.21 0.93 0.95 0.97 1.00 1.01 1.05 1.12 0.04 0.04 0.05 0.06 1.23 1.27 0.03 0.04
15:00 0.16 0.17 0.18 0.19 0.20 0.20 0.87 0.89 0.90 0.93 0.94 0.97 1.02 0.04 0.04 0.05 0.05 1.11 1.15 0.03 0.04
16:00 0.16 0.17 0.18 0.19 0.19 0.20 0.83 0.85 0.86 0.88 0.89 0.91 0.96 0.04 0.04 0.04 0.05 1.03 1.06 0.03 0.04
17:00 0.16 0.17 0.18 0.18 0.19 0.20 0.81 0.82 0.83 0.85 0.86 0.87 0.91 0.04 0.04 0.04 0.05 0.98 1.00 0.03 0.04
18:00 0.16 0.17 0.18 0.18 0.19 0.20 0.79 0.80 0.80 0.82 0.83 0.85 0.88 0.04 0.04 0.04 0.05 0.94 0.95 0.03 0.04
19:00 0.16 0.17 0.18 0.18 0.19 0.20 0.77 0.78 0.79 0.81 0.81 0.83 0.85 0.04 0.04 0.04 0.05 0.91 0.92 0.03 0.04
20:00 0.16 0.17 0.18 0.18 0.19 0.19 0.76 0.77 0.78 0.80 0.80 0.82 0.83 0.04 0.04 0.04 0.05 0.89 0.90 0.03 0.04
21:00 0.16 0.17 0.18 0.18 0.19 0.19 0.76 0.76 0.77 0.79 0.79 0.80 0.82 0.04 0.04 0.04 0.05 0.87 0.88 0.03 0.04
22:00 0.16 0.17 0.18 0.18 0.19 0.19 0.75 0.76 0.76 0.78 0.79 0.80 0.81 0.04 0.04 0.04 0.05 0.86 0.86 0.03 0.04
23:00 0.16 0.17 0.18 0.18 0.19 0.19 0.75 0.75 0.76 0.77 0.78 0.79 0.80 0.04 0.04 0.04 0.05 0.85 0.85 0.03 0.04

0:00 0.16 0.17 0.18 0.18 0.19 0.19 0.74 0.75 0.75 0.77 0.78 0.79 0.79 0.04 0.04 0.04 0.05 0.84 0.84 0.03 0.04

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS



SK.98 SK.102 SK.97 SK.96 SP.40 SP.39 SK.95 SK.94 SK.93 SP.38A SP.76 SP.38 SP.37 SP.36 SP.35 SP.34 SP.32 SP.33 SP.30 SP.28 SP.27 SK.73
0:00 0.05 0.04 0.10 0.10 0.90 0.91 0.01 0.04 0.05 0.61 0.51 0.95 0.95 0.95 1.37 1.04 1.51 1.44 0.08 0.07 0.05 0.04
1:00 4.64 3.62 9.19 9.41 67.00 66.92 1.22 2.65 3.24 23.50 51.96 67.78 67.37 67.01 106.81 49.10 103.17 85.56 7.72 6.75 4.05 3.40
2:00 5.11 2.42 10.20 10.46 91.00 91.52 0.73 3.76 4.84 31.10 50.92 95.64 96.14 96.13 137.89 74.48 152.03 145.92 8.27 7.25 4.64 3.75
3:00 3.64 1.44 7.05 7.30 74.50 75.12 0.43 3.02 3.86 31.34 29.98 79.63 80.67 80.96 111.29 64.68 130.59 135.09 5.56 4.71 3.14 2.23
4:00 2.56 1.02 4.87 5.05 55.21 55.70 0.31 2.20 2.79 29.45 20.05 59.30 60.24 60.56 82.13 50.62 101.09 107.79 3.78 3.19 2.11 1.51
5:00 1.45 0.40 2.81 2.93 36.06 36.45 0.11 1.36 1.74 22.77 10.93 39.09 39.86 40.17 52.90 36.09 71.18 78.83 2.18 1.82 1.23 0.82
6:00 0.68 0.14 1.32 1.41 21.50 21.77 0.04 0.71 0.91 16.95 3.78 23.52 24.09 24.35 31.13 24.13 46.94 54.17 1.04 0.81 0.59 0.30
7:00 0.31 0.06 0.61 0.66 12.58 12.76 0.02 0.36 0.46 13.21 1.59 13.84 14.20 14.40 18.02 16.01 30.91 36.58 0.50 0.38 0.28 0.13
8:00 0.16 0.04 0.32 0.35 7.62 7.74 0.01 0.19 0.24 9.69 0.94 8.39 8.61 8.75 10.82 9.95 20.73 24.94 0.28 0.21 0.15 0.08
9:00 0.10 0.04 0.21 0.22 4.91 4.98 0.01 0.11 0.14 5.52 0.69 5.39 5.53 5.62 6.92 6.59 14.23 17.32 0.18 0.14 0.10 0.06

10:00 0.07 0.04 0.15 0.16 3.38 3.43 0.01 0.07 0.10 3.03 0.60 3.70 3.79 3.85 4.77 4.81 10.10 12.32 0.13 0.11 0.07 0.05
11:00 0.06 0.04 0.13 0.13 2.50 2.54 0.01 0.06 0.07 1.60 0.56 2.72 2.78 2.83 3.54 3.65 7.43 9.03 0.11 0.09 0.06 0.04
12:00 0.05 0.04 0.11 0.12 1.97 2.00 0.01 0.05 0.06 1.00 0.54 2.14 2.18 2.21 2.81 3.01 5.66 6.83 0.10 0.08 0.06 0.04
13:00 0.05 0.04 0.11 0.11 1.64 1.66 0.01 0.04 0.06 0.76 0.53 1.77 1.80 1.82 2.35 2.60 4.47 5.33 0.09 0.08 0.05 0.04
14:00 0.05 0.04 0.11 0.11 1.43 1.44 0.01 0.04 0.05 0.65 0.53 1.53 1.55 1.57 2.07 2.42 3.67 4.29 0.09 0.08 0.05 0.04
15:00 0.05 0.04 0.10 0.11 1.28 1.30 0.01 0.04 0.05 0.61 0.52 1.37 1.39 1.40 1.87 2.35 3.10 3.57 0.09 0.08 0.05 0.04
16:00 0.05 0.04 0.10 0.11 1.19 1.20 0.01 0.04 0.05 0.59 0.52 1.26 1.28 1.29 1.75 2.32 2.69 3.05 0.09 0.08 0.05 0.04
17:00 0.05 0.04 0.10 0.11 1.12 1.13 0.01 0.04 0.05 0.58 0.52 1.19 1.20 1.21 1.65 2.30 2.40 2.67 0.09 0.07 0.05 0.04
18:00 0.05 0.04 0.10 0.11 1.07 1.08 0.01 0.04 0.05 0.57 0.52 1.13 1.14 1.15 1.59 2.30 2.19 2.39 0.08 0.07 0.05 0.04
19:00 0.05 0.04 0.10 0.10 1.03 1.04 0.01 0.04 0.05 0.57 0.52 1.09 1.10 1.11 1.54 2.29 2.04 2.18 0.08 0.07 0.05 0.04
20:00 0.05 0.04 0.10 0.10 1.01 1.01 0.01 0.04 0.05 0.56 0.52 1.06 1.07 1.08 1.51 2.28 1.92 2.03 0.08 0.07 0.05 0.04
21:00 0.05 0.04 0.10 0.10 0.99 0.99 0.01 0.04 0.05 0.56 0.52 1.04 1.05 1.05 1.48 2.28 1.83 1.91 0.08 0.07 0.05 0.04
22:00 0.05 0.04 0.10 0.10 0.97 0.98 0.01 0.04 0.05 0.56 0.52 1.02 1.03 1.03 1.46 2.28 1.76 1.82 0.08 0.07 0.05 0.04
23:00 0.05 0.04 0.10 0.10 0.96 0.96 0.01 0.04 0.05 0.56 0.52 1.01 1.02 1.02 1.44 2.27 1.72 1.75 0.08 0.07 0.05 0.04

0:00 0.05 0.04 0.10 0.10 0.95 0.95 0.01 0.04 0.05 0.56 0.52 1.00 1.01 1.01 1.43 2.27 1.67 1.69 0.08 0.07 0.05 0.04

DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS

JAM



SP.24 SP.23 SP.21 SK.64 SK.61 SK.60 SK.59 SK.58 SK.57 SK.56 SK.55 SK.54 SK.72 SK.69 SK.68 SK.67 SK.66 SK.65 SK.53 SK.52 SK.51 SK.50
0:00 0.02 0.05 0.06 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.28 0.05 0.17 0.18 0.18 0.20 0.21 0.48 0.49 0.49 0.51
1:00 1.83 4.46 4.33 4.34 13.08 17.93 8.92 11.86 29.06 27.93 28.06 28.61 2.75 8.60 9.48 8.95 11.08 11.25 39.46 40.83 41.06 43.12
2:00 2.24 5.37 5.63 5.11 11.66 16.23 7.43 9.48 25.85 26.56 26.75 27.27 4.72 17.37 18.60 18.20 20.29 20.94 48.13 49.34 49.59 51.14
3:00 1.34 4.06 4.79 3.51 7.76 10.92 4.57 5.81 17.01 17.93 18.10 18.49 4.75 15.73 16.55 16.64 17.96 18.65 37.24 38.14 38.34 39.36
4:00 0.90 3.08 4.07 2.51 5.50 7.73 3.18 4.06 11.94 12.55 12.67 12.95 3.60 11.79 12.36 12.57 13.49 14.05 27.10 27.77 27.93 28.66
5:00 0.52 1.98 3.08 1.39 2.84 4.09 1.50 1.88 6.23 6.90 6.99 7.15 2.44 7.86 8.18 8.43 8.90 9.31 16.60 17.00 17.11 17.48
6:00 0.19 1.06 2.10 0.56 1.23 1.87 0.55 0.69 2.76 3.26 3.32 3.42 1.42 4.40 4.55 4.81 5.01 5.28 8.83 9.06 9.13 9.31
7:00 0.09 0.58 1.39 0.23 0.55 0.88 0.23 0.29 1.27 1.55 1.59 1.65 0.74 2.28 2.35 2.56 2.65 2.82 4.55 4.70 4.74 4.84
8:00 0.05 0.33 0.93 0.11 0.30 0.48 0.14 0.18 0.69 0.84 0.86 0.89 0.39 1.21 1.25 1.38 1.43 1.54 2.48 2.57 2.60 2.66
9:00 0.04 0.21 0.63 0.07 0.21 0.32 0.11 0.14 0.47 0.54 0.55 0.57 0.22 0.69 0.71 0.80 0.83 0.90 1.50 1.56 1.57 1.62

10:00 0.03 0.14 0.43 0.06 0.17 0.25 0.10 0.13 0.38 0.41 0.42 0.43 0.14 0.44 0.46 0.51 0.54 0.58 1.02 1.06 1.07 1.10
11:00 0.03 0.10 0.30 0.05 0.15 0.22 0.09 0.12 0.34 0.35 0.35 0.37 0.09 0.32 0.33 0.36 0.39 0.42 0.78 0.81 0.82 0.85
12:00 0.03 0.08 0.22 0.05 0.14 0.20 0.09 0.12 0.32 0.32 0.32 0.33 0.07 0.25 0.27 0.28 0.31 0.33 0.66 0.68 0.69 0.71
13:00 0.02 0.07 0.17 0.05 0.14 0.19 0.09 0.12 0.31 0.30 0.31 0.31 0.06 0.22 0.23 0.24 0.26 0.28 0.59 0.61 0.61 0.63
14:00 0.02 0.06 0.13 0.05 0.13 0.19 0.09 0.12 0.30 0.30 0.30 0.30 0.05 0.20 0.21 0.22 0.24 0.25 0.55 0.56 0.57 0.59
15:00 0.02 0.06 0.11 0.05 0.13 0.18 0.09 0.12 0.30 0.29 0.29 0.30 0.05 0.19 0.20 0.20 0.22 0.23 0.52 0.54 0.54 0.56
16:00 0.02 0.06 0.09 0.05 0.13 0.18 0.09 0.12 0.29 0.29 0.29 0.29 0.05 0.18 0.19 0.19 0.22 0.22 0.51 0.52 0.53 0.54
17:00 0.02 0.06 0.08 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.18 0.19 0.19 0.21 0.22 0.50 0.51 0.52 0.53
18:00 0.02 0.06 0.07 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.18 0.19 0.19 0.21 0.22 0.49 0.51 0.51 0.52
19:00 0.02 0.06 0.07 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.17 0.19 0.19 0.21 0.21 0.49 0.50 0.50 0.52
20:00 0.02 0.05 0.06 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.17 0.19 0.18 0.20 0.21 0.49 0.50 0.50 0.52
21:00 0.02 0.05 0.06 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.17 0.19 0.18 0.20 0.21 0.48 0.50 0.50 0.51
22:00 0.02 0.05 0.06 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.17 0.19 0.18 0.20 0.21 0.48 0.49 0.50 0.51
23:00 0.02 0.05 0.06 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.17 0.19 0.18 0.20 0.21 0.48 0.49 0.50 0.51

0:00 0.02 0.05 0.06 0.05 0.13 0.18 0.09 0.12 0.29 0.28 0.28 0.29 0.05 0.17 0.19 0.18 0.20 0.21 0.48 0.49 0.50 0.51

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS



SK.49 SK.48 SK.47 SK.46 SK.45 SK.44 SK.43 SK.42 SK.41 SK.40 SK.37 SK.36 SK.35 SK.34 SK.33 SK.31 SK.30 SK.29 SP.20 SP.16 SP.17 SP.18
0:00 0.52 0.55 0.55 0.58 0.59 0.63 0.64 0.64 0.66 0.67 0.15 0.15 0.15 0.16 0.17 0.85 0.87 0.92 0.93 1.11 1.22 1.26
1:00 44.81 47.33 47.87 50.82 52.94 52.09 52.89 53.74 53.07 54.91 14.81 15.34 14.96 16.59 16.69 69.90 70.03 71.17 35.74 57.73 59.13 59.49
2:00 52.71 55.15 55.85 58.51 60.04 63.22 64.18 64.97 66.36 68.17 13.83 14.55 14.86 16.03 16.33 85.68 88.28 93.14 57.89 111.95 123.53 127.31
3:00 40.34 41.97 42.56 44.58 45.64 49.68 50.60 51.20 53.15 54.51 8.94 9.53 10.05 10.80 11.10 67.61 70.75 76.31 63.13 101.67 111.18 116.35
4:00 29.34 30.50 30.95 32.46 33.25 36.32 37.06 37.52 39.05 40.09 6.17 6.57 6.97 7.50 7.72 49.51 51.91 56.91 57.55 77.21 83.65 87.86
5:00 17.87 18.56 18.88 19.78 20.18 22.65 23.16 23.45 24.70 25.37 3.28 3.55 3.92 4.16 4.33 31.24 33.06 37.25 40.96 53.47 57.69 60.80
6:00 9.47 9.81 10.02 10.57 10.79 12.44 12.81 12.98 13.86 14.26 1.38 1.56 1.84 1.95 2.07 17.57 18.73 21.90 24.48 33.59 35.89 37.95
7:00 4.92 5.11 5.24 5.58 5.71 6.67 6.92 7.03 7.56 7.81 0.61 0.71 0.87 0.92 1.00 9.66 10.31 12.51 12.75 19.96 21.09 22.36
8:00 2.71 2.83 2.91 3.12 3.21 3.76 3.92 3.99 4.31 4.48 0.34 0.39 0.47 0.50 0.54 5.55 5.92 7.39 6.81 12.16 12.79 13.55
9:00 1.65 1.73 1.78 1.92 1.98 2.31 2.41 2.46 2.66 2.76 0.23 0.26 0.30 0.33 0.35 3.45 3.67 4.65 4.87 7.73 8.13 8.60

10:00 1.13 1.19 1.22 1.32 1.36 1.56 1.63 1.67 1.79 1.87 0.19 0.21 0.23 0.25 0.26 2.35 2.48 3.14 3.69 5.19 5.48 5.79
11:00 0.87 0.91 0.94 1.01 1.04 1.17 1.22 1.25 1.33 1.38 0.17 0.18 0.19 0.21 0.22 1.75 1.84 2.29 2.98 3.72 3.94 4.15
12:00 0.73 0.77 0.78 0.84 0.87 0.96 0.99 1.01 1.07 1.11 0.16 0.17 0.18 0.19 0.20 1.41 1.47 1.80 2.36 2.83 3.02 3.17
13:00 0.65 0.68 0.70 0.74 0.77 0.84 0.87 0.88 0.92 0.96 0.16 0.16 0.16 0.18 0.19 1.21 1.26 1.50 1.98 2.28 2.45 2.56
14:00 0.60 0.63 0.65 0.69 0.71 0.76 0.79 0.80 0.83 0.86 0.15 0.16 0.16 0.18 0.18 1.09 1.14 1.31 1.65 1.94 2.08 2.18
15:00 0.58 0.60 0.62 0.65 0.67 0.72 0.74 0.75 0.78 0.81 0.15 0.16 0.16 0.17 0.17 1.02 1.06 1.20 1.45 1.71 1.85 1.93
16:00 0.56 0.59 0.60 0.63 0.65 0.69 0.71 0.72 0.74 0.77 0.15 0.16 0.15 0.17 0.17 0.97 1.00 1.12 1.34 1.55 1.69 1.75
17:00 0.55 0.57 0.58 0.61 0.63 0.67 0.69 0.70 0.72 0.74 0.15 0.15 0.15 0.17 0.17 0.94 0.97 1.06 1.27 1.44 1.57 1.63
18:00 0.54 0.57 0.58 0.61 0.62 0.66 0.67 0.68 0.70 0.72 0.15 0.15 0.15 0.17 0.17 0.92 0.95 1.03 1.24 1.36 1.49 1.55
19:00 0.54 0.56 0.57 0.60 0.62 0.65 0.67 0.67 0.69 0.71 0.15 0.15 0.15 0.17 0.17 0.90 0.93 1.00 1.21 1.31 1.43 1.48
20:00 0.53 0.56 0.57 0.59 0.61 0.65 0.66 0.67 0.68 0.70 0.15 0.15 0.15 0.17 0.17 0.89 0.92 0.98 1.20 1.27 1.39 1.44
21:00 0.53 0.56 0.56 0.59 0.61 0.64 0.65 0.66 0.68 0.70 0.15 0.15 0.15 0.17 0.17 0.88 0.91 0.97 1.19 1.23 1.35 1.40
22:00 0.53 0.55 0.56 0.59 0.60 0.64 0.65 0.66 0.67 0.69 0.15 0.15 0.15 0.17 0.17 0.87 0.90 0.96 1.19 1.21 1.33 1.38
23:00 0.53 0.55 0.56 0.59 0.60 0.64 0.65 0.66 0.67 0.69 0.15 0.15 0.15 0.17 0.17 0.87 0.90 0.95 1.20 1.19 1.31 1.35

0:00 0.53 0.55 0.56 0.59 0.60 0.63 0.65 0.65 0.67 0.69 0.15 0.15 0.15 0.17 0.17 0.87 0.89 0.95 1.19 1.18 1.29 1.34

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS



SP.19 SP.14 SP.13 SP.12 SK.23 SK.21 SK.20 SP.10 SK.7 SK.8 SK.9 SK.10 SK.11 SK.12 SK.13 SK.14 SK.15 SK.16 SK.18 SP.8 SP.9 SP.6
0:00 1.34 0.06 0.06 0.03 0.05 0.12 0.16 0.59 0.06 0.13 0.24 0.25 0.28 0.30 0.32 0.33 0.36 0.36 0.37 0.95 1.22 0.36
1:00 61.43 4.72 5.19 2.15 4.79 12.49 16.14 50.48 5.90 13.47 20.00 19.01 21.59 22.77 24.18 24.91 29.05 29.99 30.60 75.79 5.04 29.99
2:00 135.53 6.05 5.77 2.66 3.07 10.43 16.19 59.94 5.37 12.24 24.73 25.13 28.11 30.06 32.25 32.86 35.92 36.60 37.26 95.77 116.76 36.70
3:00 125.88 4.72 3.78 1.71 1.81 6.47 10.55 43.78 3.23 7.65 16.70 18.24 20.57 22.21 24.00 24.50 26.59 27.06 27.70 76.21 123.36 31.06
4:00 95.26 3.69 2.58 1.16 1.28 4.48 7.23 30.88 2.26 5.33 11.57 12.69 14.37 15.55 16.84 17.22 18.73 19.08 19.58 56.94 93.49 24.74
5:00 66.02 2.58 1.37 0.63 0.50 2.20 3.93 18.21 0.99 2.46 6.46 7.49 8.51 9.28 10.11 10.33 11.09 11.27 11.61 36.69 66.75 16.83
6:00 41.22 1.68 0.59 0.25 0.17 0.87 1.73 9.43 0.30 0.88 2.78 3.68 4.26 4.72 5.22 5.35 5.73 5.81 6.05 21.44 43.06 10.51
7:00 24.21 1.06 0.25 0.10 0.08 0.37 0.77 4.83 0.12 0.36 1.19 1.72 2.05 2.31 2.59 2.68 2.89 2.94 3.09 12.41 25.76 6.51
8:00 14.57 0.69 0.13 0.05 0.06 0.21 0.40 2.66 0.07 0.20 0.59 0.87 1.06 1.21 1.37 1.43 1.56 1.59 1.68 7.49 15.76 4.15
9:00 9.20 0.46 0.09 0.04 0.05 0.16 0.26 1.64 0.06 0.16 0.38 0.52 0.64 0.73 0.83 0.86 0.95 0.97 1.03 4.82 10.17 2.75

10:00 6.16 0.32 0.07 0.03 0.05 0.14 0.21 1.15 0.06 0.14 0.30 0.38 0.45 0.51 0.58 0.60 0.66 0.68 0.71 3.33 6.90 1.90
11:00 4.40 0.23 0.06 0.03 0.05 0.13 0.18 0.91 0.06 0.14 0.27 0.32 0.37 0.41 0.46 0.47 0.52 0.54 0.56 2.47 5.00 1.38
12:00 3.36 0.17 0.06 0.03 0.05 0.13 0.17 0.78 0.06 0.14 0.26 0.29 0.33 0.36 0.40 0.41 0.45 0.46 0.48 1.95 3.81 1.06
13:00 2.71 0.14 0.06 0.03 0.05 0.13 0.17 0.71 0.06 0.13 0.25 0.27 0.31 0.34 0.37 0.38 0.42 0.43 0.44 1.63 3.05 0.84
14:00 2.31 0.11 0.06 0.03 0.05 0.12 0.17 0.67 0.06 0.13 0.25 0.26 0.30 0.32 0.35 0.36 0.40 0.40 0.42 1.43 2.55 0.70
15:00 2.04 0.09 0.06 0.03 0.05 0.12 0.16 0.65 0.06 0.13 0.25 0.26 0.29 0.32 0.34 0.35 0.38 0.39 0.40 1.29 2.21 0.61
16:00 1.86 0.08 0.06 0.03 0.05 0.12 0.16 0.63 0.06 0.13 0.25 0.26 0.29 0.31 0.34 0.34 0.38 0.38 0.39 1.20 1.98 0.54
17:00 1.73 0.08 0.06 0.03 0.05 0.12 0.16 0.62 0.06 0.13 0.25 0.25 0.29 0.31 0.33 0.34 0.37 0.38 0.39 1.14 1.81 0.50
18:00 1.64 0.07 0.06 0.03 0.05 0.12 0.16 0.62 0.06 0.13 0.25 0.25 0.28 0.30 0.33 0.34 0.37 0.37 0.38 1.09 1.69 0.46
19:00 1.58 0.07 0.06 0.03 0.05 0.12 0.16 0.61 0.06 0.13 0.25 0.25 0.28 0.30 0.33 0.33 0.36 0.37 0.38 1.06 1.59 0.44
20:00 1.53 0.06 0.06 0.03 0.05 0.12 0.16 0.61 0.06 0.13 0.25 0.25 0.28 0.30 0.33 0.33 0.36 0.37 0.38 1.04 1.52 0.42
21:00 1.49 0.06 0.06 0.03 0.05 0.12 0.16 0.61 0.06 0.13 0.25 0.25 0.28 0.30 0.32 0.33 0.36 0.37 0.38 1.02 1.47 0.41
22:00 1.46 0.06 0.06 0.03 0.05 0.12 0.16 0.60 0.06 0.13 0.25 0.25 0.28 0.30 0.32 0.33 0.36 0.37 0.37 1.00 1.43 0.40
23:00 1.44 0.06 0.06 0.03 0.05 0.12 0.16 0.60 0.06 0.13 0.25 0.25 0.28 0.30 0.32 0.33 0.36 0.37 0.37 0.99 1.39 0.39

0:00 1.42 0.06 0.06 0.03 0.05 0.12 0.16 0.60 0.06 0.13 0.24 0.25 0.28 0.30 0.32 0.33 0.36 0.37 0.37 0.99 1.37 0.39

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS



SP.5 SP.4 SP.3 SP.2 SK.2 SK.3 SK.4 SK.5 SK.6 SP.1
0:00 0.35 0.32 0.28 0.25 0.13 0.20 0.21 0.22 0.21 0.23
1:00 28.85 25.17 20.56 17.01 9.99 14.64 13.55 13.89 13.54 14.04
2:00 35.51 32.10 28.52 25.48 12.74 20.29 21.10 21.84 21.68 23.16
3:00 30.10 27.49 25.09 22.84 11.13 17.32 19.06 19.72 19.76 21.09
4:00 23.98 21.98 20.22 18.52 9.54 14.08 15.53 16.05 16.13 17.16
5:00 16.31 15.03 14.09 13.07 6.69 9.72 11.03 11.40 11.52 12.27
6:00 10.17 9.35 8.86 8.24 4.03 5.83 6.86 7.11 7.25 7.74
7:00 6.28 5.73 5.44 5.04 2.42 3.45 4.11 4.27 4.38 4.71
8:00 3.98 3.61 3.41 3.13 1.43 2.08 2.50 2.61 2.69 2.90
9:00 2.63 2.36 2.21 2.02 0.87 1.30 1.57 1.65 1.71 1.85

10:00 1.82 1.62 1.50 1.36 0.56 0.86 1.04 1.09 1.13 1.24
11:00 1.32 1.17 1.07 0.96 0.38 0.60 0.73 0.77 0.79 0.87
12:00 1.00 0.88 0.81 0.72 0.28 0.45 0.54 0.57 0.59 0.65
13:00 0.80 0.70 0.64 0.57 0.22 0.36 0.42 0.45 0.46 0.51
14:00 0.67 0.59 0.53 0.47 0.18 0.30 0.35 0.37 0.38 0.42
15:00 0.58 0.51 0.46 0.40 0.15 0.27 0.30 0.32 0.33 0.36
16:00 0.52 0.46 0.41 0.36 0.14 0.24 0.27 0.29 0.29 0.32
17:00 0.47 0.42 0.37 0.33 0.13 0.23 0.25 0.27 0.27 0.29
18:00 0.44 0.39 0.35 0.31 0.13 0.22 0.24 0.25 0.25 0.28
19:00 0.42 0.37 0.33 0.29 0.13 0.21 0.23 0.24 0.24 0.26
20:00 0.41 0.36 0.32 0.28 0.13 0.21 0.22 0.23 0.23 0.25
21:00 0.39 0.35 0.31 0.28 0.13 0.21 0.22 0.23 0.23 0.25
22:00 0.38 0.34 0.30 0.27 0.13 0.20 0.22 0.23 0.23 0.24
23:00 0.38 0.34 0.30 0.27 0.13 0.20 0.21 0.22 0.22 0.24

0:00 0.37 0.33 0.30 0.26 0.13 0.20 0.21 0.22 0.22 0.24

JAM
DEBIT TIAP JUNCTION (m3/dt)

Debit Rencana Periode Ulang 10 tahun Hasil Perhitungan HEC-HMS
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BAB VI 

PENUTUP 

6.1 Kesimpulan 
Berdasarkan hasil analisa dan perhitungan yang telah 

dilakukan, maka diperoleh hasil sebagai berikut: 
1. Debit banjir rencana periode ulang 10tahun yang masuk 

ke saluran primer Margomulyo adalah 30,37 m3/dt pada 
bagian hulu dan 82,33 m3/dt pada bagian hilir. Untuk 
debit yang masuk ke Kali Balong  adalah 69,29 m3/dt 
pada bagian hulu dan 185,82 m3/dt pada bagian hilir. 
Untuk debit perencanaan yang masuk ke Kali Kandangan 
adalah 63,59 m3/dt pada bagian hulu dan 108,08 m3/dt 
pada bagian hilir. Sedangkan debit perencanaan yang 
masuk ke Kali Sememi adalah 104,49 m3/dt pada bagian 
hulu dan 144,08 m3/dt pada bagian hilir. 

2. Dari hasil analisa hidrolika disimpulkan bahwa 
penampang eksisting tidak dapat menampung debit 
perencanaan yang mengalir, sehingga dilakukan 
normalisasi saluran. Dari normalisasi saluran didapatkan 
dimensi untuk: 
a) Saluran primer Margomulyo dengan b = 10 m dan 

h=3,43 m pada bagian hulu saluran, sedangkan untuk 
di hilir saluran direncanakan dengan b= 15 m dan  
h=3,13 m. 

b) Kali Balong dengan b=20 m dan h=3,36 m pada 
bagian hulu saluran, sedangkan untuk di hilir saluran 
direncanakan dengan b=48 m dan h=3,65 m. 

c) Kali Kandangan dengan b=20 m dan h=3,12 m pada 
bagian hulu saluran, sedangakan untuk di hilir 
saluran direncanakan dengan b=30 m dan h=2,30 m. 

d) Kali Sememi dengan b=20m dan h=3,92 m pada 
bagian hulu salran, sedangkan untuk di hilir saluran 
direncanakan dengan b=38m dan h=2,20 m. 
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3. Ada pengaruh backwater pada Kali Balong, Kali 
Kandangan dan Kali Sememi. Backwater terjadi karena 
adanya pengaruh pasang surut air laut, dimana menurut 
SDMP Surabaya ketinggian pasang pada Kali Balong, 
Kali Kandangan, dan Kali Sememi pada elevasi 0 m. 
Karena pengaruh backwater tidak terlalu tinggi, maka 
alternatif  yang digunakan untuk mengatasi pengaruh 
backwater adalah dengan perencanaan tanggul. Tinggi 
tanggul pada Kali Balong, Kali Kandangan, dan Kali 
Sememi direncanakan dengan ketingian 0,6 m. 

4. Dari hasil analisa penampang eksisting dan analisa 
penampang rencana didapatkan profil muka air saluran 
yang berbeda. Dimana elevasi muka air rencana lebih 
rendah daripada elevasi muka air eksisting. Ini 
dikarenakan kondisi eksisting sudah di normalisasi 
dengan cara dilebarkan dan elevasi dasar eksisting sudah 
mengalami pengerukan dan beberapa ditimbun, sehingga 
menghasilkan elevasi rencana yang lebih landai. 
 

6.2 Saran 
1. Normalisasi saluran perlu dilakukan di saluran primer 

Margomulyo, Kali Kandangan, dan Kali Sememi, 
sehingga kapasitas penampang bisa menampung debit 
yang mengalir. 

2. Diharapkan adanya pemeliharaan secara rutin seperti 
melakukan pengerukan atau pembersihan sedimen untuk 
mengurangi resiko terjadinya banjir. 
. 
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